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PREFACE

Punjab School Education Board has been updating the school level syllabi
compatible with modern approach and latest research. The board has also
launched a special drive to prepare new text books as per latest national policies in
this regard. The present book is a part of the prestigious program.

The knowledge in the subject of computer science is need of the hour
because its study is essential for efficient usage of science and technology in every
field of modern era. Computerization of every department is done to keep it
updated in light of all round development of information technology and
communication. The knowledge of computer education is necessary for everyone
to avail the latest information about different departments, e-ticketing and usage
of internet.

Keeping in view these requirements Punjab School Education Board has
introduced computer science as a compulsory subject at Secondary and Senior
Secondary levels as per guidelines of Punjab Government. Every effort has been
made to include each requisite information regarding the subject in this book. I
hope it will be useful for students and teachers.

All suggestions for the improvement of the book will be highly appreciated.

Chairman
Punjab School Education Board
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Chapter

1" OFFICETOOLS ‘

Objectives of this chapter:

Introduction

1.1 Introduction to office tools

1.2 Using MS-Word

1.3 MS-Excel

1.4 Using mail merge with spreadsheet
1.5 Page Layouts

1.6 Finalizing a Document

1.7 Print Preview

1.8 Print Command

1.9 MS-Power-point

1.10 Saving Presentation

Introduction:

1.1

As we all know that hardware and software work together to
accomplish a task. Computer software is classified into two broad
categories: system software and application software.

System Software: System software consists of a group of
programs that control the operations of a computer equipment including
functions like managing memory, managing peripherals, loading,
storing, and is an interface between the application programs and the
computer. MS DOS (Microsoft's Disk Operating System), UNIX are
examples of system software.

Application software: Software that can perform a specific task
for the user, such as word processing, accounting, budgeting or payroll,
fallunder the category of application software.

Introduction to office tools:

Office tools are software programs designed to make computer users
more productive and efficient at their workplace. Office productivity
tools range from word processing to spreadsheet, presentation and
database etc.

Office Productivity tool is a category of application programs that
help users produce things such as documents, databases, graphs,
worksheets and presentations. Many productivity applications are
intended for business use. Examples of office productivity software
include word processors, database management systems, graphics
softwares and spreadsheet applications.
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1.1.1 Types of office tools are:

e Word processing tool: The main purpose of this tool is to produce
documents. MS-Word, Word Pad, Notepad and some other text editors
are some of the examples of word processing tools.

e Database software tool: Database is a collection of related data. The
purpose of this tool is to organize and manage data. The advantage of
this tool is that you can change the way data is stored and displayed. MS
access, dBase, FoxPro, Paradox, and Oracle are some of the examples of
database software.

e Spread sheet tool: The spread sheet tool is used to maintain budget,
financial statements, and sales records. The purpose of this tool is
organizing numbers. It also allows the users to perform simple or
complex calculations on the numbers. MS-Excel is one of the examples
of spreadsheet tools.

e Presentation tool: This tool is used to display the information in the
form of slide show. The three main functions of presentation tool is
editing that allows insertion and formatting of text, including graphics
in the text and executing the slide shows. The best example for this type
of tool is Microsoft PowerPoint.

e Multimedia software: Media players and real players are the examples
of multimedia tool. This tool allows the user to create audio and videos.
The different forms of multimedia tools are audio converters, players,
burners, video encoders and decoders.

__ Note:

Productivity tools are increasingly available for mobile devices also.
However, mobile productivity apps are generally for basic tasks like
e-mail, note-taking and calendar functions, rather than more
substantial tasks, such as word processing.

1.2 Using MS Word:

In previous classes we already have studied about various features of MS
word such as creating, editing and formatting a document, inserting tables,
pictures and editing them. We have also used the feature of mail merge, spell-
check and thesaurus etc.

Microsoft Word can be used for the following purposes:

° To create business documents having various graphics including
pictures, charts, and diagrams.

° To store and reuse readymade content and formatted elements such as
cover pages and sidebars.

° To create letters and letterheads for personal and business purpose.

2
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° To design different documents such as resumes or invitation cards etc.

° To create a range of correspondence from a simple office memo to legal
copies and reference documents.
Formatting in MS - Word:
Here we will learn more about word in different manner. Before using
word tool we must define and plan a document design. Planning a
document design is vital to ensure the printed output of our document
accomplishes our goal or not. Document design determine if the
document orientation will be portrait (vertical) or landscape (horizontal),
if the document will be formatted in single or multiple columns. A
landscape document with two columns is the most readable and popular

layout for an event program. It also determines if we will use any images
or clip art.

1.2.1 Templates in Microsoft Word:
Word 2010 allows us to apply built-in templates from a wide selection of
popular Word templates, including resumes, agendas, business cards,

and faxes.
Wl [ T Microscht Word T — | — ]
Hom Insert  Pagelayout  References Mailing Review  View Q
I seve
Available Templates Blank documen t
& save
. Home
I o a
o -
95 a8
Recent Blank Blog post Recent Sample  Mytemplstes  New from
document templates  templates exsting
_ o U=
Print
Save & Send — — — — — — — —
Animals A me  Annual vy Blank and B Business Card:
Help General
(3 opt
3 et
Centificat Children Christr: Design Set: Educat; Envelop: Event Fax G J
Creats
i - N -—
=
Financial I Fly Food and Forms Holiday Industry Invitations ~ Invoices
Management Nutrition
= N o, =]
5 ¥ / / /
A Y o 4 4 B
Labels Letters Lists Marketing Nature Newsletters Order Paper - e

Fig: 1.1

To apply a template in Word, do the following:
1. On the File tab, click New.
2. Under Available Templates, select of the following:
e To use one of the built-in templates: Click Sample Templates click the
template that we want, and then click Create.

3
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e To reuse a template that we've recently used: Click Recent Templates,
click the template that we want, and then click Create.

e To find a template on Office.com: under Office.com Templates, click the
template category that we want, click the template that we want, and
click download to download the template from Office.com to our
computer.

3. Once we have selected our template we can modify it in any way to create
the document we want.

Microsoft Word 2010 allows us to create and edit personal and business
documents, such as letters, reports, invoices, emails and books. By default,
documents saved in Word 2010 are saved with the .docx extension.

~ Here are some Quick Tips:

1. Decide what we want to accomplish with our document.

2. Identify our users.

3. Identify the layout and design, file, format, and storage location.

1.2.1.1 Creating a resume with MS - Word templates
So far we have learnt about many features of MS —~Word. Here we will
create aresume with MS —Word. Follow the steps written below:
1. Click on New in File tab.

Available Templates Blank document
3 Home

ice.com Templates

Fig: 1.2

2. In office.com templates, select Resumes and Cover Letters.
3. MS - Word will download the selected template from office.com
templates.
4. Here various styles are available for Resumes

and Cover Letters. Select anyone according to 4 9 J

the requirement and click Download. Persons
5. Resume with selected template will appear.

4
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E—
eeeee sume tter in =

2. 3
[Type your address]
[Type the phone number]
[Type the fax number]
[Type your website]

Resumne (Urban theme) Photo resume (Median

eeeeee
Objective [Typeyour objecives) | | | | Dol
Skills +  [Typelist of skills]
Education [Type the school name] ..

‘ [Type the completion date] Flg. 1 .5

+  [Type list of accomplishments]

Experience [Typethe job title]
[Type the start date]- [Type the end date]
[Type the job responsibility]

Fig: 1.4

6. Now we can editit and can make the necessary changes in resume.
7. After filling all the required information in the resume, save it.

1.3 MS-Excel:

Like MS — Word we have already learnt so much about MS - Excel. We
have used Excel for creating worksheets, tables, results, doing mathematical
calculations and representing data in pictorial view with help of charts. Excel is
a spreadsheet program used to create and format workbooks. It helps us in
analyzing data and making data more informative in order to take business
decisions. Specifically, we can use Excel to track data, analyze data, write
formulas to perform calculations on that data, pivot the data in numerous
ways, and present data in a variety of professional looking charts.

As in MS - Word we have used templates to create resume, here we will
learn about using templates in MS -Excel. Excel allows us to create a new
workbook using a template, which is a predesigned spreadsheet. Several
templates are preloaded in Excel, while others can be located on Office.com. A
spreadsheet template is a predesigned spreadsheet which we can use to create
new spreadsheets with the same formatting and predefined formulas. With
templates, we don't need to know how to do the math, or even how to write
formulas—these are already integrated into the spreadsheet.

1. Click the File tab and Select New. The Available Templates
pane appears.

2. In Available templates, click Sample templates to choose a
built-in template, or select an Office.com template category to

3
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download a template
1.3.1Create a workbook using a template:
User can select the template according the requirement. Here we will
take different examples.
1.3.1.1 Home schooling progress record
First of all we will select Home schooling progress record in Forms

template under office.com Templates.

1. After selecting particular form click on download button.
@d G ™ HomeSchoolProgressecordl - Microsoft Excel T
Home Insert Page Layout Formulas Data Review View
=] X o Calibri s - A == B SiwnapT - ; ¢ (W =
= ¥ =5 Wrap Text General = |
P% i Comy - & == EiE o 2 00 C E!J | F% _Cf l_
it fomatpainter (B U EH- | & A- [EE B FF EHmegeacenteis| $ - % 0 W3 Sonceione) Fonmt_con..| I
Clipboard . Font . Alignment ‘) Number ‘) Styles
cs - I
A B | c [ [ | E F G H

2 Home schooling progress record

3

 E—TE—
5 Student name Term starts Overall marks

6 Age Term ends (%)

7 Grade Total term marks possible 1]

B8 Teacher name Total marks scored this term 0.0

3

10

n Assignment # 1 2 | 4 5

Marks to date  Subject total (%)
12 Due date

13 Marks (total) 0

14 Marks scored 0.0
15
16 SUBJECT NAME
17 A nt# 1 2 a 4 3

S Ll Marks to date  Subject total (%)
18 Due date
19 Marks (total) 0
20 Marks scored 0.0
21
2

#

23 Assignment 1 2 = 4 = Marks todate  Subject total (%)
24 Due date
25 Marks (total) 0
26 Marks scored 0.0
e g
H 4 » | Home schooling progress record . %J [«

Ready |

Fig: 1.6

2. A new workbook will appear using the template we chose.
In this particular form we can keep track of subject wise
assignments of the student.

3. Enter the data into the template and Save the workbook.

1.3.1.2 Sales invoice

In the similar way can use Sales invoice under Invoices. We can edit this
invoice and enter data in this invoice to make calculations according to our
requirement.

This invoice can be saved as a new workbook. We can place our company
logo and edit date and invoice no. and other details in the invoice also. After
entering the required data in this invoice it will calculate the total in Balance
due cell.

6
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I - A Te

Home Insert Page Layout Formulas Data Review View

L12 - F
A

B - c IO - D E F
fany 1090

g e INVOICE
1 N\ Tag line can go here
2 -
3 Street address Date 12123
4 City, ST 00000 Invoice # 11
M= For  rosinis
6 someone@example com
7
8
9 Contact at company

10 Company name
11 Street address
2| City, ST 00000
13 (206) 555-1163

15 i Description n Unit price - Amounl- D;;‘I’i::
16 1 ttem Number 1 $ 200 % 2.00
1K tem Number 2 s 200 200

18 ' 1 ttem Number 3 $ 200 % 2.00

=l s 0.00

=l | + 000

2 $ 0.00

2 $ 0.00

2 $ 0.00

24 4 0.00

25 Subtotal $ 6.00 J
26

Rl | ke ﬂﬁmm%ﬁ‘&"m’“ Credit | & 1000.00

28 ;h":n".‘f; o (fﬂfb:ﬁ;zm-@mm!m Additonal discount 2%

29 Balancedue | $

30
M 4 » ¥ | Invoice 2010 / ¥J
Ready |

Fig: 1.7

1.4 Using mail merge with spreadsheet
As we have learnt many things about Word and Excel, let us try to do

something new with these two tools.

1.4.1 Creating Student Annual Report
1. First of all, we should prepare the Annual report formate in Ms word.
Here, in this we have mentioned student's detail like admission no, roll

no, name, father's name, marks of each subject, overall result and
percentage of marks of student.

i

Downloaded from https:// www.studiestoday.com



Downloaded from https:// www.studiestoday.com

IR vome et Pagelajout  References | Mailings | Review  View

IR @ B RAE BT LR
= =| =
g = = = 92 Match Fields £ Find Recipient
B Labels | Start Mail  Select Edit Highlight ~ Address Greeting Insert Merge Preview Shsh &
Merge - Recipients = Recipient List | Merge Frelds Block  Line  Field= (2 Update Labels | peuns G Auto Check for Erors | Merge -

‘Write & Insert Fields Preview Results Finish

A9t WSS Hisig Adsdt Ags

Govt. Model Senior Secondary School

L — [ TR

Annual Report

Fig: 1.8
2. On the other side, we have prepared a excel worksheet, in which
student's admission no, roll no, name, father's name, subject-wise
marks obtained in Punjabi, English, maths, science, sst, and grades of
EVS and Computer are filled.

EEEE teve | Weet Paoelsout  Fomuls  Dts  Redew  View

Bl R O
P g pomapactes| B 4 W - A W | Eeneacos | $ - % o || Conotoot Form con | den On Forme =
Cpboaa 5 Font 3 Angrment - Number al - = Gount Numbers
SUM *(° K o F| sSUM(EXI) R
;‘ | | c ] o T CI| P [ e [ W ] ' I 1] I L e
More Functions
: | Mos Beieri
o Roll No. Punjabi English Mathematics Science St Computer EVS Total Marks | Percentage %
Lo [ o [ rsw [mersn | - " " “ - P
e 1702 2 Harsh Rajesh Kumar 57 & B2 s s A A
5 1708 s Vikram Parbhakar 58 kL 69 &7 A A
o s Gurprest kaur | Davinder Singh ™ " n ” . s

Fig: 1.9
e Here we calculate the total marks using Autosum function ¥ of MS
excel.

Home | Inset  Pagelayout  Formulas  Data  Review  View

% cut e T 'B-'?' Siwnap Ten F— E: ﬁ ﬁ E 3_ E‘ ;::s....-

4a copy ~
Paste .| B~ - - = | - - b Conditional Format  Cell Insert Delete Format
" romarinin BT U E - A EEIW | FE Ereenconinc | $ - % 0 W8 vt famt e Dot ot G0
Clipboard I Font r..‘ Alignment n Humber & Styles Cells ‘ Ec
Zonment fambar Hrler tel =
[ (= ﬁrﬁuu(sa:u)
p] A | 8 ] B I ) T e [ F | & [ w [ 1 [ 1 | ®x [ 1t T m
1
2 Roll No Student Name Father's Name Punjabi English Mathematics. Science Sst Computer EVS Total Marks | Percentage '
1701 1 Avtar Singh Jagtar Singh a5 54 87 87 58 A+ 8 331
1702 2 Harsh Rajesh Kumar 57 82 75 65 A A
1703 3 Vikram Parbhakar 61 58 78 69 67 A A
1704 4 Gurprest Kaur | Davinder Singh 55 62 74 7 72 ] L]
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e Next we calculate the percentage of marks of each student using a
formula (=L3*100/450).

File Home | Inset  Pagelayout  Formulas  Dats  Review  View
Cut - o T AutoSum
: PR B
42 copy ~ L =
" B 7/ U B ] A EEE IFR 3 &2 Clear =
Clipboard Font Alignment Number yies Cells Editi
SuM - X « fe =13*100/450
A 8 c [ E F G H 1 1 K L [ ™ |
1
Admission No|  Roll No StudentName | Father'sName | Punjabi English | Mathematics |  Science st Computer EVS Total Marks | Percentage %
1701 1 Avtar Singh Jagtar Singh as 54 87 a7 58 A+ B 331 ] =L3*100/450|
3 ;
1702 2 Harsh Rajesh Kumar 57 63 82 75 65 A A 342
a
1703 3 Vikram Parbhakar 61 s8 78 63 &7 A A 333
H
1704 4 GurpreetKaur | Davinder Singh 55 62 74 7 72 ] 8 334
6

Fig: 1.11
e Next field shows the result of each student.

Inset  Pagelayout  Formulas  Data  Review  View
B X cw P = | S Fm =h  E autesum - Ap
! Calibri - - AN -y B S5 wrop Text General L _ | s
B g ces o e B oo oY
Paste B IU- e A~ PSP BMergeacenter+ § - s %8 2% Condmional Format Cel  Insert Delete Format Sot& Find &
-+ Foimat Painter u = A- EEF FE Hueo i N Formatting * as Table = Styles= = B - 2 CHT Fitter~ Select =
c o Fant . Alignment Humbes Styl Edtting
M3 - 3
A 8 c o E F G H I I J K L M T N
1
admission No|  Roll No Student Hame | Father's Hame |  Punjabl English | Mathematics | Science st Computer Evs Total Marks | Percentage%s | Result
2
1701 1 Awtar Singh Jagear Singh 45 54 87 E 58 A ] 331 7356 Pass
1702 z Harsh Rajesh Kumar 57 63 82 75 6 A A 342 76.00 Pass
1703 3 vikram Parbhakar 61 s8 78 6 &7 A A 333 7400 Pass
1704 a Gurpreet Kaur | Dawinder Singh 55 62 74 7 72 B B 334 7422 Pass
&

Fig: 1.12
e Now save this Excel sheet and continue in Ms-Word , where we have
prepared the Student Annual Report.

3. Now, click on Mailings Tab, and start mail merge. Then, choose Letter
option which we already prepared.

Insert Page Layout References Mailings Review View
[ = . .
L 3 - Rules = (e 1 -
| B @ 28 g R | Sy | 2
- - ==l @2 Match Fields =L —
Start Mail| Select Edit t Address Greeting Insert Merge A Finish &
Merge * |Recipients * Recipient List = Merge Fie Block  Line Field ~ v Auto Check for Ermors  perge ~
Letters Write & Insert Fields Preview Results Finish

E-mail Messages
Enyelopes... %
3% HIaa Adsd S

el Senior Secondary School

Labels...

Directory

Normal Word Document
Date:

2E UDLDe

Step by Step Mail Merge Wizard...

Annual Report

Fig: 1.13
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4. Next Click on Select Receipients and select Use Existing List option. Choose
excel Sheet1$ from Select Table dialog box and click OK.

Insert Page Layout References ] Mailings [ Review View

‘ a o R
a# = -SE
& Match Fields | € Find Recipient

Edit Highlight Address Greeting Insert Merge Preview Finish &
Recipient List Block Line  Field~ |2 Update Labels | pecys = 3 Auto Check for Emmors | mMerge ~
&2 Type New List.. Write & Insert Fields Preview Results Finish

‘T Use Existing List... |

Select from Outlook Contacts...
% HIdd A9 RAS

H 41 PH

Merge Fields

Merge ~

Fig:1.14

12:00:00 AM  12:00:00 AM TABLE
12:00:00 AM  12:00:00 AM TABLE
12:00:00 AM  12:00:00 AM TABLE

“ L3
] st cow of da contans comn headers (Lomar ]
Fig: 1.15

5. We should place our cursor where we want to insert the value of field
from excel sheet. Now go to Insert Merge Field option in Write & Insert
Fields group. A drop down menu will be displayed having field names
according to excel worksheet we have selected

Inset  Page Layout Mmu]mlllngllm View

DB @ B B afEl., ® L
4 = = =
23 Match Fields £ Find Recipient
Start Mail _ Select Edit Highlignt  Address Greeting Preview Finish &
|4 Update Labels | pesuits S Auto Check forErrors | Merge+

Merge = Recipients ~ Recipient List | Merge Fields Block  Line
Start Mail Write &I Preview Results Finish

&

HES g i
Govt. Model Senior Secor

e
Annual Report

Fig: 1.16
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Select the field names one by one after placing the cursor in proper

place in the student annual report. All fields will be displayed as
shown in figure below:

Insert  Pagelayout  References | Maiings | Review  View ' a
BB @ B 88 @ 40 e | B
9 Maten Fields | €1Find Redpient
Start Mail  Select Highlight mmmmmmum Preview Finish &
Merge ~ Recipients ~ udpmun Merge Fields Block  Line 2] Update Labels | Results 9 Auto Check for ENTOrs | perge =
Start Mail Merge ‘Write & Inse rlFlIld Preview Results. Finish
RSS! WSS Highie Felsdt

Govt. Model Senior Secondary School

L Dme
Annual Report
Admission No.: «Admission_No»
Roll No.: «Roll_No»

Name: «Student_Name»
Father’s Name: «Fathers_Name»

Marks Deail
Subject Obmined Marks | Total Marks Reule
Puzjabi Panjis o oResults
Eegiat “EEguks R “Rerets
Mmbamurics <Mathemaics - 100 eResuits
Som Same 0 pTEn
Social Smadie £ ) TR
Computer “Compas L] ey
Evs EVss W FTES
ey Fandts Towl M |
- ‘Pecetage_»

i
{

Class

Fig: 1.17

After inserting all the fields we can preview the result of students by
clicking Preview Results option. We can also preview the result of

next and previous student, first and last student using navigation
button

Insert  Pagelayout  References | Mailings | Review  View

DR e 2338 [l

Start Mail  Select Highlight Address Greeting Insert Merge Finish &
Merge - Recipients = unpmun Merge Fields Block  Line Field ~ lﬁUWat Label 1 Auto Check for Emors | per,

Start Mail Merge ‘Write & Insert Fields Preview Results

ge~
ish

View Merged Data

Replace the merge fields in your
AITSt S Histhie Adsd! Ag® Socument it cus dtarom
Govt. Model Senior Secondary School ook k.

‘what it looks

@ Press F1 for more help.

Annual Report
Admission No.: 1701
RollNo.: 1
Name: Avtar Singh
Father's Name: Jagtar Singh
Marks Detail
Subject Obmined Marks | Total Marks Result
P = = Pa
=y ™ ™ T
Matamma Ly % T
Sciamce " 100 Fans
Scasl Smdu £ g D
Compe e 10 o
B 0 T
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8. Now click on Finish & Merge option and select Edit Individual
Documents from the menu. A dialog box Merge to New Document will open.
Choose option All and click Ok to show the report card of all the students in

excel worksheet.

‘ | Merge to New Document M
%-__‘J Merge records
Finish & ® iii
Merge ~ Current record
| £y EditIndividual Documents... Erom: To:
iz;g Print Documents...
- | Merge to New Document (Alt+5Shift+N)
&3 Send E-mail Messages...
i Fig: 1.20
Fig: 1.19
9. Now a new Word document will open having Report card of all the students

as shown in figure below. We can save this document and can also take printouts.

Home | Insert  Pagelayout  References Review  View > @
“‘_j : e B - A Ae SrECTE EE WO asbce| assbcex AaBbCi AaBbce AAB aaBbec. sosvceo. | A ?&;.:.m
Pt Fomat painter || B 4 T - be WA EEIER S 5 THormal | THNo Spaci.. Headingl Heading 2 Subtitle  Subtie Em... _ g';:'swj :Sﬂm,
Fig: 1.21
1.5 Page Layouts:
1.5.1 Adjusting Line Spacing: :

The default spacing is 1.15 line spacing and 10 #=#= 4l T | s.sbco
points after each paragraph. The easiest way to change %= &. - A—
the line spacing for an entire document is to select the [, ,,
paragraphs or entire document that we want to change v
the line spacing on. &

1. On the Home tab, in the Paragraph group, click 2

Line Spacing. .

2. Do one of the following as shown fig 1.22: 3'0

Click the number of line spaces that you want. For
example, click 1.0 to single-space with the spacing that is
used in earlier versions of Word. Click 2.0 to double-space
the selected paragraph. Click 1.15 to single-space with

the spacing that is used in Word 2010.

2

“W e

Line Spacing Options...
Add Space Before Paragraph

Add Space After Paragraph

Fig: 1.22
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3. Click Remove Space Before Paragraph to remove any additional lines
added after each paragraph as a default

Note:

If a line contains a large text character, graphic, or formula, Word
increases the spacing for that line. To space all lines evenly within a
paragraph, use exact spacing and specify an amount of space that is large
enough to fit the largest character or graphic in the line. If items appear cut
off, increase the amount of spacing.

1.5.2 Page Margins:

Page margins are the blank space around the edges of the page. In general,
we insert text and graphics in the printable area inside the margins. When we
change a document's page margins, we change where text and graphics appear
on each page.

1.5.2.1 Setting Predefined Page Margins:
1. On the Page Layout tab, in the Page Setup group, click Margins. The
Margins gallery drop down menu will appear.
2. Click the margin type that we want to apply.

Insert Page Layout References Mz
3

N Ij r,J'-, Breal

L= $ Line

Margins| Orientation Size Columns
- - + b Hypr

Top: 1 Bottom: 1°

Left 1° Right: 1 '_“\ l
Narrow I-J j

0.5 Bottom: 0.5° Margins |Orientation| Size C
0.5 Right: 05 = - -

Moderate

Top 1° Bottom: 1° P
Left 075 Right: 075 _I Portrait
Wide

jl Landscape

Top 1° Bottom: 1
Left: g Right: 2

Mirrored
Top 1 Bottom: 1°

Inside: 125" Outside:1 Fig: 1.24

Office 2003 Default
Top 1" Bottom: 1
Left. 1.25° Right: 1.25

Custom Margins

== 5 & OO E)

Custom Margins...
Fig: 1.23

1.5.3 Page Orientation:
We can choose either portrait (vertical) or landscape (horizontal)
orientation for all or part of our document.
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1.5.3.1 To change Page Orientation:
e On the Page Layout tab, in the Page Setup group, click Orientation.

e Click Portrait or Landscape.

1.5.3.2 Different Page Orientations on Same Document:
1. Select the pages or paragraphs that we want to change to portrait or

landscape orientation.

2. On the Page Layout tab, in the Page Setup group, click Margins.
a. Click Custom Margins at the bottom of the drop down menu.
b. A Page Setup dialog box will appear.
c. On the Margins tab, click Portrait or Landscape.
d. In the Apply to list, click Selected text or This point forward.

Note:

If we select some but not all of the text on a page to change to portrait or
landscape orientation, Word places the selected text on its own page, and

the surrounding text on separate pages.

1.5.4 Creating Custom Margins:
1 On the Page Layout tab, in the

Page Setup group, click
Margins.

2. At the bottom of the Margins
gallery drop down menu, click

Custom Margins.
3. The Page Setup dialog box will

appear.
4. Enter new values for the

margins in all or some of the
Top, Bottom, Left or Right text

boxes.
5. Click OK.

Note:

Page Setup li‘i—k
. Margins | Paper ] Layout I
Margins
Top: 0.8 = Bottom: 0.8"
Left: 0.8 = Right: 0.8" =
Gutter: 0" + Gutter position: | Left E|
Orientation

|

[

Portrait

Landscape

Fig:1.25

margins are set outside the printable area of the page.

Most printers require a minimum width for margin settings, because
they can't print all the way to the edge of the page. If we try to set margins
that are too narrow, Microsoft Word displays the message One or more

14
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1.5.5 Page Breaks: —— ' }_]
Word automatically inserts a page break when - j |

we reach the end of a page. If we want the page to break Cover Blank Page
in a different place, we can insert a manual page | pg ge~ Page Break
break. Pages
1.5.5.1 Inserting a Page Break: Fig: 1.26
1. Click where we want to start a new page.
2. On the Insert tab, in the Pages group, click Page Break.

Note:

We can also insert breaks into our document by going to the Insert
tab, Pages group and clicking on the Page Breaks command to view a
variety of page and section breaks you can insert into your document.

One another formatting option is setting Tab stops.
1.5.6 Tab Stops:

Creating tab stops can be helpful when creating a large number of
documents such as flyers, table of contents or even when creating a resume. They
help us to display and line up information correctly.

1.5.6.1 Setting Manual Tab Stops:
1. Click the tab selector at the left end of the ruler |[t]| until it displays the
type of tab that you want.
2. Then click in the ruler at the top of our page, where we want to set the
tab stop.
The different types of tab stops are

- A Left Tab stop sets the start position of text that will then run to
the right as we type.

- A Center Tab stop sets the position of the middle of the text. The
text centers on this position as we type.

- [4] A Right Tab stop sets the right end of the text. As we type, the text
moves to the left.

- [2] A Decimal Tab stop aligns numbers around a decimal point.
Independent of the number of digits, the decimal point will be in
the same position. (We can align numbers around a decimal
character only)

- [1] A Bar Tab stop doesn't position text. It inserts a vertical bar at the
tab position.

Note:

We can drag existing tab stops left or right along the ruler to a different
position. Just Click and hold on the tab stop on the ruler then drag it to

where ever we would like it to be.

15
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1.5.7 Clear Tab Stops
1. We can clear tab stops in a variety of ways, the simplest is going to the ruler,
click and hold on the tab stop and drag in down towards the document. The
tab stop will disappear. To quickly clear multiple tab stops and start fresh:

a. Click the Home tab; click the Paragraph Dialog Box Launcher.

b. A Paragraph box will appear, click on the Tabs button at the
bottom left of the dialog box.

c. A Tabs dialog box will appear.

d. In the list under Tab stop position, click the tab stop position that we
want to clear, and then click Clear. To remove the spacing from all
manual tab stops, click Clear All.

e. Click OK.

1.6 Finalizing a Document:
After completing our work, we need to finalize our document using
some features of MS-word.

1.6.1 Using the "Spell Check" Feature:
As we type our document, red wavy lines will appear under any word that is
spelled incorrectly. The fastest way to fix spelling errors is to:

1. Put our cursor over the misspelled word and right click.

2. A drop down box will appear with correct spellings of the word.

3. Highlight and left click the word we want to replace the incorrect
word with.

To complete a more comprehensive Spelling and Grammar check, we can
use the Spelling and Grammar feature.

Click on the Review tab.

Click on the Spelling & Grammar command

A Spelling and Grammar box will appear.

We can correct any Spelling or Grammar issue within the box.

0N =

Wild™® -G 17

File Home Insert Page
e ] :
v [ m

spelling & Research Thesaurus Wo g iing and Grammen Engiish U5) I R
Grammar Cou
¢ A Comma Use; 5
Proofing Examples of office productivity =+ [ tonoreonee |
i software include word processors, Ignore Rule
Spelling & Grammar (F7) database management systems, |
Check the spelling and grammar of| S’z;s’:gs’;“mmm' =
text in the document, [ e )
V| Check grammar
Options... | Cancel
Fig: 1.27
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1.7 Print Preview:
Print Preview automatically displays when we click on the Print tab. When
we make a change to a print-related setting, the preview is automatically updated.
To print preview of our document follow these steps:
1. Click the File tab, and then click Print. To go back to our document,
click the File tab.
2. A preview of our document automatically appears. To view each page,
click the arrows below the preview.

1.8 Print Command:
The Print tab is the place to go to make sure we are printing what we want.

1. Click the File tab.

2. Click the Print command to print a document.

3. Click the Print button to print our document.

4. This dropdown shows the currently selected printer. Clicking the

dropdown will display other available printers.

5. These dropdown menus show currently selected Settings. Rather than
just showing us the name of a feature, these dropdown menus show us what the
status of a feature is and describes it. This can help us figure out if we want to
change the setting from what we have.

A ~ -
1- Hom| Insert Page Layout References Mailings Review Vi

Print
H Save As
dpies: 1
7 Open
d Close

Info Printer

7 Send To OneNote 2010
Recent 2 Ready
rinter Properties

New S

Settings
Print
q - J Print All Pages 5. .
ave s Send skttt

Pages:

Help | Print One Sided
Only print on one side of the page

:] Options =
Collated
63 e e, ,,, -
j Portrait Orientation -
J Letter
P 11 “/

Normal Margins

Left: 1° Right 1
J 1 Page Per Sheet -

Fig:1.28
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1.8 MS - Power Point:

Microsoft PowerPoint is a presentation tool that supports text, shapes,
graphics, pictures and multimedia along with integration with other Microsoft
Office tools like Excel. By default, documents saved in PowerPoint 2010 are
saved with the .pptx extension whereas; the file extension of the prior
PowerPoint versions is .ppt. PowerPoint enables us to present information in
office meetings, lectures and seminars to create maximum impact in a
minimal amount of time.

1.8.1 Background in MS - Power Point:

We all know that PowerPoint is a design-based program. Backgrounds in
Power point are effective ways of improving the readability of the slides. The
Themes in PowerPoint help us to select the backgrounds by default, so every
time we change the theme, the default background is set automatically. Theme
includes more than just backgrounds.

Inset | Design | Transitions  Animations  Slide Show  Review  View  Storyboarding 4

A . ‘ B coors - & Background Styles *
= = | el B R R e e ] e 5
Themes Background ;
Fig.1.29
A theme is a set of colors, fonts, effects, and more that can be applied to
our entire presentation to give it a consistent, professional look. We can apply
any theme by clicking it in the Design ribbon.
Here are the steps to apply backgrounds in PowerPoint.

1. In the Design ribbon, under the Background group, click the
Background Styles command.
2.  Select one of the background styles that suit our requirements.

E Colors * [ ‘
1 —— M Background Styles

1
]
[y

Fig:1.30
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1.  To edit the background for a specific slide, right-click on the desired
background slide and select "Apply to Selected Slides".
2. Selected slide(s) now have the new background.

Note:

The graphics in the slide background can
distract us from the actual content, in such
cases we can hide the graphics and retain a plain
background till we finish working on the Fig.1.31
content. To do this, select the slide and check the o
"Hide Background Graphics" checkbox.

33] Background Styles ~

[¥] Hide Background Graphics

Background

1.9.2 Transitions in MS - Power Point:

PowerPoint supports slide transition feature which allows us to specify
how the slides should transition during the slide show.

PowerPoint presentation that had special effects between each slide, are
slide transitions. A transition can be as simple as fading to the next slide or as
complex as a flashy effect. This means we can choose transitions to fit the style
of any presentation. There are three categories of unique transitions to choose
from, all of which can be found on the Transitions tab:

® Subtle (slight transitions)

Subtle

J s B

o & B W

None Cut Fade Wipe Split Reveal Random Bars

H o« 4 O

Shape Uncover Cover Flash

® Exciting (strong transitions)

Exciting

I )

Dissolve Checkerboard Blinds Clock

m B @ o

Shred Switch Flip Gallery

[¢]
B
I

=
o
2
m

9]
-4
i
<
o
=3
(]
=

Honeycomb

(]
B
a
]

(]
[
o
"
o
o
o
“
m
o
=
~N
=)
o
3

Fig:1.33
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® Dynamic Content (strong transitions that affect only the content,

such as text or images)

Dynamic Content

H & @m @ @ @ &

Pan Ferris Wheel Conveyor Rotate Window Orbit Fly Through
Fig: 1.34

The steps to add and preview slide transitions are:

1. Select the slide to which we want to apply the transition.

2. Goto the Transition Scheme under the Transitions ribbon.

3. Select one of the transition schemes from the list available.
PowerPoint will instantly show us a preview of the scheme. If we are
not satisfied, we can pick an alternate scheme. The last selected
scheme will apply to the slide.

4. We can change the effects on the selected transition scheme from the
Effect Options menu. Every scheme has a unique set of effect options.

,L; Sound: [No Sound] v Advance Slide

g 7
m ﬁ
a

O Duration: 0100 -  [¥] OnMouse Click
Options =| a8 Apply To All [] After: 00:00.00 =
Timing
I ﬁ From Bottom
E—)—‘ From Left
’_ﬁ From Right
% From Top
Fig.1.35
5. We can also modify the transition timing settings from the Timing
section.
6. To preview the slide transition, click on Preview.

1.9.3 Animation in MS - Power Point:

Animation can help us to make PowerPoint presentation more dynamic,
and information more memorable. The most common types of animation
effects include entrances and exits. We can also add sound to increase the
intensity of our animation effects. To add animation to text or an object apply

following steps:
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1. Select the text or object that we want to animate.
2. On the Animations tab, in the Animation group, click an animation

effect from the gallery or click the more arrows to see more options.

Home  Inset  Design  Transitions Animations Slide Show  Review  View  Storyboarding Format

None -~

%
None

Entrance

w ¢ w »” hidg X w w =

IR ~N
Appear Fade Fly In Float In Split Wipe Shape Wheel Random Bars

Lighten  Transparency

X B ]
Object Color Complemen... Line Calor Fill Color Brush Color Font Color Underline Bold Flash Bold Reveal

Disappear Fade

ink & Turn Zoom Swivel Bounce -
More Entrance Effects..
More Emphasis Effects...

= More Exit Effects..

More Motion Paths Fig! 1 .36

b

se | G

Effect Add
In the gallery, entrance effects icons are colored green, O;_t':: ). Antmation ™ -
emphasis effects icons are colored yellow, and exit effects 'J; o
icons are colored red. g  Horizontalln
3. To alter how our selected text animates, click B frigontst Out
Effect Options and then click what we want the 3
animation to do ,
@@ | Vertical In
Note:
Not all animation effects offer the same Effect @ vertical Out
Options choices. sequence
4. To specify the timing of the effects, on the
As One Object

Animations tab, use the commands in the Timing group.
1.9.4 Slide Show in MS - Power Point: Fig:1.37

To present our slide show, we need to know how to start it. PowerPoint
allows us to start our slide show from the first slide or from any slide within
the slide show. Once our slide show has started, we need to know how to
advance through the slides.

To start a slide show:
1. Select the Slide Show tab.

2. Click the From Beginning command in the Start Slide Show group
to start the slide show with the first slide.
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— =l
ECNECE] ® I
_'.J . o =
From From Broadcast Custom

Beginning Current Slide Slide Show Slide Show ~
Start Slide Show

Slide Show From Beginning (F5)

Start the slide show from the first
slide,

Fig: 1.38

We can also start the slide show from the slide we prefer by selecting the slide
and clicking on From Current Slide from the Start Slide Show group. This
option is convenient if we only want to view or present certain slides.

Another option for starting the slide show is to select Slide Show view right
side on status bar at the bottom of the window.

28 B3 T 100% (=)

Slide Show )

Fig: 1.39

To stop or end a slide show: We can press the Esc key from our keyboard to
end the show.

PowerPoint has various options for setting up and playing a slide show.
We can set up an unattended presentation that can be displayed at a kiosk and
make our slide show repeat with continuous looping.

To access slide show setup options:
1. Select the Slide Show tab.
2. Click the Set up Show command

tions Animations Slide Show Review View

- = x V| Play Narratit
Ec NICT N
=\ JJ

v Use Timings
Set Up Hide Rehearse Record Slide :
Slide Show Slide  Timings Show~ ¥ Show Medi:

Set Up

: Set Up Show

B Set up advanced options for the
slide show, such as kiosk mode.

Fig:1.40

3. The Set up Show dialog box will appear. Click the buttons according to
the options available for setting up and playing a slide show.
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- N\
Set Up Show [
Show type Show slides
@ Presented by a speaker (full screen) @ al
Browsed by an individual (window) From: || | To:
Browsed at a kiosk (full screen) Custom show:
Show options Advance slides
Loop continuously until 'Esc’ Manually
| Show without narration @) Using timings, if present
[ show without animation Multiple manitors
Pen color: —
Laser pointer color: _IE‘ Primary Monitor
| Show Presenter View
To show a laser pointer during slide show, hold down the Ctrl key and press the left mouse
button.
[ ok ][ conce

Fig: 1.41
4. Click OK to apply the settings to the slide show.
1.10 Saving Presentation:

Save option allows us to save a new file or an existing file in standard
format (.pptx format). If we are working on a previously saved file this will
save the new changes in the same file format. If we are working on a new file,
this command would be similar to the Save As command.

1.10.1 Saving Presentation as pdf file:

As we know PowerPoint is used to create presentations, it supports
various file types when it comes to saving the content. Using a pdf file type can
be a great way of saving the slides.

Steps to save a presentation as a pdffile are:

Go to the backstage view under the File tab.

Click on Save As to open the Save As dialog.

Add a proper name to the file.

Select the file type as .pdf from the list of supported file types and
click save.

5.  The .pdffileis created in the specified location.

1.10.2 Saving Presentation as video file:

PowerPoint allows presentations to be saved as files that can be posted
on video sharing platform like YouTube or just played on any other media.

Steps to save a presentation as a video file are:

Go to the backstage view under the File tab.

Click on Save As to open the Save As dialog.

Add a proper name to the file.

Select the file type as .wmv from the list of supportedfile types
and click Save.

The video creation is not an instant process like other file types as
PowerPoint needs to create the video file. We can track the
progress of video creation at the bottom of our presentation
window.

0N

=N

o1
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6. Once the creation is complete, the video file is created in the
specified location.
1.10.3 Image File:

Among the many file types that PowerPoint supports Image File is also
supported by it. There are a set of extensions for image files. The image file
extensions supported by PowerPoint include JPEG (.jpg), GIF (.gif), TIFF (.tiff)
and Bitmap (.bmp).

1.10.4 PPT XPrinting Presentation:

It is sometimes necessary that we share our slides with our audience in
printed format before we begin presenting them so they can take notes.
1.10.5 PPT XBroadcast Slideshow:

PowerPoint 2010 offers users to broadcast their presentations on the
internet to worldwide audience. Microsoft offers the free broadcast Slide Show
service; all we need to do is share the link with our audience and they can
watch the presentation from anywhere. There is no special setup or charges
required to do this; all we need is a Windows Live account.

1.10.6 PPT XPackaging Presentation:

Certain presentations are better suited for distribution as a CD to
audience. In such cases, we can create a CD packaging which can be burned
into a CD and distributed.

1.10.7 PPT XSetting Document Password:

Sometimes it is important to protect the presentation and ensure
unauthorized users does not get to view the slides. PowerPoint offers users the
ability to protect the presentations.

Steps to password protect the presentation are:

. Go to the Backstage view under the File tab.

. On the Info section, click on the Permissions dropdown.

. Select "Encrypt with Password" to enable password protection.

. Enter the password in the Encrypt Document dialog.

. Re-enter the password in the Confirm Password dialog.

. Our presentation is now password protected. Readers will now have

to enter the password in the Password dialog to open the file.
Note:

OOl WIN -~

To unprotect the file, follow the steps up to Step 3 and delete
the password in the Encrypt Document dialog.

1.10.8 PPT X Email slideshow:

PowerPoint allows users to share the presentation as an email
attachment too. Although we can attach the presentation from outside the
program, the ability to send the emails directly from PowerPoint is quite
convenient. This is because we need not leave the PowerPoint program to send
the email.
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Steps to send an email from PowerPoint are:-

1. Go to the Backstage view under the File tab.

2. Click on Save & Send, select Send Using E-mail option and
click on Send as Attachment button.

3. This launches the Outlook Send Email window with the
presentation added as attachment. We can add the emails of
recipients and send the email.

Instead of "Send as Attachment" if we select "Send as PDF", we will

get a pdf attachment instead of a .pptx attachment.

File Home  Inset  Design  Transitions  Animations Slide Show Review  View  Storyboarding

| save : .

Save & Send Send Using E-mail
B save As

4 Attach a copy of this presentation to an e-mail
& Open U4 Send Using E-mail 8 e )
) Everyone receives separate copies of this presentation
[ Close Changes and feedback need to be incorporated manually
Save to Web e o
Attachment

Info
Recent Save to SharePoint Create an e-mail that contains a link to this presentation

Everyone works on the same copy of this presentation

r— '——‘_‘0 —— Everyone always sees the latest changes
F - Keeps the e-mail size small

. f\ Presentation must be saved in a shared location
=1 Ppublish Siides -

m . B Attach a PDF copy of this presentation to an e-mail
File Types g

(] Document looks the same on most computers
Help = Preserves fonts, formatting, and images
2 o H Change File Type 5’;;:‘ Content cannot be easily changed
] Options
3 et A Create PDF/XPS Document
g Attach a XPS copy of this presentation to an e-mail
u-n? Document looks the same on most computers
t,gl Create a Video == Preserves fonts, formatting, and images
Send as XPS Content cannot be easily changed

&  Package Presentation for CD

Send as Internet Fax

B _1] Create Handouts m Send a fax without using a fax machine
Requires a fax service provider
Send as

Internet Fax

Fig 1.42

1.¥ Computer software is classified into two categories: system software and
application software.

2. System software is software that consists of a group of programs.

3. Application software is software that can perform a specific task for the
user.

4. The main purpose of Word processing tool is to produce documents.

5. Database software is a collection of related data. The purpose of this tool
is to organize and manage data.

6. The spread sheet tool is used to maintain budget, financial statements,
and sales records.

7. Presentation tool is used to display the information in the form of slide
show.

8. Multimedia software is tool that allows the user to create audio and
videos with the help of Media players and real players.
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9. We can choose either portrait (vertical) or landscape (horizontal)

orientation for all or part of our document.
10. Word automatically inserts a page break when we reach the end of a page.
11.We can drag existing tab stops left or right along the ruler to a different

position.
12. As we type our document, red wavy lines will appear under any word that
is spelled incorrectly.

13. Print Preview automatically displays when we click on the Print tab.
14. Microsoft PowerPoint is a presentation tool that supports text, shapes,

graphics, pictures and multimedia.
15.The Themes in PowerPoint help us to select the backgrounds by default.
16. A transition can be as simple as fading to the next slide or as complex as a

flashy, eye-catching effect.
17.There are three categories of unique transitions to choose from, all of

which can be found on the Transitions tab: Subtle (slight transitions),

Exciting (strong transitions), Dynamic Content.
18.The most common types of animation effects include entrances and exits.
19.We can also add sound to increase the intensity of our animation effects.
20.In the power point gallery, entrance effects icons are colored green,

emphasis effects icons are colored yellow, and exit effects icons are colored

red.
21.PowerPoint allows us to start our slide show from the first slide or from

any slide within the slide show.
22.We can press the Esc key at the top left of our keyboard to stop or end the

slide show in power point.
23.PowerPoint allows presentations to be saved as files that can be posted on

video sharing platform like YouTube or just played on any other media.
24.The image file extensions supported by PowerPoint include JPEG (.jpg),
GIF (.gif), TIFF (.tiff) and Bitmap (.bmp)
25. Microsoft applications offer users the ability to protect the presentations.

Exe rCise 3. Word automatically inserts a page break

when we reach the of a page.
i i . a) Starting b) End
1. Multiple Choice Questions: ¢) Mid of page ) None of these
1. Which software consists of a group of 4. Aswetypeourdocument,  wavy
programs? lines will appear under any word that is
a)System software b) Application spelled incorrectly.
software a) Blue b) White
c) Utility software d) All of these c) Red d) Black
2. Which tool is used to maintain budget, 5. Which feature is in PowerPoint help us to
financial statements, and sales records? selectthe backgrounds by default.
a) Multimedia b) Spread sheet a) Animation b) Transition
c) Presentation d) Database c)Timer d) Theme
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Which option of Presentation can be as
simple as fading to the next slide?

a) Animation b) Sound Effect

c) Design d) Transition

The most common types of

effects include entrances and exits.

a) Animation b) Sound Effect

c) Design d) Transition

Usually which Key of our keyboard we can
press to stop or end the slide show in power
point.

a) Shift Key b) Ctrl Key

c) Alt Key d) Esc Key

Microsoft applications offer users the ability to
protect their file like documents, spread
sheets, and presentations etc. with Encrypt

with option.

a) Keyword b) Password

c) Lock d) All of these.

Page are the blank space around
the edges of the page.

a) Graphics b) Design

¢) Margin d) None of these

Fill in the Blanks:

Computer software is classified into two
categories:

We can choose either ........cccocceevvciieriennne,
(vertical) or (horizontal)
orientation forall or part of our document.
The image file extensions supported by
PowerPoint include ..........ccccovvveeeeenennnn. .a.,
................... , TIFF (.tiff) and Bitmap (.bmp)
Multimedia software is tool that allows the
user to create............... and ..ol with
the help of Media players and real players.

True or False:

The main purpose of Spread sheet tool is to
produce documents.

Application software is software that can
perform a specific task for the user.

3.

nun U e

oV hswWwNE

S
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Database tool is used to display the
information in the form of slide show.

We can drag existing tab stops left or right
alongtherulerto a different position.

Print Preview automatically displays when
we click on the Print tab.

Very Short Answer type Questions:

Write extension of Word document in Ms
Office 2010.

Write extension of Spread Sheet in Ms Office
2010.

Write extension of Power Point Presentation
Ms Office 2010.

Write the full form of bmp (Image file)
Write the full form of PDF.

Short Answer type Questions:

Define System Software?

Explain office Productivity tools?

Explain Database software?

Explain Multimedia software

Write steps to Create Custom Margins

What is Page Break? How to Insert a Page
Break?

Long Answer type Questions:

What is office tool? Explain any five types of
office tools?

How to create a resume with MS — Word
templates?

Write steps to create Student Annual Report
using mail merge with spreadsheet?

What is Tab Stops? Explain Setting Manual
Tab Stops

Explain Print Preview and Print Command?
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Answers Key

o
- 7= mt;'“ s o
— Spread sheet  Organize and manage TRUE Xlsx
n End Portrait or landscape FALSE .pptx
I & | Red JPEG (ipg), GIF (.gif)y  TRUE Bitmap
- Theme Audio and videos TRUE uenmaneni Document

Format
— Transition - - =
Animation - - -
_ Esc Key - - =
_ Password - - =
n Margin - - —
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Chapter
5 HTML FUNDAMENTALS |<@
Crs ot w
&
Objectives of this chapter:
Introduction

2.1 History of HTML
2.2 Whatis HTML?
2.3 Basic structure of an HTML document
2.4 CREATING AN HTML DOCUMENT
2.5 Web Browsers
2.6 HTMLTAGS
2.7 Attributes
2.8 Body tag with attributes
2.9 Formatting in HTML document
2.10 Lists
2.11 Images
2.12 Tables

Introduction

The Internet is rapidly becoming a key resource for locating information
relevant to a particular field. The Internet has been called the "network of
networks." Simply put, it's a way to link millions of people around the world,
each of whom is using a computer, smart phone, tab etc. connected to a smaller
network through ISP. Nobody owns or controls the Internet or the World Wide
Web, although millions of individuals and organizations control their own
systems. Some task forces have been constituted for its smooth functioning.
WWW is composed of millions of webpages containing text, graphics, sounds,
videos and link to other webpages. Have you ever think which basic technology
lies in writing these webpages, which we are using daily? We need a computer
language to design these web pages. The Basic and frequently used language
for designing a webpage is HTML. In this chapter we will discuss the basics of
HTML.

2.1 History of HTML

In early 1980's, SGML (standard generalized Markup Language) was
designed which was a extension of GML General Markup Language designed
early 1960's.SGML was originally designed to share large documents related to
government, law, and industry .In 1989 Tim Berners-Lee at CERN, THE
EUROPEAN laboratory in Geneva proposed and designed More refined
Internet based “hypertext markup language “.He also wrote browser and other
related software, It latter become a universally accepted language.
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2.2 What is HTML?

HTML stands for Hyper Text Markup Language. HTML is a language
used for DESIGNING A WEB page in which text, graphics, and other
information are organized, formatted, and linked together. HTML is a tag
based Language, which specifies the web browser what operation has to be
performed on the given text. Hypertext refers to a text which acts as a link in
markup language for describing web documents (web pages).A markup
language is a set of markup tags, HTML documents are described by HTML
tags, Each HTML tag describes a distinct meaning for which it has been
designed.

HTML is extremely simple, Flexible, easy to learn, interactive, widely
accepted Markup Language.

2.3 Basic structure of an HTML document
An HTML document has two main parts:
e Head. The head section contains title that identifies the heading of
the HTML document.
e Body. The body element contains the actual contents or information
that you want to display on a web page to the end user.

— HTML document contains the following syntax:-

<html>

<head>

<title>TITLE OF YOUR WEBPAGE </title>
</head>

<body>

Information which user wants to show.
</body>

</html>

Fig: 2.1
The tags defined in the above structure basically define or instruct the web
browser about the different operation to be performed on the text defined
in the given TAGS. We will now explain the above structure.

1.3.1 <HTML>HTML document is started <html>and ended
</html>with this tag. This TAG informs the web browser from
where a web page will start and where it ends. If the commands
are not defined in tags then the commands are taken as text by
the web browser.

1.3.2<HEAD Tag> Head tag provides Header information. The
document title is written in Head Tag. It always occurs in pair.
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Head Tag is considered very important for a web page. This is a
container tag. It defines the Heading of the HTML document. It
starts with<HEAD> TAG and ends with </HEAD> .This Tag is
always defined below <HTML> and above <BODY>tag. It contains
information regarding title of the webpage, keywords used by the

search engines etc. It contains no text in itself.
Eg. <HEAD> <TITLE> First Web Page </TITLE> </HEAD>
2.3.3<TITLE>TITLE tag defines the title of the webpage, which is to be

displayed on the title bar of the web browser when the web page is
loaded in the web browser. It is enclosed in between <TITLE>
AND</TITLE>tags. It should be short and meaningful of <TITLE>

First Web Page </TITLE>
2.3.4<BODY>BODY tag contains the actual information to be displayed

on the web browser. When the webpage is loaded in the web
browser. It may contain any element or contents related to text,
images, audio, video etc. These contents are defined with in
<BODY> and </BODY> tags. e.g. <BODY>This is my first

document in HTML document. </BODY>
Each Body tag has different characteristics. These characteristics

(properties) are termed as attributes. We can select Background colour, text
colour, font size etc. with these attributes.

2.4 CREATING AN HTML DOCUMENT:-

HTML webpages are plain text files that can be created using any text
editor or word processor such as Notepad, WordPad, MS-word. The following
steps are to be taken while creating and displaying a webpage.

1. Open Notepad by clicking Start—AllPrograms—Accessories—Notepad
or by typing Notepad in the run window. Notepad will be opened asshown
infig.2.1

""" | MYWEBPAGE - Notepad =

File Edit Format View Help

<HTML> -
<HEAD>

<TITLE> MY WEBPAGE</TITLE>

</HEAD>

<BODY>

WELCOME TO HTML

</BODY>

</HTML>

Fig: 2.2
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2. Now type the html code in the Notepad as Shown in the Fig. 2.2
Click on File—» Save menu option. A dialog box will appear as shown fig 2.2

select where you want to save the file, enter your file name with an
extension .html

~
_|| Save As oS
Ou ’ . » 10th chapter - | ‘f] | Search ol
‘ Organize + == Views ~ B New Folder
Favorite Links Name Date modified Type
No items match your search.
[ Documents

%] Recent Places
Bl Desktop

M Computer

B Music

% Recently Changed

More »

Folders ol | m b
File name: MYWEBPAGE.HTML| v
Save as type: | Text Documents (*.bd) v]

+ Hide Folders Encoding: [ANSI v] [ r—— ] [ P— ]

Fig. 2.3

2.4.1 VIEWING AN HTML DOCUMENT:-

Any HTML document can be viewed using any web browser like Internet
Explorer, Netscape Navigator, Mozilla Firefox, Opera or Google Chrome. Here
Internet explorer is used in examples.

To open Internet Explorer follow the underwritten steps:

1. Start— All Programs — Internet Explorer or start -+ Run — explore

in the text box and click OK.

2. Click File—»Open or press Ctrl + O from the keyboard, an open box
will appear and select htmlfile as shown in fig 2.3

32

Downloaded from https:// www.studiestoday.com



3.

Downloaded from https:// www.studiestoday.com

€ Windows Internet Explorer : E
@le I. v 10th chapter v | ¥4 ||| Search P

- - =
R
‘ Organize e . New Folder (

Fiorite ks Name Date modified Type Size
(O MYWEBPAGE 8/19/2016 8:45PM  HTML Document

E‘ Documents
%] Recent Places
)| Bl Desktop

™ Computer
n Music

(4 Recently Changed

B Searches

Ji Public

Folders Lol [ m | b

File name: v |HTML Fies -
[ Open ] [ Cancel |

Fig: 2.4

Choose the path where file is stored and open it with open button. The
webpage will be displayed in the browser as shown in fig 2.4:-

e |

'€ MY WEBPAGE - Windows Internet Bxplorer

(TN & cusemironaoeiiopunn copenptmeopac it m

File Edit View Favorites Toois Help
W \gwwzamss o~ #h v b Page v () Tools v

WELCOME TO HTML

Fig: 2.5
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2.5 Web Browsers:-
Webpages can be opened in any web browser. Now we will discuss some
commonly Used Web Browsers:-

1. Internet Explorer. Internet Explorer (IE) -- sometimes referred to as Microsoft
Internet Explorer (MSIE) -- is the most widely used World Wide Web browser. It
is bundled with the Microsoft Windows operating system and can also be
downloaded from Microsoft's Web site. It has been most popularly used web
browser since 1999.

2. Google Chrome:-Google Chrome is a freeware web browser developed by
Google. It was first released in 2008 for Microsoft Windows, and was later
ported to Linux, OS and Android. Speed, simplicity, security, privacy are the
main features of Google chrome.

3. Mozilla Fire fox:-Mozilla Firefox (or simply Firefox) is a free and open-source
web browser developed by the Mozilla Foundation and its subsidiary, the
Mozilla Corporation. Firefox is available for Windows, OS X and Linux
operating, with its mobile versions available for Android, and Firefox OS. Plug-
in compatible, fast web page downloads, "Safe browsing" ,Multi-tab feature
,private browsing are the main features of Mozilla Firefox.

4. Opera:-Opera is a web browser developed by Opera Software. The latest
version is available for Microsoft Windows, OS X, and Linux operating systems,
Opera is a Web browser that provides some advantages over other browsers
from Mozilla or Microsoft. Much smaller in size, Opera is known for being fast
and stable.

2.6 HTML TAGS

As to attract end users we have to make our web page attractive, which may
include text , graphics, and links. In HTML we can use tags which are defined in angle
brackets<>. The use of less-than and greater-than angle brackets surrounding an
element creates what is known as a tag. Tags most commonly occur in pairs of opening
and closing tags.

These tags are also known as elements. These tags can be defined in
two forms these are:-

1. Container Tags.

2. Empty Tags.

1 Container Tags:-The container is an area enclosed by the beginning and
ending tags. Container tags come in pairs. Every tag which is opened must be closed.
A container tag consists of a start tag and end tag, with the content inserted in
between, for example: <tag name>content goes here...</tag name>

for example, when you want italic text, you will contain the text between
opening <i>and closing </ i>. Html encloses the entire document in <html> and
</html>.

2 Empty Tags:-These elements are called empty or void and they only have a
start tag as they don't have any content. They must not have an ending tag in HTML.
For Example <BR> tag is used to break the given line from where it is used.

Note:-

Attribute of a tag defines the features of a given tag in its starting tag..
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2.6.1 Difference between container and empty tag

CONTAINER TAG

EMPTY TAG

1. HTML tags that need to be closed with
</> command are called container tag. A
container tag has a beginning (opening)
tag and an ending (closing) tag.

1. The tags which don’t need to be
closed with </> command are
called empty tags. An empty tag

has only the opening tag.

2. A container tag is a tag that may contains
elements or attributes.

2. Anempty tag is a tag that may or
may not contain element or

attributes.

3. Example: <html>....

....... </html>

3. Example: <BR>

2.6.2 Some of the commonly used container tags are defined below:

ELEMENT/TAG OPERATION PERFORMED | EXAMPLE OUTPUT
<B>...... </B> Bold the text <B>hello</B> hello
<I>... </I> Italic the text <[>hello</I> hello
<U>...... </U> Underline the text <U>hello</U> Hello
<SUP>...... </SuUPpP> Superscript the text a<SUP>2</SUP>. A2+p2
b<SUP>2</SUP>
<SUB>...... </SUB> Subscript the text H<SUB>2</SUB>0 H,O
<STRIKE>...... </STRIKE> | Strike through the text <STRIKE>hello</STRIKE> | Helle
<IT>...... </TT> Type writer font. <TT>hello</TT> hello

Above tags are explained in the example as shown in fig 2.6.

| CONTAINER TAGS - Notepad

(= D oo

File

Edit Format View Help

<HTML>
<HEAD>

<TITLE> MY DIFFERENT TAGS WEBPAGE</TITLE>

</HEAD>
<BODY>
WELCOME

TO HTML

<B>HELLO </B>
<I>STUDENTS</I>

<U>I WANT TO DRINK </U>
H<SUB>2</SUB>0

<STRIKE>AND WANT TO TELL SOLVE</STRIKE>

a<SuUP>2</SUP>+B<SUP>2</SUP>
<TT>TRY IT</TT>

</BODY>
</HTML>

Fig 2.6

The output will be displayed as shown in fig 2.7
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@ MY DIFFERENT TAGS WEBPAGE - Windows Intemet Explorer = B )

U\J | @ Casers\khalsa\De ~ | 43 | X || search The web e

File Edit View Favorites Tools Help

»

$% & | @ MY DIFFERENT TAGS W... 2~ B ~ #™ v |:):Page~

WELCOME TO HTML HELLO STUDENTS I WANT TO DRINK
H,0 AND-WANTFO-FELL-SOLVE a’+B% 1ay 1T

Fig 2.7
2.7 Attributes:
2.71. Difference between Tag and Attribute:-
TAG ATTRIBUTE
1. Tags contain elements which provide 1. An attribute defines a property for

instructions for how information will be an element, consists of an attribute.

processed or displayed. There are both Its value appears within the

starter tags <TAG> and end tags element's start tag.

</TAGS> Tags are used to mark up the
start and end of an HTML element.

2. Tags contains elements as well as attribute 2. Attribute is a part of starting Tag of
an element.
3. These are of two types:-Empty Tag and 3. Types of Attribute depend upon
Container Tag the tag used .i.e. each tag has its
own number of attributes.
4. Example:- 4 Example:-
<Table > <Table Border="3" >
Here table is a tag. a. Here a table is the Tag and

border is its attribute.

2.8 Body tag with attributes

Body Tag is the main part of the HTML document in which whole information about
the webpage resides. The main attributes of this tag are background, bgcolor and text.
Let us discuss these attributes used in Body Tag.

2.8.1 Background attribute is used to define the background of a webpage. This is
explained with an example in the figure as shown in html code and output in fig
2.8and 2.9

JB bodybackground - Notepad ]

Fle Edt Fomat View Help

<htm]>
<head>
<titlesMy Font Page</title>
</head>
<body background="Tampbg. jpg">
<font face="times new roman" color="white" size=4>
This webpage [looks different.
<;'fgn§>
</body>
</html>

/= My Font Page - Windows Internet Explorer =10/ x|
@f_ﬁ‘-he C:\Users\admnistrator Deskiopt1 =] | 42/ X [ Pl
| Fle Edt WView Favorites Tools Hebp

L Favorites g My Font Page

Fig: 2.8 Fig: 2.9
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2.8.2 Bgcolor attribute of body tag is used to change the background colour of the
webpage.
eg. <BODY BGCOLOR="GREEN">
EXPLAINED as shown with html code and output in fig 2.10 and 2.11

l bodvbgcok)r . Notepad Jﬂﬂ ;Ig'ﬂ
(5 ) ® 8] cusersiadministrate =] 49| % [0 500 P

Fie Edt Fomat Ve AL

pr i J | Fle Edt View Favorites Tools Help

<head> 7 Favorites & My Font Page

<titlesNy Font Page</title>

This webpage looks different with background colour.

</head>

<body bgcolor="green">

<font face="times new roman" color="white" size=4>
This webpage looks different with background colour]
</font>

</body>
</html>
Fig: 2.10 Fig: 2.11
2.8.3 Difference between BACKGROUND and BGCOLOR:
BACKGROUND BGCOLOR
1. Background attributeisused in body 1. Bgcolor attribute is used inbody as well
as well as in table tag ,to add as intable tag, to change the
background image in the given background color of the webpage or a
webpage or a table. table.
2. Syntax <body 2. Syntax is <table bgcolor="color_name">
backeround="URL">
3. Example 3. Example
<BODY <BODY BGCOLOR="GREEN">
BACKGRO! ="IMAGE1.IPEG">

2.8.4 Text attribute defines the color of the text and is defined with an example as shown

with html code and output in fig 2.12and 2.13 <BODY BGCOLOR="RED”
TEXT="WHITE">

Wodybgert-Maepad =X 5
Fk Edt Fmt \‘ﬂl l‘w G_\'jﬂg C:\Users\Adnin\su'amj | X I; Bing R~
<html> j | Fle Edt View Favorites Tools Help
<h?ad> , . Favorites @ My Font Page
<titleMy Font Page</title>
(/ he3d> This webpage looks different with background colour AND
<body bgcolor="red" TEXT="WHITE"> MR
This webpaqe looks different with background colour
AND TEXT colour,
</fgn§>
</body>
</htm>

Fig: 2.12 Fig: 2.13
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2.8.4.1 Some other text attribute s associated with body tag.

LINK The Link attribute defines the color of the unvisited links in a document. The
default color of LINK attribute is blue. In <BODY> tag, type LINK ="?",
replacing “?” with the name of color or color code which user wants to apply for
the unvisited link.

ALINK This attribute changes the color of Active link. An Active link is alink thatis in
the process of being clicked. The default color of A LINK is red. In <BODY> tag
type ALINK = “?”, replacing “?” with the name of color or color code which user
wants to apply for the active link.

VLINK The VLINK attribute defines the color of the link after it has been visited. The
default color is purple. In <BODY> tag type VLINK=“?", replacing “?” with the
name of color or color code which user wants to apvlv for the visited link.

TOP MARGIN | This attribute is used to set the top margin of aweb page. For eg: <BODY
TOPMARGIN= “VALUE">

LEFT This attribute is used to set the left margin of a web page. For eg: <BODY
MARGIN LEFTMARGIN= “VALUE">

2.9 Formatting in HTML document
2.9.1 Heading Tags:
The heading tag is used to fix the heading. There are 6 levels of heading . The
levels are numbered as heading 1 to heading 6. All the letters of the heading in
a given level have same font. The font size goes on decreasing as we move from
heading 1 to heading 6. The heading in level 1 is expressed by tags <H1> and
</H1>. Similarly in the heading in level 2 we use the tags <H2> and </H2>.
<H6> is the lowest level. The font size in it is the smallest. Heading tag is used
to define heading in a HTML document.HTML supports Six Heading Levels H1
to H6. Heading tags are container tags.

Example: <H1> Computer Education </H1>

The alignment attribute is used in heading tag. This aligns the text.
ALIGN attributes are of three types viz. LEFT, RIGHT and CENTER.
These are explained with an example as shown with html code and output
in fig 2.13and 2.14with html code and output: -

7 headings - Notepad W (=@ —

—_— & MY WEBPAGE with different HEADINGS - Windows
<HTML> C. e L@ C:\Users\khalsa\Desl + ] b 4 l x ||
<HEAD> . . File Edit View Favorites Tools Help
<TITLE> MY WEBPAGE with different HEADINGS</TITLE> T e e — 5
</HEAD>

<BODY> WELCOME TO HTML HEADINGS
WELCOME TO HTML HEADINGS

<H1>HEADING-1</H1> HEADING-1

<H2>HEADING-2</H2>
<H3>HEADING-3</H3>

<H4>HEADING-4</H4> HEADING-2

<H5>HEADING-5</H5> HEADING.3
<H6>HEADING-6</H6>
</BODY> HEADING-4
</HTML> e g
Fig: 2.14 Fig: 2.15
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2.9.2 FONT: -

Font is pre-defined style and size of the text. FONT is the style and shape of the text
which is used in any document. It allows to format data on a given web page.

Font has four main properties:

1. Style: Font style can be changed in three ways - Bold, Italic and Underline.

a. Font face: Face defines the type face to be used like writing.
2. Font colour: Font colour gives different colours to the text.
3. Font size: Font size changes size of text matter.

2.9.2.1. Face defines the type face to be used for the text.eg.

<FONT FACE="ARIAL">WELCOME TO HTML</FONT>

These are defined with an example as shown with html code and output in fig
2.16 and 2.17

el
Fe Edt Fomat Vew Hep br:ucﬁ‘.'n,fcmt’r'aw:e.html +
khﬁm]; E| -

<neaa> *

<t}1'1:1e>My Font Page</title> | Fie Edt View Favorites Tools Helr

:ﬂoﬁf 77 Favorites @ My Font Page

<faqt face="times new raman" >

Ip;;nlgcﬂ text looks different. T Rl e by

</body>
</htm]>
Fig: 2.16 Fig: 2.17

2.9.2.2 COLOR defines the colour of the font to be used. It is defined with an

example as shown with html code and output in fig 2.18and 2.19
<FONT FACE="ARIAL” color="RED”">WELCOME TO HTML</FONT>

I8l fontfacecolor - Notepad /> My Font Page - Windows Internet Explo

File Edit Format View Help - -
= @: v |g C:\Users\Admnnlstrato;I &
<head>

<title>My Font Page</title> | File Edit View Favorites Tools Help
<éh§ad>

< O ,—* 1
<fonty1:ace="t'imes new roman”" color="red"> 1 Favorites @& My Font Page

This Tocal text looks different.

</font> ' _

</body> This local text looks different.

</html>|

Fig: 2.18 Fig: 2.19
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2.9.2.3. SIZE defines the size of the font. It has values from 1 to 7, while 1 is
the smallest and 7 is the largest font size. By default font size is 2. font size 1

means 6 points, 2 means 12 points and so on.

Example of font and its attributes are defined as shown with html code

and output infig2.20and 2.21: -

PRy

""- N w Y
_| font - Notepad ‘ ' | E

File Edit Format View Help

<HTML>

<HEAD>

<TITLE> font tag and its attributes</TITLE>

</HEAD>

<BODY>

<font size="3" color="red">Text is red with font size 3</font>
<font size="2" color="blue">size=2 color=blue!</font>

<font face="verdana" color="green" size=5>color="green"size=5
font=verdana!</font>

</BODY>
</HTML>
Fig: 2.20
@ font tag and its attributes - Windows Internet Explorer [E@g
@v v |@ C:\Users\khalsa\Desl + | ‘f‘ X ' Search The Web L v
File Edit View Favorites Tools Help
= f — ) - . »
W0 ¢ | @ fonttag and its attributes { ‘ 2 v B - ™ v |:hPage~

Text is red with font size 3 size=2 color=blue!

color="green"size=5 font=verdana!

Fig: 2.21
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2.9.3 Paragraph Tag:-

Single large documents are not recommended in a webpage as it is not
edited easily. So, it is highly recommended to divide the text or document in
different sections which is possible through paragraph tag<P> When we use
this tag a blank line is inserted before and after the paragraph automatically
by the browser.

Ex. <BODY> Computer is an electronic Machine. It is a data
processing machine. <P> and has memory </P> <BODY>

This is a container tag.

The text will automatically go to the new line after tag <P>

<P ALIGN="RIGHT”>

<P ALIGN="LEFT">

<P ALIGN="JUSTIFY">

<P ALIGN="CENTER">

EXAMPLE OF <P> TAG.WITH OUTPUT:-
This tag is defined with an example as shown with html code and output
in fig 2.22and 2.23

| 7| PARAGRAPH - Notepad
File Edit Format View Help

<HTML>

<HEAD>

<TITLE> MY WEBPAGE with PARAGRAPH TAG</TITLE>

</HEAD>

<BODY> i

<P ALIGN="JUSTIFY">The paragraph tags are used to

define a block of text as a paragraph.</P>

<P ALIGN="RIGHT"> This HTML element is

one of the basic HTML tags you should learn to

use properly.</pP>

<P ALIGN="CENTER">When a block of text is surrounded
by the paragraph tags, the browser automatically

|adds white space before and after the paragraph.</p>

l</BODY>

|</HTML>

Fig: 2.22

V4 MY WEBPAGE with PARAGRAPH TAG - Windows Internet Explorer’ =TS
| @ C\Users\khalsa\Des| v | 3 | X || Search The Web
File Edit View Favorites Tools Help

W & | @MYWEBPAGEwithPAR.. | | R ~ ~ dm v |-} Page ¥

The paragraph tags are used to define a block of text as a paragraph.

This HTML element is one of the basic HTML tags you should learn to use
properly.

‘When a block of text is surrounded by the paragraph tags, the browser
automatically adds white space before and after the paragraph.

Fig: 2.23
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2.9.4 Empty TAG
2.9.4.1 BREAKTAG<BR>

The line Break tag is used to start the text from the new line. This tag
does not leave a blank line space as the paragraph tag does. The text jumps
to the new line on using break tag. The tag <BR> is a symbol for line
break.The<br>tag inserts a single line break. The <br>tag is an empty tag
which means that it has no ending tag.This is defined with an example as
shown with html code and outputinfig 2.24 and 2.25

ol
Fie Edit Format View Hep
<html> o
<head> B
<titlesMy Font Page</titles
</head>
<body >
This webpaqe looks different<gr> with background colour
AND TEXT colour.
</1/‘gn§>
</body>
</htm1>
Fig: 2.24

%
@’-\v £ C:\Users\Administrato ¥ | | *2|| X | Bing P~

| Fle Edt View Favorites Tools Help

L Favortes (@ My Font Page | I

[ |

This webpage looks different
with background colour AND TEXT colour.

Fig: 2.25

2.9.5 Difference between Paragraph Tag and Break Tag.

Paragraph <P> Tag

Break <BR>Tag

<p> tag Tag is a container element which marks a
block of text as a paragraph in a webpage and the
web browser leaves a line between two
paragraphs. This tag has an attribute ALIGN,
which can take three values - left, right and center
.The <p> tag denotes a paragraph and ends witha
</p>and is a container tag.

1. <BR> tag is an empty element that
is used to break a line and display
the proceeding text from the next
line, without giving any space
between two lines. It has no
attribute. The <BR> is a line break
and is an empty tag.

This tag is used to define paragraphs with in your
text.

This tag is simply a line break. It
just jumps to the next line without
anv spacing or formatting ootions.

Example:- <p>hello world</p>

Example - Hello<br>world!

2.9.6 HR Tag

The <HR> tag is used to insert horizontal line across the page. Its

attributes are:

e Size

e Width
e Align
e Color

It is used to set the thickness of line.

It is used to set the length of line.

It is used to set the alignment of line.

It is used to set the color of line.

These are explained in Fig 2.26and 2.27
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T v
| HRTAG - Notepad (= ) b
B MY WEBPAGE with differ- 3
File Edit Format View Help
sescer C = B filey)/C/Users/khalsa/Desktop/htmi/10th3%20chapter/HRT, | @ | @
<HTML>
<HEAD> + | [ Other bookmarks
<TITLE= MY WEBPAGE with different HEADINGS</TITLE>
<HEAD> HR TAG WITH EXAMPLE
<BODY ALIGN=CENTER>
<HR SIZE=5 ALIGN=CENTER WIDTH=1000 COLOR=RED>
HR TAG WITH EXAMPLE HELLO
<HR SIZE=5 ALIGN=CENTER WIDTH=700 COLOR=GREEN>
<H1>HELLO<H1>
<HR SIZE=5 ALIGN=RIGHT WIDTH=700 COLOR=LIGHTGREEN> 3 7
<H2>WELCOME</H2> E WELCOME
<HR SIZE=5 ALIGN=LEFT WIDTH=500 COLOR=LIGHTBLUE>
<H3>HR </H3> HR
<HR SIZE=5 ALIGN=CENTER WIDTH=500 COLOR=PINK>
<H4>TAGGING=/H4>
<HR SIZE=5 ALIGN=CENTER WIDTH=500 COLOR=LIGHTCYAN> -
<HE>EXAMPLE</HS> -
<HR SIZE=5 ALIGN=LEFT WIDTH=500 COLOR=LIGHTRED>
<HB>THANKS/HE> :
<BODY> EXAMPLE
</HTML> -
/| i
Fig: 2.26 Fig: 2.27

2.10 Lists
While accessing some information from the web, user prefers to

read only the required information from the website. So, lists play an
important role in defining important information in the form of few lines.
For example. As the user wants to differentiate between two distinct
objects, then it will be better to represent it in the form of lists. In HTML
there are three types of lists available.

These are as follow:-

1. Numbered Lists (Ordered List)

2. Bulleted Lists (Unordered List)

3. Definition Lists

2.10.1 ORDERED LIST :-

Also known as numbered list ,it is used to define a list in a specific
or sequential order in which numbers are used. The basic tag used for
Ordered list is <OL> tag at the starting and</OL> at the end of the list.
Each item is marked with an<LI> (List Item)tag. By default the list is
started with 1. But user can change the starting number.

ATTRIBUTES USED:- In an Ordered List the attributes used are “TYPE“
which have values as 1(Arabic),A(upper case letter),a(Lower case
letters),I(Upper case Romans),i (Lower case Romans).

Eg.<OL type="I">

Second attribute used is START in which user can define his own

starting value in the list.
Eg.<OL Start="5" Type="i" >
Ordered List example is shown as follows inexample as shown with
html code and output in fig 2.28and 2.29
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P& GROERED LisTs - Wind

@ W o

File Edit Format View Hel
— — ikt i € C:\Users\khalsa\Desktop\10th chapter\data updated in schoolorde

<html=> . =
<head> File Edit View Favorites Tools Help
z;;;;S:ORDERED LISTS</title> __E?____ﬁ__lgomm"m“ ! ‘ —
<body> I
Order List of Hardware units with Order List of Hardware units with different attributes
different attributes TYPE=a start=2
<BR>TYPE=a start=2
<0'| start="2" type="a"> b. Keyboard

<1i>Keyboard</11>

| . £ c. Mouse
<li>Mouse</11> 3 ek
<}"i_|>5canner'</'l‘i>
</01> T
TY'.TE=I TYPE=I
<01 type="1I"> :
<li>Printer</1i> [: g‘m“
| <1i>Speaker</1i> - Speaker
<li=SMonitor</1i> ML SMonitor
</01>
TYPE=1 START=5 TYPE=1 START=5
<01 Start="5" type="1">
<li>MotheBoard</11> 5. MotheBoard
<li>Hard disk</11> 6. Hard disk
| <1i>Netwrok Interface card</li> 7. Netwrok Interface card
</01=>

</body=>

</html>

‘<

Fig: 2.28 Fig: 2.29

2.10.2 Unordered List (Bulleted List) :-

The lists which have information related to each other but their
sequence is not important are called Bulleted Lists. It has a starting tag as
<UL> and ending tag as </UL>tag. Each item is marked with <LI>tag which
stands for List Iltem. Any number of elements can be added in it. This

is defined with an example as shown with html code and output in fig 2.30
and 2.31

n X Rlepacy ; - el el e} P " =
[ File Edit Format View Help | ‘___M’Emw# 1 ===
UU v !ﬁC\Usus\lha\sakﬂtshnp\lﬂtﬂchapw\dmupdatad‘ludmhumrdmdlisnml | x”.‘mﬂ The e P
<title>My Font Page</title> e Bt Vew Fovoites Teds Help
</head> = — - —
WA EMyFothge ﬁvumv:?*v&[wkv
UnorderListshowmn nput devices
<}i75canner</1i> + Kesboard
</ul> + Mouse
</body> .
</html> Soame
Fig: 2.30 Fig: 2.31
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By default attribute used for bullet list are used as disc. But these
bulletscan be changed by using an attribute as TYPE .It can be used in
<UL> as well as in <LI> tag as per the requirement. the values support by
this attribute is defined as

Disc (@)

CIRCLE(©O)

SQUARE(m)

These are explained and defined with an example as shown with html

code and outputin fig 2.32 and 2.33

7] unordered listTYPE - Notepad [P 8 UNORDERED LISTS - Windows Internet Explorer
_File Edit Format View Help K5\ | @ Ch\Users\khalsa\Desktop\10th chapter\data updated in schoohunore
<html> o

<head> File Edit View Favorites Tools Help

<title>UNORDERED LISTS</titlex> > =

T Raads ¥# 4 | %8 UNORDERED LISTS

<body>

Unorder List of Input Devices with
different attributes
<BR>TYPE=DISC

<ul type="disc">

Unorder List of Input Devices with different attributes
TYPE=DISC

<li>Keyboard</11i> + Keyboard
<li>Mouse</1i> okl
<li>Scanner</11i> :c,
</ul> = Scanner
TYPE=CIRCLE
<ul type="circle"> TYPE=CIRCLE
<li>Keyboard</1i>
<li=Mouse</1i> o Keyboard
<li>Scanner</11i> o M
</ul> %

o Scanner

TYPE=SQUARE

<ul type="square'>
<li>Keyboard</1i>
<li>Mouse</T11i>
<li=Scanner</li>

TYPE=SQUARE

B e = Keyvboard
</body> o Mot
</html> = Scanner

Fig: 2.32 Fig: 2.33

2.10.3 Difference between Ordered List and Unordered List

| Ordered List Unordered List

1. Inan Ordered List, the order of the 1. Inan unordered list the order of the items is
listitem is important. If we change the not significant .We can swap two items or
order, the meaning of the whole list reverse the whole list, and it still remains the
changes. same list.

2. Ordered List starts with <OL>and 2. Unordered List starts with <UL> and ends
ends with</OL> tag. with</UL> tag.

3. OLis acontainer tags 3. ULiscontainer tags.

4. OLhas an <LI> (List Item) tag which 4. ULhasan <LI> (List Item) tag which defines
defines the list elements defined in the the list elements defined in the list.
list.

5. Inan Ordered List the attribute used 5. Inan Ordered List the attribute used is TYPE
is TYPE Which has values as Which has values as
1(Arabic), A(upper case letter), “Disc(*)”, "(ARCLE(O)”, and “SQUARE(N)”.
a(Lower case letters), I(Upper case Eg.<UL type="disc¢">
Romans),i(Lower case Romans).
Eg.<OL type="1">

6. Default value of TYPE ATTRIBUTEis1. | 6. Default value of TYPE ATTRIBUTE is “Disc(«)”
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2.10.4 Definition List:-

Definition list generally contains the definitions of different terms and
their meaning. It starts with <DL> tag and ends with</DL>tag. It has two
main tags definition Term <DT> and Definition Description <DD> tags.
These are explained in the following example as shown in figure 2.34 and
2.35 with html code and output.

File Edit Format View Help

<html>
<head>
<title>DEFINITION LISTS</titlex>
</head>
<body>
DEFINITIONS
<DL>
<DT>Center

<DD> A point equidistant from all points
on the surface of a sphere.
<DT>Centre
<DD> In some field sports, the player who
holds the middle position on the field, court,
| or forward line.
</DL>
</body>
</html>

< |

Fig: 2.34

7€ DEFINITION LISTS - Windows Interet Explorer e

(— (el @ C:\Users\khalsa)\Desktop\10th chapter\data updated in school\definition lists.html v | ¢3 | & [ Search The wes .0 -

Fule Edit View Favorites Tools Help
i.é o \&DEFINrHONuSTs | | M v ) - ® v |Page v {(Tooks v

DEFINITIONS

Center
A point equidistant from all points on the surface of a sphere.
Centre
In some field sports, the player who holds the middle position on the field, court, or forward line.

Fig: 2.35
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2.10.5 Nested Lists:-

When a List is inserted in other list it is known as Nested List. We
can explain the nested list with the following example as shown with html
code and output in fig 2.36 and 2.37

J nested lists - Notepad & NESTED LISTS - Windows Internet Explorer
File Edit Format View Help @U + | @ CA\Users\khalsa\Desktop\10th chapter\d
<ol=> " — :
<1i >Chapter‘ One File Edit View Favorites Tools Help
<ol> ¢ 4k | /@ NESTED LISTS
<li>Section 1.1 - -
<li>Section 1.2
<li>Section 1.3 NESTED LIETS
</01>
<li>Chapter Two L. Chfp“sfo',“ .
<ul type="cirlce"> e -
<li>Section 2.1 2. Section 1.2
<li»Section 2.2 3. Section 1.3
<li> Section 2.3 2. Chapter Tvlvo
<1i> Section 2.4 o Section 2.1
</ul> o Section 2.2
<li>Chapter Three o Section 2.3
<ol _type="1i"> o Section 2.4
<li>sSection 3.1 3. Chapter Three
<li»Section 3.2 i Section3.1
<li> Section3.3 & Cectind
7 _I<'I'|> Section3.4 i Section33
</00> iv. Section3 4
</body>
</html>
« m
Fig: 2.36 Fig: 2.37

2.11 IMAGES:-
By now you know enough to write a very nice, text-based home page

in HTML, but it is the ability of the Web to provide pictures, technically
called images, graphics, or sometimes icons, that has made it so popular.
In this following section we 'll learn how to place an image in our web page
and attributes related to it. Various graphics formats used are
jpeg,.jpg.,.gif, png etc.

To add an image to a webpage, the tag used is <img
SRC=""FILENAME”>.Here SRC defines the source of the image and file
name defines the filename with extension of the image chosen.

NOTE:-The location of the image file must be defined properly. i.e.
either the file is in the same folder in which web page is stored or User has

to define the complete path of the file.
Eg If file is in the same folder then it can be defined as
<Img SRC="green.jpeg">
OR

<img SRC="C:\html\ 10class\green.jpeg”>
The attributes of image tag are defined below:-
1. ALT stands for "alternate text". This tells the browser that if it

can't find the image, then just display this text. For example a disabled
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user using a screen reader,visit the webpage, When he mouse over the image,

the alternate text pops up.

Example for this is as follows:
<Img SRC="green.jpeg” Alt="green color image is shown”> and are
explained with an example as shown with html code and output in fig 2.38

and 2.39:-

"] images - Notepad

(= 6 b

File Edit Format View Help

<html=
<head=>
<title=IMAGES TAGS<ftitle=
</head=
<body=
<img src="image2. jpeg"
Alt="beautiful pic shown">
</body>
</html=

Fig: 2.38

 IMAGES TAGS - Windows Internet Explorer

- + [ C\Users\khalsa\Desktop\10t = | 45| x | [ Search Tme wes 2~
o d

File Edt View Favorites Tock Help =

W4 | @8 IMAGES TAGS B-B-m-

Fig: 2.39

2. WIDTH stands for the image in pixels as well as percentage of the
web browser window. It can range from 1 pixel to any number, but
generally will be less than the width of the web browser.

3. HEIGHT stands for the height of the image in pixels or percentage
of the web browser windows. Again, the height can be just about
anything, but generally will be less than the height of the web

browser.

Example<img src="images2.jpeg” height=50% width=30%>
These are explained with an example as shown with html code and output

infig2.40and 2.41:-

| imageshw - Notepad

=)

File Edit Format View Help

<html=

<head=>

<title=IMAGES TAGS<ftitle>

</head>

<body=

<img|src="image1 jpeg" height=50% width=30%3>
</body=

</html>

Fig: 2.40

@ IMAGES TAGS - Windows Internet Explorer = [ B1| 32 |

@U v ‘@ C:\Users\khalsa\De « | +3 ‘ x [ Search The

% ¢ | @ IMAGES TAGS o
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4.  Align defines the alignment of the attached image in contrast to the
other contents of the webpage. It has different values left, right, top

and bottom.
Example for this is as follows
<img src="images2.jpeg” align="Right” >

Note:

To increase the space at the top and bottom of an image, use VSPACE
and HSPACE.

These are explained with an example as shown with html code and
output in fig 2.42 and 2.43:-

_| imagesalign - Notepad L‘:'_@_@-

i File Edit Format View Help
| <html>
<head>
<title>IMAGES TAGS</title>
| <head>
<body=>
<img src="image1 jpeg" align="Right" height=50% weight=50%>
| Adding images to your website or social networking
| profile is a great way to spruce up your page.
The HTML code for adding images is straightforward,
and often one of the first lessons for an HTML
novice. [
</body> |
</html>

KPashd & CAUsers\khalsa\Desktop\ith chapterdata = | ¢y |  |f Search The e
| —

Fle Edt Viev Favorites Tools Help
Tt MAGES TAGS Bov B v v rPagew (3Toos v

Adding images to your website or social networking profile is a great e L
‘way to spruce up your page. The HTML code for adding images is 4 " |
straightforward, and often one of the first lessons for an HTML

novice.

Fig: 2.42 Fig: 2.43

Similarly other alignments can be performed by changing align attribute
values.

2.12 Tables:

2.12.1 Creating Tables in HTML: -

In previous topics we have explained the various aspects in which
information is defined in the form of sentences and paragraphs. However, the
information can be defined in the form of columns and rows or tabular form. It
allows tomanage the information in to multiple rows and columns. The HTML
tables allow web authors to arrange data like text, images, links, other tables,
etc. into rows and columns of cells. It makes the webpage attractive. Table
begins with <Table> tag and ends with</Table>. Table has various attributes
which will be discussed later. Table tag has various other tags which are
explained below ;-

1. Table Heading<TH>.It defines the table headings of a given table. It
starts with <TH> tag and ends with</TH>tags. It should be defined with
in the Table Row<TR>.

2. Table Row<TR>.It defines the row in a table. Table heading and table
data are defined with in the row which starts with <TR>Tag and ends
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with </TR>
3. Table Data <TD>It defines the data of the table. Table data defines the
information stored in the table. It starts with<TD> data and ends
with</TD>.
Let us explain all these tags as shown with html code and output in fig
2.43and 2.44. _
S e — -

d oh,ﬁ.u'.u =t Explorer

File Edit Format View Help

<html=>

<head>

<title>TABLES EXAMPLES</titlex>
</head>

<body=>

<table>

<tr>

@ C:\Users\khalsa\Desktop\10th chapter\c v

File Edit View Favorites Tools Help

<th>Input Devices</th>
<th>Output Devices</th>
<th>Storage Devices</th>
</tr>

<trs>

0 4 | TABLES EXAMPLES BRE: R >

<td>Keyboard</td>
<td>Monitor</td>
<td=Hard Disk devices</td>

. Input Devices Output Devices Storage Devices
</tr>

Keyboard Monitor Hard Disk devices
Mouse Printer Compact Disk

<tr>

<td>Mouse</td>
<td=Printer</td>
<td>Compact Disk </td>
</tr>

</table=

</body=>

</html>

Fig: 2.44 Fig: 2.45

2.12.2 Attributes of Table Tag:-
Border:- The border attribute defines the width of the table border. It has
O value for no border and by default value is 1.
Example for this is as follows.
<Table Border="1">
ALIGN:-  Align attribute defines the alignment of the table in the browser
window. It has left, right and center values.
Example for this is as follows.
<Table align="Right" Border="1">
BORDERCOLOR: - It defines the color of the border.
Example for this is as follows.
<Table BORDER=2 BORDERCOLOR="RED">
WIDTH:-Width defines the width of the table. It can be defined in pixel or as
a percentage of the web browser window.
Example for this is as follows.
<Table WIDTH="35 %">
It defines the 35% space of the browser.
<Table WIDTH=500>
It defines the 500 pixels space of the browser. All the above tags
are explained with an example shown in fig 2.46 and 2.47
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<title>TABLES EXAMPLES</titlex>

</head>

<body=>

<table border="2" bordercolor=red bgcolor="green"
align="right" width =50%>

<th>Input Devices</th>
<th>0utput Devices</th>
<th>Storage Devices</th>

<td>Keyboard</td>
<td>Monitor</td>
<td>Hard Disk devices</td>

<td>Mouse</td>

<td>Printer</td>

<td>Compact Disk </td>
</tr>

Fig: 2.47

2.12.3 CELLSPACING is the pixel width between the individual data cells in
the TABLE. (The thickness of the lines making the TABLE grid). The default
value is zero. If the BORDER is set at O, the CELLSPACING lines will be
invisible.

Example for this is as follows.
<Table Border="2" cellspacing=12> and is explained with an example as shown
with html code and output in fig 2.48and 2.49

o
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| TABLES cellspacing
File Edit Format View Help

<html>
<head>
<title>TABLES EXAMPLES</title>
</head>
<body>
<table border="1" cellspacing=10>
<tr>
<td>some text</td>
<td>some text</td>
</tr><tr>
<td>some text</td>
<td>some text</td>
</tr>
</table>
</body>
</html1>

Fig: 2.48 Fig: 2.49
2.12.4 CELLPADDING is the pixel space between the cell contents and the
cell border. The default for this property is also zero. This feature is not used
often, but sometimes comes in handy when you have your borders turned on
and you want the contents to be "away" from the border a bit for easy viewing.
CELLPADDING is invisible, even with the BORDER property turned on.

Flle Edit View Favorites Tools Help

Yo @ | @ TABLES EXAMPLES ||

some text |some text

some text |some text

Example for this is as follows.
<Table Border="3" cellpadding=10>These are explained below with html

code and its output as shown in fig 2.50 & 2.50

- il Echt — Formet- {Wiemmy Help
<html>
<head>
<title>TABLES EXAMPLES</title> | File Edt View Favorites Tools H"P
:égg?ﬁ} W |gTABLEsexAMpLEs
<table border="" cellpadding=5>
<tr:>
<td>some text</td>
<td>some text</td> some text | some text

</tr><tr>

<td>some text</td> some text | some text
<td>some text</td> L - -

Fig: 2.50 Fig: 2.51

2.12.5 Difference between CellSpacing and cellpadding
Cellspacing Cellpadding

1. Cellspacing isattribute of Table Tag. 1. Cellpaddingis an attribute of Table Tag

2. The cellspacing attribute specifies the 2. The cellpadding attribute specifies the
space, in pixels, between cells in a space, in pixels, between the cell wall
given table.. and the cell content.

3. Example:- <Table Border="2" 3. Example:- <Table Border="3"
cellspacing=12> cellpadding=10>
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2.12.6 COLSPAN and ROWSPAN. Table cells can span across more than
one column or row. The attributes COLSPAN ("how many across")defines the
combination of one or more columns together while ROWSPAN ("how many
down'") indicates how many rows to be combined together.

Syntax for this is as follows.

<Table Border="1" colspan=2>

<Table Border="1" rowspan=2>

These are explained with an example as shown with html code and
outputinfig2.51 and 2.52:-

File Edit Format View Help

SN : 22 [ErTTTEOR CITTE
<title>TABLES EXAMPLES</title» e e —
</head> File__Edit View Favorites Tools Help

<body> | B“ki — -
<table border=1> | @ TABLES EXAMPLES | f2 v B v @ v [}Pager

<tr>
<th colspan=3 align=center:>

hardware devices</th> hardware devices

</tr> Input Devices Output Devices Storage Devices

<tr> Monitor Hard Disk devices
<td>Input Devices</td> Keyboard B 3
<td>Output Devices</td> Printer Compact Disk
<td>Storage Devices</td>

</tr>

<tr>
<td rowspan=2>Keyboard</td>
<td>Monitor</td>

<td>Hard Disk devices</td>
</tr>
<tr>
<td>Printer</td>
<td>Compact Disk </td>
</tr>
</table>
</body>
</html>
Fig: 2.52 Fig: 2.53
2.12.7 Difference between Colspan and Rowspan
COLSPAN ROWSPAN
1. Sometimes it makes sense for a cell to span 1. Sometimes it makes sense for a cell
multiple columns . This might be used for to span multiple rows. This might
a header cell that titles a group of columns be used for aside-bar that groups
of entries. rows of entries.
2. Allows a single table cell to span the width 2. Allows a single table cell to span
of more than one cell or column. the height of more than one row.
3. COLSPAN s attribute thatisused in 5. ROWSPAN s attribute that is used
i.e. <th>and <td> tag. ini.e. <th>and <td> tag,
4. It provides the same functionality as 4. Ttprovide the same functionality as
“merge cell” in spreadsheet programs like “merge cell” in spreadsheet
Excel. programs like Excel.
5. Example:- 5. Example:-
<th colspan="2"> <th rowspan='2">
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2.12.8 Table Background:-

BACKGROUND attribute is used to set the background image in the

given table.

The example for this is as follows:-

<table background="up.jpeg”

with an example.

border=2> This is explained below

These are explained with an example as shown with html code and

output in fig 2.54 and 2.55:-

[P 5|

7| TABLES bg - Notepad
File Edit Format View Help

<html>
<head>

<title>TABLES EXAMPLES</titlex>
</head>
<body>
<table background="bgsky. jpeg" border=1x>
<tr>
<th>Input Devices</th>
<th>0utput Devices</th>
<th>Storage Devices</th>
</tr>
<tr>
<td>Keyboard</td>
<td>Monitor</td>
<td>Hard Disk devices</td>
</tr>

<tr>
<td>Mouse</td>
<td>Printer</td>
<td>Compact Disk </td>

</tr>

</table>

</body>
</html>

m *

Fig: 2.54

{6 TABLES YANPLES - Windows et Exlrr B

*'7 ‘ X ‘ | Search The Web P

@U o sk et +

file Edt View Favortes Tools Help

WA TABLE EXAMPLES R ® e ook

hpﬂDévites Ollplt Devices Siﬁnge Devices

Keybord ~ Monitor Hard Disk devices

Mowe  Printer Compact Disk
Fig: 2.55

BGCOLOR:-BGCOLOR is used to set background colour of the table. The
example used for this attribute is as follows:-
<table bgcolor="yellow” border=2>This is explained below with an

example.(Fig. 2.56 and 2.57)

[E=ECE=

| TABLES bgcolor - Notepad
File Edit Format View Help

<html1>
<head>
<title>TABLES EXAMPLES</titlex>
</head>
<body=>
<table bgcolor="yellow" border=2>
<tr>
<th>Input Devices</th>
<th>0Output Devices</th>
<th>Storage Devices</th>
</tr>
<tr>
<td>Keyboard</td>
<td>Monitor</td>
<td>Hard Disk devices</td>
</tr>

<tr>
<td>Mouse</td>
<td>Printer</td>
<td>Compact Disk </td>
</tr>
</table>
</body>
</html>

m »

Fig: 2.56

(@ TABLES EXAMPLES - Windows Intemet Explorer

@U v |fé C:\Users\khalsa\Desktop\10t v | #4 ‘ X ‘ | Search The W

File Edit View Favorites Tools Help

Y% & | TABLES EXAMPLES R RRE

Input Devices Output Devices Storage Devices

Keyvboard  Monitor Hard Disk devices
Mouse Printer Compact Disk
Fig: 2.57
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gnts emember

1. HTML is a Hypertext markup Language which is used to design
webpage.

2. HTML codes are defined in Tags.

3. There are two types of element tags: Container and empty tags.

4. Container has both opening and closing tags while empty tags have
single tag.

S Web browser is used to see the output of html Program example Google

chrome, Internet explorer, Firefox, Opera etc..
6. Heading tags can be defined between <H1> to<H6> Tags.

7. User can format his/her text using various tags example. <B>, <U>, <I>
etc.

8. .html or .html is the extension of HTML program.

9. Each tag has some attributes which are used to define the properties of
that tag.

10. There are three types of lists these are ordered, unordered and
definition lists.

11. Nested Lists are used to represent list with in list.

12.  User can connect multiple webpages together with linking.

13. Linking of pages can be done using Anchor<A> tag.

14. Information can be defined in the tabular form, the tag used for this is
<table>.

15. <IMG>Tagis used to define images in a web page.

3. What is the correct HTML tag for
inserting a line break?
b. <lb>

: a. <br>
Exe rc I S e c. <break> d. <newline>

4. Which of the following is not a

1. Multiple Choice Questions: pair tag?
. a. <p> b.<u>
1. What should be the first tag in c. <I> d. <img>
any HTML document? 5. Some tags enclose the text.
a. <head> b. <title>

Those tags are known as

a. Couple tags b. Single tags

c. Double tags d. Pair tags

6. Marquee is a tag in HTML to

a. mark the list of items to
maintain in queue

b. Mark the text so that it is
hidden inbrowser

c. <html> d. <document>
2. Choose the correct HTML tag
for the smallest size heading?
a. <heading> b. <h6>
c. <hl> d. <head>
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c. Display text with scrolling effect
d. None of above

7. HTML supports
a. ordered lists
b. unordered lists
c. both type of lists
d. does not support those types

8. Which attribute is used withimg
tag to display the text if image could
not load in browser?
a. description b. name
c. alt d.id

9. Awebpage displays a picture. What
tag was used to display that

picture?
a. picture b.mage
c.img d. src

10. Which tag inserts a line
horizontally on your web page?
a. <hr>
b. <line>
c. <line direction="horizontal">
d. <tr>
11.Which tag allows you to add a row
in a table?
a.<td>and </td> b.<cr>and</cr>
c.<th>and </th> d.<tr>and</tr>
12. What is the full form of HTML?
a. Hyper text markup language
b. Hyphenation text markup
language
c. Hyphenation test marking
language
d. Hyper text marking language
13.What is a FTP program used for?
a. Transfer files to and from an
Internet Server
b. Designing a website
c. Connecting to the internet
d. None of the above
14.Which HTML tag would be used to
display power in expression

(A+B)2 ?
a. <SUP> b. <SUB>
c. <B> d. <P>

15.Page designed in HTML is called a
a. Yellow Page b. Web Page
c. Server Page d. Front Page
16.HTML document is saved using

extension.
a. .htl b. .html
c. .hml d. .htnl

17.HTML tags are surrounded by _
brackets

a. Angle b. Square
c. Round d. Curly
18 ........ connects web pages.

a. Connector b. Link
c. Hyperlink d. None of the above

19. Which section is used for text and
tags that are shown directly on your

web page ?
a.Head b.Body.
c.Title. d.Html

20. What is used to store information
usually relevant to browsers and
searchengines?
a.Cookies. b.Metatages.
c.Form. d. Frame.

21. The <HR> tag is used to insert
horizontal line across the page. Its

attributes are:

® Size.

e Width.

® Align .

@ All of th Above.

22. Table tag has various other tags,

these are
a. <TR>. b. <TD>.
c. <TH> d. All of the above.

2 Fills in the Blanks: -

1. HTML stands for

2. software is used to
access a webpage.
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3. Elements of HTML is of two

types and

4. list to represent an
unorganized list.

5. Tag is used to define

the elements of a list.
6. attribute is used to
set the background image in the

given table.

7. ALT stands for

__________ is the pixel width
between the individual data cells in
the TABLE.

9. is the main part of
the HTML document in which
whole information about the
webpage resides.

10.The contains title that
identifies the heading of the html
document.

3 True Or False:-

—

HTML is a structured Language.

2. Table heading starts with <TH> tag
and ends with</TH>tags

of the attached image in contrast to
the other contents of the webpage

4. CELLPADDING is the pixel space

between the cell contents and the cell

border.

5. Definition list generally contains the
definitons of different terms and
their meaning.

4 FULL FORMS:-

1.HTML 2. <B> 3.<I> 4.<U>
5.<OL> 6.<UL> 7.<P> 8.<BR>

9. SRC 10.<IMG> 11. <TR>
12.<TH> 13<TD> 14. LI

15. URL.

Align does not defines the alignment

5 Very Short Questions

1. Who designed HTML?( Tim
Berners-Lee)

2. Name the tag which is by the
beginning and ending
tags(Container Tag).

3. Name the tag of the HTML
document in which whole
information about the webpage
resides.(Body tag)

4. Name a tag which is an empty
element that is used to break a
line and display the proceeding
text from the next line, without
giving any space between two
lines.(<br>)

5. Name the list which have
information related to each
other but their sequence is not
important .(Bulleted Lists)

6. To add an image to a webpage,
which tag is used
( <image SRC=""FILENAME">)

6 Short questions:-

1. What is HTML?

2. Explain web Browser?

3. Explain <Head> and <Title>
tag.

4. What is the purpose of
<Body> tag.

5. What is a Tag?

6. What are the different types
of lists used in HTML?

7. What is <Img> tag. Explain.

8. Name different tags used to
create a table.
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9. Explain Nested Lists.

10.Explain Font tag with its
attributes.

7 Differentiate Between:-

1. Ordered and Unordered List.
Background and BGCOLOR.
Container and empty Tags.

Colspan and Rowspan.

Tag and attribute.
<P> and <BR> tags.
8. Long questions:-

1. Describe the basic structure of
HTML in Details.

Hypertext
Markup
Language
b Web browser

a Container and
Empty Tag
d Unordered
List

<LI>
Background
Alternate
Cell spacing
<Body>

heading

22

= = = = = = = = = ]
w oo ~ o v £l w - o
o

Cell spacing and Cell Padding.

TRUE

TRUE
FALSE

TRUE

TRUE

Hypertext markup

2. How we can create a simple
webpage. Explain in details.

3. What are the various tags used
in table .explain with an example.

4. Explain ordered list with an
example.

5. Define definition List with an
example.

6. What are the different way to

insert an image in a HTML
program.

7. How we can change the
background of a given webpage.

8. Explain Nesting List with an
example.

Multiple Fillin the True or
V Short A
Choice Blanks False m
c

Tim Berners-Lee

language
Bold Container Tag
Italic Body tag
Underline <br>
Ordered list Bulleted Lists

Image

Unordered list SRC="filename” >

Paragraph -
Break -
Source -
Image -
Table row
Table heading
Table data

List item

Uniform resource locator
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Chapter o
3 HTML- I <I>

Objectives of this chapter:

Introduction
3.1 Hyperlink.
3.2 Forms.

3.3 Buttons.

3.4 Frames.

3.5 Multimedia in HTML.
3.6 CSS

Introduction:

In the last chapter we have already discussed the different aspects of
HTML which includes how to create a simple webpage,lists,tables images
etc.Now in this chapter Marquee ,Hyperlink,adding external audio and video
toaweb page in HTML will be discussed.

3.1 Hyperlinking

Linking is an important property of HTML. With this property we can link
text or image to another document.Link is also named as Hypertextlink or
Hyperlink. Browser shows the Hyperlink in blue colour and also underlines it.
LINKING means connecting multiple webpages with each other.Each website
has multiple webpages related to its different information stored.In HTML
linking is defined with HYPERLINK .It provides links between different
webpages of the website .Usely links are defined into two parts internal links
(which are defined with in the same website) and External Links(which are
defined to the links defined outside the website). Hyperlinks can be defined on
text or images on the given webpage.
3.1.1 Anchor Tag <a>

Anchor tag<a> is used to create a link on a webpage. It starts with<a> tag
and ends with </a>. The most important attribute of the <a> element is the href
attribute, which indicates the link’s destination.
By default, links will appear as follow in all browsers:

o An unvisited link is underlined and blue in color
. Avisited link is underlined and purple in color
. An active link is underlined and red in color

HREF defines the link desitnation which user wants to visit. It provides
the URL of the webpage to be visited. It defines the address of html page to be
visited (eg. Tables.html). The anchor tag syntax is defined below :

<a href="url”>link text</a>
Eg<a href="tables.html”>Visit our tables page</a>
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| | hyperi =0 inks in htmi -

o 7 it el

File Edit Format View Help & cau p\10th chapt v | #2.| X | Search The Web L~
<html> - File Edit View Favorites Tools Help
<head> s 4 p W @ | @ hyperlinks in htmi | fi o~ B = @ v |kPage~ (JTooksw
<title>hyperlinks in html</title> | i w
</head>

| <body>

<a href="tables.htm]">visit our tables page</a>
<p>The href attribute specifies the destination
address (tables.html) of the Tink.

The 1ink text is the visible part

(visit our tables webpage).</?>

Clicking on the 1ink text will send you to the
specified address.

Visit our tables page

The href attribute specifies the destination address (tables html) of the link. The link text is the visible
part (Visit our tables webpage).

Clicking on the link text will send you to the specified address.

</body>
</html>
Fig: 3.1 o Fig: 3.2
3.1.2 Types of Links.
3.1.2.1 LINKS DEFINED WITH IN THE SAME WEB PAGE:

1.

When a Link is defined with in the same webpage, we need two parts to be
defined with anchor tag.

"HREF"defines the link to the given part of the webpage.

Syntex.<A HREF="#SNAME">LINK TO ANOTHER PART OF SAME

WEBPAGE</A>

the part to be linked.

Second "NAME"defines the reference to that link which means it defines

Eg.<ANAME="SNAME">NEW SECTION</A>
Let us explain it with an example as shown in Fig 3.3. and Fig 3.4 When
the user clicks on the html disadvantages it will show the disadvantages
portion of the webpage.
Here Name attribute allows the user to create a link on the same page.
This defines the linkname through which the link on the same page is
identified and hyperlinked.

<html>
<head>
<title>hyperlinks in html</title>
</head>
<body>
<a href="#HTML">Visit HTML DEFINITION</a><BR>
<A href="#ADVANTAGES">HTML ADVANTAGES </A><BR>
<A href="#DISADVANTAGES">HTML
DISADVANTAGES</A><BR>
<A NAME="#HTML"></A><BR>
HTML refers to the HyperText Markup L anguage.<BR>
POINTS ABOUT HTML:<BR>
1. HTML is used to create webpages.<BR>
2. HTML used many tags to make a webpage. So it is a tag
based language.<BR>
3. The tags of HTML are surrounded by angular bracket.<BR>
4. It can use wide ranges of colors,objects and layouts.<BR>
5. Very useful for beginners in web designing field.<BR>
<A NAME="#ADVANTAGES">ADVANTAGES OF
HTML</A><BR>

Fig: 3.3

Advantages of HTML:< it is widely used.<BR>
2. Every browser supports HTML language.<BR>
3. Easy to learn and use.<BR>
4. It is by def ault in every windows so you don't need to
purchase extra software.<BR>
<A NAME="#DISADVANTAGES">DISADVANTAGES</A><BR>
Disadvantages of HTML:<BR>
1. It can create only static and plain pages so
if we need dynamic pages then HTMLis not useful.<BR>
2. Need to write lot of code for making simple
webpage.<BR>
3. Security features are not good in HTML.<BR>
4. If we need to write long code for making a webpage then
it produces some complexity.<BR>
</body>
</html>
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4. Tt s by default in every windows so you don't need to purchase exira software.
DISADVANTAGES

Disadvantages of HTML:

1. Tt can create ouly static and plain pages so £ we need dynamic pages then HTVL s not useful
2. Need to wte lot of code for making simple webpage. :
3. Security features are not good in HTML. :
Il 4. 1w need to write Jong code for making a webpage then it produces some complexty.

Vist HTML DEFINITION
HTML ADVANTAGES
HTML DISADVANTAGES

HTML refers to the HyperText Markup Language.
POINTS ABOUT HTML:
1. HTML is used to create webpages. 3

Fig: 3.4
3.1.2.2 EXTERNALLY DEFINED LINKS:-

Links defined outside the website is known as external Link. These links
are defined with complete and accurate address of the website. When the user
clicks on these links he/she is directed to the URL given in the link with the help
of web browser.

Eg.<AHREF=HTTP://WWW.SSAPUNJAB.ORG>SSAPUNJAB WEBSITE</A>

When user clicks on the above link, ssapunjab.org website will be opened.

Let us explain it with an example. with code & output as shown in Fig. 3.5
& Fig.3/6

.| HYPERLINKEX - =
File Edit Format View Help

<html>

<head>

<titleshyperlinks in html</title>

</head>

<body>DIFFERENT USEFULL WEBSITES FOR A STUDENT<BR><BR>
<A href="HTTP: //SSAPUNJAB.ORG">Visit SSAPUNJAB WEBSITE</A>
<BR><BR>

<A href="HTTP: //PSEB.AC.IN">Visit PSEB MOHALI WEBSITE</A>
<BR>»<BR>

<A href="HTTP: //EPUNJABSCHOOL . GOV.IN">Visit EPUNJABSCHOOL
WEBSITE</A><BR><BR>

<A href="HTTP: //SCHOLARSHIPS.GOV.IN">Visit SCHOLARSHIP
RELATED WEBSITE</A><BR><BR>

<A href="HTTP: //PUNJABSCHOLARSHIPS. GOV. IN">APPLY FOR SC/BC
SCHOLARSHIPS

RELATED WEBSITE</A><BR><BR>
<A/Eref:“HTTP://WELFAREPUN]AB.GOV.IN">Visit WELFARE DEPARTMENT</A>
</D0O
| </htm]>

4 m »

Fig. 3.5 Fig. 3.6

3.1.3 LINKING IMAGE AS A HYPERLINK

As we have defined earlier the hyperlink can be defined on text as well as
other elements of a webpage. We can define hyperlink on an image also.
Eg.<A HREF="bodybackground.html” ><image src="lampbg.jpeg” HEIGHT=70%
WIDTH=60% >

Here in the above example a hyperlink is created on the image
“lampbg.jpeg”.In this user has to define anchor tag and img src tag to create a
link on the given image.

I= Edit View Favorites Tools Help
U6 & | hyperinks in htmi fv B v @ v [tPage~ GTooks v

DIFFERENT USEFULL WEBSITES FOR A STUDENT
Visit SSAPUNJAB WEBSITE

Visit PSEB MOHALI WEBSITE

Visit EPUNJABSCHOOL WEBSITE

Visit SCHOLARSHIP RELATED WEBSITE

APPLY FOR SCBC SCHOLARSHIPS RELATED WEBSITE

Visit WELFARE DEPARTMENT
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Create html program “Link.html” with an image, then create another program
with hyperlinking.html as shown in the in Fig 3.7 (a) & Fig. 3.7 (b) and outputin
Fig. 3.8 (a) & Fig 3.8 (b) And see the results

File Edtt Format View Help

) File Edt Fomat View Help

dead> o ‘ <head>
<titleradding image Tink in html</title ctitleshyperlinks in html</titles

f </head>
| <body>
<img src="bkgreen. jpg" HEIGHT=30% WIDTH=60% <A HREF=hodybackground. htm1>
border=2»
</A> { <ing src=imgTnk. jpeq HEIGHT=30% WIDTH=60%
</body> border=2>
</html> </A>

</body>
</html>

et Explorer

+' I

SR e — : e m ree— Hep
! : ' By i~ o v -\-P v Tooks » d g = n \ \ »
@ Enpisitin ARG R AT — Br D 8 e e

T = i e

Fig: 3.8 (a) Fig: 3.8 (b)
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3.1.4 Linking to email address
We can link with an e-mail address by using an Anchor Tag. With this

a user can send e-mail to designer by clicking on the link.
The code used for linking to an e-mail address is as follows:

<A HREF = mail to: abc@rediffmail.com> mailme </A>.

Here abc@rediffmail.com is mail address and mailme is the hyperlink.
3.2 Forms

An html form is part of a web page that includes areas where readers can
enter information to be sent back to WEBSITE or the publishers of the web
page It is a container that consists of other form elements such as text box,
radio buttons ,list box etc. .

Every form has to include the action and method attributes to complete
the purpose of feeding information in a form. These are explained below:-
Action:

The action attribute specifies where to send the form-data when a form is
submitted. FORM is useless unless some kind of processing takes place after
the form is submitted. The action attribute is used to inform the browser what
page (or script) has to be called, once the SUBMIT button is pressed. It
Specifies a URL to which the form's data is sent when submitted.

Exp. <FORM ACTION="welcome.php">
Method:

The method attribute defines the way through which user's information,
which he enters in the form, can be sent and stored to the websites server.
There are basically two methods through which information can be sent.

Get Method:

This method is used to encode the feeded data by the user by using URL

path and is sent to the server. Limited data can be sent to the server. Its

parameters remain in the browser history.
<FORM method=get action="welcome.php">
Post Method:
This method is used to store the data to the server without interfering

URL and is more secure to send information than GET method from the
website form to the server. There is no restriction on sending data. Its

parameters don't remain in the browser history.
<FORM method=post action="welcome.php">
3.2.1 CREATING A FORM:
Every form must begin with a <form>tag, which can be located

anywhere in the body of the html document and ends with
</form>.Different controls are available which can be used in a form these
are explained below.
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3.2.2 Text input:

This is a simple type of form control available and is used to ask the
user for a specific piece of information within a form, It uses the <input >
element.Type is the attribute which can be used in the input element to
determine the type of control which user wants to use with in the form. This
tag must fall between the <form> and </form> tags, but it can be anywhere
on the page in relation to text, images, and other html tags. For example, If
user asks for someone's name you could type the following :

Exp. What's your first name ?<input type="text" name="fullname" size="20" >
Here type defines the type of input needed, name defines the name of the field

, that is used to retrieve the information from the form, size defines the size of
the text. If web designer wants the user to enter text without it being
displayed on the screen, he can use <input type="password" > instead of
<input type="text">. Asterisks (***) are then displayed in place of the text the

user types.
Below html program shows the text input and its related output
e =y |
B TTRS - = 1 {8 Guest book - Windows Intemet Explorer @M
|| File Edit Format View Help ”
<html> - ' HTML- w4 ‘&ym?yﬁn .
Sk () |6 st detiomsini +|4p|x | e e e p
g Fle Bt View Fovortes Took Hel
</title> . v ' »
</head> W8 Guestbook LR v om v Pagew (fTook v

<hl>my guest book</hlx> ’
<p>please lest me know what you think of my

e - | || my guest book

what is your name 7 <input type="text"
name="fullname" size="25"/> ;
Your e-mail address : <input type="text" please lest me knonw what you think of my web pages. Thanks !
name="e-address"size="25"/>
enter your code<input type="password"
name="fullname" size="25"/> ihat is your name ?
Your e-mail address :

- enter your code
m ]

Fig: . 3.9 Fig: . 3.10
3.2.3 TEXT SPACE AREAS:-

This is a container tag and is used to allow multiple lines of text in a
single input item. It has two attributes these are ROWS and COLS .Row
defines the number of rows defined in the text area and cols defines the
number of columns used in the text area. If user wants to define some default
text then he can define in-between the open closing tags of text area element.
All this is explained in the given example.

<textarea name="comments" rows="4" cols="20">

Please send more information.

</textarea>
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The rows and cols attributes control the number of rows and columns of text
that fit in the input box. Text area boxes do have a scrollbar, however, so the

user can enter more text than fits in the display area.
3.2.4 CHECK BOXES:
The simplest input type is a check box, which appears as a small square

the user can select or deselect by clicking on it. It is generally used where a
group is used for sharing a common name from where information can be
selected. It is used in <input> html element. We must give each check box a
name attributes the value defined in the type attribute is checkbox. These are

explained below with an example.
<input type="checkbox" name="baby"> baby grand piano
<input type="checkbox" name="mini"> mini piano stool
You can check any option or both by clicking on it. It also supports some

additional attributes
3.2.5 RADIO BUTTONS:
Radio buttons, are those buttons where only one choice can be selected

at a time and are almost as simple to implement as check boxes. It is used in
<input> html element. User must give each radio button a name attribute and
the value defined in the type attribute is radio. Just use type="radio" and give
each of the options its own input tag, but use the same name for all of the radio

buttons in a group These are explained below with an example.

Ex. <input type="radio" name="card"> visa

<input type="radio" name="card"> master card

Below in Figure 3.11 and 3.12 html program shows the text input and
its related output.

CHECKRADIO - Notepad o B ﬁ Guest book - Windows Intemet Wﬂ'ﬂ @Eﬁ
ik s Fommet s View s el )+ | {8 CALDMh dassHTML T CHECKRADIOHTML v ¥ | X | Serch The e P
| HIML-2\ ] | #¢ | X || Seorch The Web \
<htm]> » AV | |
<head>
P Tes file Edit View Favorites Tools Help
iy i b b o B B Bnidhes Qe
</head>
<ll1(1>dy> /hl
<h1>PAYMENTS OPTIONS</hl» f
<p>please SELECT PAYMENT OPTIONS PAYB[ENTS OPTIONS
<form> <pre>
<input type="CIICCKBOX"

name="PAYMENT" VALUE=CASH>CASH please SELECT PAYMENT OPTIONS
<input type="CHECKBOX" B
name="PAYMENT" VALUE=CREDIT CARD>CREDIT CARD

<input type="CHECKBOX" [ cass
name="PAYMFNT" VAI lJF=NFT-RANKTNG>NF T-RANKTNG " -
Male/Female '_"REDH CARD
<input type="radio" NET-BANKING
name-"sex" VALUE-M-Male Male/Penale
<inpul Lype="radiy"
name="sex" VALUE=M>+emale 9 Hale
</pre> Female
</Forms
</body>
</html>
Fig 3.11 Fig. 3.12
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3.2.6 SELECTION LISTS:

In this option user can select single or multiple options from a given list. In
this option multiple inputs are available but some options can be displayed at a
time. Scrolling Lists and Pull-Down pick lists are created with the <select>tag.
You can use this tag together with the <option>tag :
Exp. <select>
<option> electric windows</option>
<option>am/fm radio</option>
<option>turbocharger</option>
</select>
No html tags other than <option> and </option> should appear between
the <select> and </select> tags.

Attribute of select tag:-
Size: Size attribute here determines how many items are shown at once on the
selection list. If size="2" were used in the preceding code, only the first two
options would be visible, and a scrollbar would appear next to the list so the
user could scroll down to see the third option.
Ex.: <Selectname ="Month” size=3>
name:-It is used to define name to the drop down menu.
<Select name ="Month” size=3 multiple>
Multiple:-This is used to select multiple options from the given list.
Value:-This is the value which has to be given back to the website and defined in
the option tag.
Ex.: <option Value="jan”>January
Selected:-When this option is used the given option will be preselected.
Let us discuss an example related to this topic as shown in figure 3.13 and 3.14

s |

File Edit Format View Help

<html>

<heat]i>

<title> — " ’

||DROP DOWN MENUS Fll: Edit View Favotes Tools Help
a a T »

b0 v W & | 80R0DDONN MENS Biv ) # v cPger ook

<body>

<hl>Select the input and output devices from the following:-</hl>

<p>PLEASE SELECT OPTIONS ' :

Form <pre> | Select the input and output devices from the

Input Devices | ¥

<select NAME="INPUT" SIZE="3" > "

<option VALUE="KEY" SELECTED>KEYBOARD </option> 3 fouowmg'

<option VALUE="MOUSE">MOUSE </option> 7

<option VALUE="TB">TRACK BALL </option>

<option VALUE="OMR">OMR </option> PLEASE SELECT OPTIONS
<option VALUE="SCAN">SCANNER </option>

.
<select NAME="output" SIZE="2" multiple > KEYBOARD I8
<option VALUE="print" >PRINTER </option> MOUSE &
<option VALUE="Plot">PLOTTER </option> TRACK BALL ~
<option VALUE="Mon">Monitor </option> Bitasing
Ik/PF‘E> Utpu ‘IIICES
</form> PRINTER 8

</body> PLOTTERY

</htm¥> -

‘ i \ |

Fig. 3.13 Fig. 3.14
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3.3 BUTTONS

Buttons are used to perform some action on the given webpage.Some
important buttons are discussed below.
3.3.1 SUBMIT:-

Every form must include a button that submits the form data to the
server. You can put any label you like on this button. It has two attributes these
are type, which has submit value and value attribute defines the name of the
submit button which can be displayed on the button. These are explained
below with an example

Ex.: <input type="submit" value="OK">
A button will appear on screen. When the user clicks it, all data items on the
form are submitted
3.3.2 RESET Button:

you can also include a button that clears all entries on the form so users
can start over if they change their minds or make mistakes. It has two
attributes these are “type”, which has reset value and value attribute defines
the name of the reset button which can be displayed on the button. These are
explained below with an example

Ex. : <input type="reset"value="CLEAR ALL”>
All parts of a form must fall between the <form> and </form> tags Button
are explained with an example as shown in figure 3.15 and 3.16

| buttons - Notzpad ol E)

File Edit Format View Help

<html>

<head>

<title»

Buttons

</title»

</head>

<body>

<h1>USES OF BUTTONS|: -</hl>

file Edit View Favontes Took Help

I I . . »
Woal | @ buttons P v B v v Pagew (G Tooks v

USES OF BUTTONS:- 1

PLEASE SELECT OPTIONS

<p>PLEASE SELECT OPTIONS

<form> <pre>

Input Devices

<select NAME="INPUT" SIZE="3" >
<option VALUE="KEY" SELECTED>KEYBOARD </option>
<option VALUE="MOUSE">MOUSE </option>
<option VALUE="TB">TRACK BALL </option>
<option VALUE="OMR">OMR </option>
<option VALUE="SCAN">SCANNER </option>
</select>

Output Devices

<select NAME="output" SIZE="2" multiple >
<option VALUE="print" >PRINTER </option>
<option VALUE="Plot">PLOTTER </option>
<option VALUE="Mon">Monitor </option>
</pre>

</selects<hr>

<Input type="Submit" value="Submit"><br>
<Input type="Reset" value="Clear A11">
</form»

</body>

</html>

Input Devices

KEYBOARD I8
MOUSE [5
TRACKBALL ~

Qitpur, Devices
il |PRINTER
il |PLOTTER ~

Fig. 3.15 Fig. 3.16
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3.4 FRAMES
One major limitation of html in the old days was that user could see

only one page at time. Frames overcome this limitation by dividing the

browser window into multiple html documents.
Frames are like tables in which they allow user to arrange text and

graphics into rows and columns. Any frame can contain links that change the
contents of other frames.

3.4.1 Frameset :
A frame is a rectangular region within the browser window that display

aweb page , alongside other pages in other frames.
Tag used in frames :-
Within the <frameset> and </frameset> tags user should have a <frame> tag

indicating html document to display in each frame.

3.4.2 Use of * (asterisk)
We can use asterisk ( * ) to indicate that a frame should fill whatever

space is available in the window.
Eg. <framesetrows="80,*">
This means to split the window into two rows, the first row (frame) will

be exactly 80 pixels and the remaining space will be taken by the second row

(frame).
I[fwe use
<frameset rows="*","*">
Here both the rows consume the same space.
Attributes of<frameset> tag
1. Rows:- split the window into rows.
2. Cols:- split the window into columns.
3. Framespacing:- space between frames , in pixels .
4. Frameborder:- specifies whether to display a border for the frame

or not. Options are yes/no.
4. Border :- size of the frame border in pixels. ( netscape navigator

only)
Eg. <frameset cols="40%","50%" framespacing="50"
Frameborder="yes" border="50">
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TAG ATTRIBUTE FUNCTION
<FRAMESET>.. DIVIDES THE MAIN WINDOW INTO A
SET OF FRAMES. EACH FRAM CAN
</FRAMESET> DISPLAY A SEPARATE DOCUMENT.
ROWS="..." SPLITS THE WINDOW INTO ROWS
COLS="..." SPLITS THE WINDOW INTO COLUMNS.
FRAMESPACING | SPACE BETWEEN FRAMES, IN PIXELS.
FRAMEBORDER= | SPECIFIES WHETHER TO DISPLAY A
" BORDER FOR THE FRAMES . OPTIONS
ARE "YES" OR "NO"
BORDER SIZE OF THE FRAME BORDER IN
PIXELS.
<FRAME> DEFINES A SINGLE FRAME WITHIN
<FRAMESET>.
</FRAME >
SRC=".." THE URL OF THE DOCUMENT TO BE
DISPLAYED IN THIS FRAME.
j frameset - Notepad @Ell‘l_if Nj frameset] - Notepad |MP
File Edit Fomat View Help File Edit Format View Help
<html> <frameset rows="* * * " + <html> .

<bodys
<hl>Frame 1</hl»
<p>Contents of Frame l</p»

<frame src="frameset2.html"»

<frame src="framesetl.html"s I
<frame src="frameset3.html">

<Fframe src="framesetd.html"s L </body:
</frameset: </html>
</html> . v
Fi } 14 }
Fig. 3.17 (a) ' Fig. 3.17 (b)
| framesetZp - Notepad (| jframeseti-Notepad @E@
[File| Edt Fomat View Help it Fomat View Help
<html> . <html> .
<body> ‘ <hody>
| <h1>Frame 2</hl» ,| <hl+Frame 3</hL»

<pxContents of Frame 2</p> <p>Contents of Frame 3</p»
</body= </body:
</htm]> = </html> =

1 L

Fig. 3.17 (c) Fig. 3.17 (d)
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44 | X M Search The Web o)

File Edit View Favorites Tools Help

W o @cuothdassHMLAL. | | R v B -
{ C:\10th class-HTML-2\frameset.html F

»

i
‘
il
o
1]
(V=]
m
4

Frame 1 l
| Contents of Frame 1 j

Frame 2 ‘

Contents of Frame 2 :
| 3
| Frame 3

Contents of Frame 3

Fig. 3.17 (e)
Similarly if we divide the frameset into columns then the web page will be
divided into columns.The necessary change in the above program to
convert rows to columns is as follows:-
Eg.<frameset cols="*","*""*">
<frame src="framesetl.html">
<frame src="frameset2.html">
<frame src="frameset3.html"></frameset>
3.5 Multimedia in html:-
3.5.1<MARQUEE> :-This tag is used to move the text in the webpage. This

is a container tag. This tag has some attributes which are generally used.
These are defined in the following table
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Attribute Purpose Syntax Example

name

BGCOLOR This attribute defines the | <Marquee <Marquee = BGCOLOR
back ground colour of the text. | BGCOLOR="COLOUR | ="GREEN">

NAMEGREEN">

DIRECTION | This attribute defines the | <Marquee <Marquee
direction of the text ie. | direction="side”> direction="Left">
right,leftup,down.

HEIGHT Defines the height of the text | <Marquee height="pts.”> | <Marquee height="50">
in pixel.

WIDTH Defines the WIDTH of the | <Marquee <Marquee Width="20">
text in pixel. WIDTH="pts.”>

BEHVIOUR It defines the scrolling if the | <Marquee <Marquee

Text with three values

1. Scroll infinitely scrolls the
text

2. alternate moves text left
then right.

3. slide brings the text from
left or right of the webpage.

behavior="value”>

behavior="scroll”>

<Marquee
behavior="alternate™>

<Marquee
behavior="slide”>

Marquee tag is explained with code and output as shown in Fig. 3.18 and Fig
3.19 Following example all the above attributes.

File Edt Format View Help

</body>

4

<h1>USES OF MARQUEE TAG:-</hl>

li<Marquee behavior="s1ide">SLIDE SCROLLING</Marquee><BR>
<Marquee behavior="alternate">ALTERNATE SCROLLING</Marquee><BR>
<Marquee behavior="scrol1">SCROLL BEHAVIOUR</Marquee><BR>
<Marquee Bgcolor="Green">SCROLLING WITH GREEN BACKGROUND</Marquee
lf <Marquee DIRECTION="LEFT">SCROLLING WITH LEFT DIRECTION</Marquees
<Marquee WIDTH="300" HEIGHT ="500">SCROLLING WITH GIVEN HEIGHT
AND WIDTH"</Marquee»><BR>

(o1 it

JR

{6 MARQUEE - Windows Intemet Explorer

*7| X ”;'s:f:f The Web

| C00th clss HTML-2marquee il +
AV "

File Edt View Favortes Took Help

AT DR e ek

USES OF MARQUEE TAG:-

SLIDE SCROLLING
ALTERNATE SCROLLING
SCROLL BEHAVIOUR

G WITH LEFT DIRECTION
CROLLING WITH GIVEN HEIGHT AND WI

Fig. 3.19

i1
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3.5.2 Adding audio/video files to HTML programs

User can add audio/video file to html program by using Anchor tag .As
we have used this tag to link files with html webpage. We have to define the
path of the audio/video file in HREF attribute. Whenever user clicks on the
given link the file will be downloaded on the user's system and played with
supported software.
This is explained with an example in fig. 3.20 and 3.21

(& AD0ING AU LS -Wodoss e Egore o Bj
] AUDIO-Notepad oMy O 3
W Ecomdsimazamimi 4 x el P

File Edit Format View Help

< t'lt]ﬁ) i file Edt View Favortes Took Help
ADDING AUDIO FILLES G gamcuoons | B D m ke Gl
(/tit]&) - - -;ddtch‘.tr\lea Alt+Z) - .j
(/ head> Play aucio song
(body> Play video fle
<a href="ajab.mp3">Play audio song</a»<br> |. Playvido e

<a href="bear.wmv">Play video file</a><br> |
<a href="drop.wmv">Play video file</a><br>

</body>
</html>»

¢ I b

Fig. 3.20
' Fig. 3.21

Cascading Style Sheets
Style Sheets, Cascading Style Sheets and CSS all mean the same
thing and are the modern way of defining the design and layout of your
webpage. It allows the programmer to set the physical appearance of the
multiple webpages in a single way which includes its colour,font,fontsize
etc..User doesn't need to set style for each web page.
A style is defined with two sections: one or more selectors and one
or more declarations enclosed in {Curly Brackets}
Each declaration is made up of a Property: Value; pair
Syntax :- Selector {property: value;}
Example of defining a HTML tag;:
p {font-size: 10pt}
1. The selector in this example is redefining the P HTML element to
have a size of 10 points
2. Brackets must be curly brackets.
3. The colon: separates the property from the value.
example:- h1l, h2, p {color: BLUE}
The elements h1, h2 and p will be in blue colour

(2
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Specifically, the 3 kinds of styles can be added to a document.
1. Inline styles
2. Internal or Embedded styles
3. External styles
Each of these kinds of CSS styles have their benefits and drawbacks,

so let's take a deeper look at each of them individually.

3.6.1 INLINE STYLES
Inline styles are the styles that are written directly in the tag in the

HTML document. Inline style sheet should only be used where a particular
style is not going to be repeated elsewhere on the page/site. Inline styles
affect only the specific tag these are applied to. Here is an example of an
inline style applied to a standard link, or anchor,

Syntax : <element STYLE="property:value"> Ex.:<p style="color:green; font-
size:12pt">

It would not, however, change any other link on the page. This is one of the
limitations of inline styles. Lets explain it with an example as shown in
figure 3.22 &3.22 below .

GUEStbOOk m“uu- ¢t bp! TI

e it Fome Ve g

tnl> i File Edit View Favortes Tools Help
W & (@ Guestbook '7} R-D-®~

»

ead>
itle
G?egt]book
titles )

i | [my guest book
ody>

AL style="color:green; font-size:2opt"> my quest booke/hl>
¢ style="color:red">please let ne know what you think of ny
e pages. Thanks |

¢/body> "
¢/htal> :

{

please let me know what you think of my web pages. Thanks !

3

Downloaded from https:// www.studiestoday.com



Downloaded from https:// www.studiestoday.com

3.6.2 INTERNAL OR EMBEDDED STYLES
The definition is written once in the head part of a page. It must be
written on every page which requires that style.
The Internal style sheet is defined within the head section.
Syntax : <head>
< style type="text/css">
Your Style definitions go here
< /style>
< /head>
Example:
<head>
< style>
Body {background-color: cyan; color: white;}
p {margin-left: 6px}
< /style>
< /head>
Embedded styles are styles that are embedded in the head of the
document. Embedded styles affect only the tags on the page they are
embedded in. Every page would have styles in the webpage, if user wants to
make a site change, like changing the color of links from red to green, user
would need to make this change on every page, since every page uses an
embedded style sheet. This is better than inline styles, but still problematic
in many instances.
The benefit of embedded style sheets is that it loads immediately with
the page itself, instead of requiring other external files to be loaded. This is
explainin figure 3.24 and 3.25

i

internalcss - Notepad _ e~ AY L-2intemalcsshtm! - Windows Ifemet Explorer ‘ |
<HTML > _ = =
<HEAD> | File Edit View Favortes Took Help
<stylex> - —
body { % & BOWhcsHMAite. | B v B v v 3Page (hTook v

background-color:Lightblue;

WELCOME TO HTML HEADINGS WITH INTERNAL CS8

HEADING-1

h1l,H3,H5 {
background-color:yellow;
color: maroon;
margin-left: 40px;

</style>

</HEAD>

<BODY>

WELCOME TO HTML HEADINGS WITH INTERNAL CSS
<H1>HEADING-1</H1>
<H2>HEADING-2</H2>
<H3>HEADING-3</H3>
<H4>HEADING-4</H4>
<H5>HEADING-5</H5>
<H6>HEADING-6</H6>
</BODY>

</HTML>

« m )

Fig. 3.24 Fig. 3.25
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EXTERNAL STYLE SHEETS
The style definitions are only written once and saved into a file. Each
webpage that wishes to use that file places a link to the file in the HEAD
section.
Syntax:
<Head> Section of your pages
Link to the Style file with the <link> tag
Place the following link into the <head> section of your page; use the
name you have selected for the CSS file in place of
yourStyleFileName.css
<link rel="STYLESHEET" href="yourStyleFileName.css"
type="text/css">
Note: The link tag does not have a closing tag in HTML

externallcss - Notepac
File Edit Format View Help

body {
background-color: Tightgreen;

hl,h3,h5 {
color: navy;
margin-left: 20px;

| externalcss - Notepad

File Edit Format View Help
<HTML > -
<HEAD> 1
<link rel="STYLESHEET" href="externallcss.css" type="text/css">
</HEAD>

| <BODY>

WELCOME TO HTML HEADINGS WITH EXTERNAL CSS

<H1>HEADING-1</Hl1:>»

<H2>HEADING-2</H2>

<H3>HEADING-3</H3>
q<H4>HEADING—4</H4>

<H5>HEADING-5</H5>

| <H6>HEADING-6</H6>

</BODY> e |
</HTML>

Fig. 3.27

S
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€ C\10th class-HTML-2\externalcss.html - Windows Internet Explorer nlo(= e

KRN @ cion it ~ 4 [ x | e e i =

T,pe to search the web (Ctrl+E)

File Edit View Favorites Tools Help

N (T = (o B " : »
w & (92|v @cuot. @c\.x| | v B v @ v |.)Page v G Tools v

WELCOME TO HTML HEADINGS WITH EXTERNAL CSS
| HEADING-1

‘ HEADING-2

| HEADING:3

HEADING-4

HEADING-5

CSS external file Fig. 3.27

CSS files are ordinary text files and can be written in a simple text editor
such as notepad. The file must be given the extension .css

Most websites today use external style sheets.External styles are styles
that are written in a separate document and then attached to various web
documents. External style sheets can affect any document they are attached
to, you can make a visual change to every one of those pages by simply editing
that style sheet. This makes long term site management much easier.

Some main properties of CSS ARE AS FOLLOWS.

Property Description Values
Sets the color of
Color 2 oot RGB, hex, keyword
. . Sets the distance
- [*)
line-height between lines normal, number, length, %
Increase or
letter-spacin decrease the normal, length
pacing space between 1 1eng
characters
. Aligns the text in . A
text-align an element left, right, center, justify

/6
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Property Description Values
text- Adds decoration none, underline, overline, line-through
decoration to text ! ! ! 9
Sets all the
i roperties for a ) . Y . L
list-style ﬁs tli:r’1 one list-style-type, list-style-position, list-style-image, inherit
declaration
none, disc, circle, square, decimal, decimal-leading-
Specifies the type Z?::énian eorgian, lower-alpha, upper-alpha, lower-
list-style-type || of list-item 1 georgian, Pha, upper-alpha,
marker greek,
lower-latin, upper-latin, lower-roman, upper-roman,
inherit
Sets all the
rder pri i .
border :::100?: properties border-width, border-style, border-color
declaration

Y <A> L </A>anchor tag is used to define hyperlink.

2. <A href="#SName”> and <A Name=#SName”> tag is used to define
link with in the same webpage.

3. Form is a part of a webpage that includes areas where readers
feed information which can be forwarded to the webserver.

4. Text input and textarea tag is used to define text format in the
webpage.

5. Checkbox is a small square that user can select from given
choice.

6. Radio Buttons can be used to select single option from the given
set of choices.

7. Buttons are used to perform the specific job or task.

8. Frames divide the single webpage into multiple webpages in
single web browser window.

9. Marquee Tag is used to move the text in the webpage.

10. Anchor Tag is used to add audio or video files to the webpage.

L7
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1.

Exercise

Multiple Choice Questions:

What is the use of Forms in HTML?
a. to display contents of email.

b. to display animation effect.

c. to collect user's input.

d. None of the Above.

CSS is an acronym for

a. Cascading Style Sheet

b. Costume Style Sheet

c. Cascading System Style

d. None of the Above

What is the correct syntax in HTML
for creating a link on a webpage?

a. <LINK SRC= "abc.html">

b. <BODY LINK = "abc.html">

c. <A SRC = "abc.html" >

d. < A HREF = "abc.html">

Which tag creates a check box for a
form in HTML?

a. <checkbox>

b. <input type="checkbox">

c. <input=checkbox>

d. <input checkbox>

Which of the following is most
commonly used HTTP methods?

a. PRE and POST.

b. GET and SET.

c. ASK and REPLY.

d. GET and POST.

8.

9.

Downloaded from https:// www.studiestoday.com

An html form is part of a web

page that includes areas where

a. Information is feeded by the
user.

b. And sent to the website server.

c. Both a and b.

d. None of the above.

A container tag and is used to

allow multiple lines of text in a

single input item is known as

a. Textarea.

b. Checkbox.

c. Radio Button.

d. None of the above.

10. In Selection lists s that list which

Is it possible to link within the 5.

current page ?
a.Yes.

b. No.

c. Only In frames

d. Null.

How can you make an e-mail link?
. <a href="xxx@yyy”>

. <mail href="xxx@yyy”>

. <mail>xxx@yyy</mail>

. <a href="mailto:xxx@yyy”>

o0 TP

6.

8.

9.

/8

user can select single or multiple
options from a given list.The type of
lists are

a. Scrolling lists.

Pull down pick up lists.

Both a and b.

None of the above

Fill in the Blanks:

tag is used to create a link
on a webpage.

aog

defines the link to the given
part of the webpage

is used to feed information
into the webserver.

If you want to allow multiple lines of
text is used in the
form(Textarea)

To select multiple options in a form
we can use .(Checkbox)

are used to check single
option from a multiple options at a
single time.(Radio Buttons).

button is used to send
information to the server.(Submit).

To clear all options from a form we
can use button.(reset)

divides the web browser window
into multiple html document.
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10. In frameset tag we can use and
as its attribute.(rows and cols)

3. True or False:

1. An unvisited Link is underlined and
blue.

2. Bookmark is used to define link outside
the given webpage.

3. Links defined outside the website is

known as external link.

4. <input type="password”> will show
asterisks in the text box.

5. Selection lists are used to define the
dropdown lists.

4.. Full forms:-

1. <A> 2. HREF 3. URL
4. BGCOLOR 5. SRC

5. Short Answer type Questions:

1. Which tag is wused to link a
webpage.(<A> AnchorTag)

Which Link is defined outside the
website. (external Link.)

Which attribute is defined to specifies
where to send the form-data when a
form is submitted (action attribute)
This method is used to encode the
feeded data by the user by using URL
path and is sent to the server.(GET
method)

What are used to perform some action
on the given webpage.(Button).

2.

Long Answer type Questions:
What is hyperlink?
Name the types of links?

What is Anchor tag? Explain with
example.

w =

Explain Bookmark in html webpage.
How to create Image as a link?
Whatis a form?

What is use of selection list in forms

® N s

Name different types of buttons used in
html form.

9. Explain Frames.

10. Explain Marquee Tag and its
attributes with an example.

11. How we can add audio and video files
to an html file.

12. Explain CSS.

13. Define types of CSS.

14. Explain Radio buttons and its
atrributes

15. Whatis checkbox.

16. What is the function of get method in
form.

17. Explain the post method in form.

Long Questions:

1. How to link two different
webpages.
Discuss form in details.
How to add multimedia in
HTML.

4. Discuss different types of
buttons with example.

5. What is selection list in form.

6. Explain TextArea with an

79

example.
Explain Frames with an example.

What is the purpose of action
and method in forms.
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Anchor

HREF
form

Text area

Checkbox

Radio button

Submit
button

Reset button
Frames

Rows and cols
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Answers Key

Multlple Fill in the True or

TRUE Anchor tag

FALSE  Hypertext References External link
TRUE Uniform resource locator ~ Action attribute
TRUE Background color Get method
TRUE Source Button

80
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Chapter
4 WEB DEVELOPMENT

Objectives of this chapter:

4.1 Planning for website.

4.2 Web Implementation Guidelines

4.3 Aspects related to publishing a website
4.4 Important guidelines or checklist.

4.5 Project: School Website

Introduction

We will learn to make small projects and we will also know that how a
website is planned and launched on internet. There are four stages of planning
a website viz: goal of site, designing for viewers, work strategy, development of
subject matter. Similarly there are many stages to put website in use for,
example, selection of name of Domain, Registration of Domain Name, selection
of Server, testing the website off-line as well as on-line etc.

4.1 Planning for website.
The website developed by proper planning is always effective. To build a
website we should first make its planning. If done with proper planning, the
objective of site would be fulfilled. We communicate through websites. Hence
we have to decide while planning that what we wish to communicate and by
which technique. First & foremost purpose of designing a website is to keep in
mind the goal and target of website. The website should always be built to
achieve its goal.
4.1.1 The goal of the Site

Every site has some specific purpose. This purpose guides us what to
include in the site. User can prepare a detailed and decorative site. But the
condition is that it must support the purpose of the site. The following facts are
to be kept in mind while building a site:

° Purpose of organization.

81
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important purposes of your site.
Method to develop the site
Fulfilling these requirements.
Working strategy of site to achieve the goal.
Time of developing the site.
e Time of updating the site.
4.1.2 Designing for the Audience

After fixing the aim of website, we have to know about nature of viewers of
the site, which type of people will be hitting it: children, students, advocates,
doctors or housewives. We have to keep in mind about their expectation from
your site.

For example if the designer is building the site for a publisher then the
viewer's certainly would be students, children, teachers, professors and other
intellectuals. In such a case the site will be designed according to their interest
and expectations.

4.1.3 Strategy

When the designer has decided to build a particular site, we will have
to think about its work-strategy. The mode of works to carry out for
achieving the goal is called work-strategy. Many kinds of information can
be included in the website.

e Text information

e Audio or Voice information

e Video information

A simple website is good and impressive. In other words it should not be
complicated.
4.1.4 Contents

After finalizing above jobs we now need the contents of site to enter. The
contents of the site supplies all the important information to the viewer, hence
the contents should be at proper place and arranged systematically. If there
are links in a sequence, then it is easier to search the required information.

4.2 Web Implementation Guidelines

After making complete and proper planning and deciding about
information (contents) and links we have to work for its implementation part.
We probably know that the content of the website is its most important aspect,
but it's also very important that its intended audience are able to find it, and
that visitors to our site can quickly locate the information they are seeking. It's
also a good idea to check that it's thoroughly optimized to attract new visitors
and track their activities.

Selection of Domain Name, Registration of Domain, Selection of server

82
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and managing the site etc. are under the Web Implementation Plan.

4.2.1 Choosing Domain Name

Domain name is the address of your site .Choose a domain name that
is brief, easy to remember, and suited to the content of your website. Some
common top-level domains include .com, .edu, .org, and .net, which stand
for commercial, education, organization, and network respectively. It should
not include hyphens. Maximum numbers of letters included in it can be 63.
4.2.2 Registering Domain Name

After deciding about the Domain Name, we have to register it. Designer
can register the site through the service provider. Service provider asks to fill a
form and also charges fee for its registration. After filling the form it is verified
whether the Domain name provided by the designer is free and is not already
registered by anyone else. If the name is available then designer gets the
confirmation message about registration through email.
4.2.3 Choosing a Server

To put the site in practice we have to choose the server or host. It is very
important task Designer can buy or hire the server where the site is to remain
permanent. In the web world the role of server is very important. Such a
specific server is named Web server. Whenever designer opens any site on the
browser, it connects to the concerned server. Securing the bandwidth
necessary to keep the website running smoothly. Bandwidth is the amount of
data transferred within a given time period.
Designer may need to buy more bandwidth as the website grows or else the
visitors may experience lag, which could drive them away from the website.
Many hosts also provide software aid in building the website.
4.2.4 Organizing Web page

If a person cannot find what they are looking for on the website within 30
seconds, there is a good chance they will leave and never return. Organizing
the website into specific sections and then providing links to those sections at
the top of each page is an effective and simple way to make the website easy to
navigate. The Webpage should be beautifully organized. So that it gives a
balanced look. The size of the page is an important point in organizing
webpage. The following points must be kept in mind while designing a
webpage.

1. Size of a web page should not be more than two screens. If we have to

use alonger page, the establish internet link through bookmark.
2. If the documentis longer than one screen then show only a part of it to
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the viewers and remaining part maybe shown only on their demand/
requirement.
4.2.5 Look

Webpage should have a fine look so that one is attracted to read it. In a
webpage with a good look designer should insert links graphics, animation,
sound and video clips. The various contents in the webpage should give an
impression of diversity and a beautiful view. Usage of proper font size/colour,
background colour, table, graph etc. gives a good look to the site.

4.2.6 Validate the code.

Validate the HTML, CSS, XHTML, JavaScript, and XML codes to ensure
that the website has clean code and function as intended for visitors. There are
several programs available online that validate each type of code.

4.2.7 Offline Testing

After designing all the webpages it is tested on the browser. No internet
connection is required for this test that is why it is named as offline test. In
offline test first of all home page is opened in different browser. Then we check
all the linked pages one by one. Designer should ascertain it here that all pages
have a good appearance. The website should be thoroughly tested to confirm
that the design and page structure are displayed as intended. Specifically,
view the website with the most popular browsers, including Chrome, Firefox,
Internet Explorer, Opera, and Safari, as those browsers are used by the
majority of people who are browsing the Internet.

4.2.8 Uploading the Site

To make the site available to all the viewers on the internet is called
Upload. To transfer.

The webpages to the "Host" we need File Transfer Protocol (FTP) client.
For this purpose first of all we set FTP programmer as Cute FTP. Then upload
the file after coming online. The copy of the website on computer is called the
localversion, and the copy on the web host is called the productionversion.
4.2.9 Online Testing

When the site is uploaded online, next step is to test it online. Make the
internet connection, open the browser, and type URL of the site. Check that all
the links of the site are working property.

4.2.10 Using SEO-friendly code.

Utilize both Meta and ALT tags to ensure that the website not only
appears in user searches but that pertinent keywords from the content of the
website are displayed. Doing so will more likely attract searchers' interests and
will facilitate more visits to the website. ALT tags are merely a written
description to go along with the pictures on the website, and so they are
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necessary to tell search engines and searchers what kind of pictures are there
on the website.
4.2.11 Installing website analytics

The statistics will enable to monitor the number of visits website
receives, the amount of time visitors stay, the average number of page views
for each visitor, and many other useful statistics. Making use of such
software will enable to make adjustments to the website to increase its
effectiveness.

4.3 Some important aspects related in publishing website
4.3.1 SEO

SEO means search engine optimization. Search engine optimization is a
methodology of strategies, techniques and tactics used to increase the amount
of visitors to a website by obtaining a high-ranking placement in the search
results page of a search engine including Google, Bing, Yahoo and other search
engines.

SEO helps to ensure that a site is accessible to a search engine and
improves the chances that the site will be found by the search engine. SEO is
typically a set of practices that webmasters and Web content producers follow
to help them achieve a better ranking in search engine results.

4.3.2 Social media marketing (SMM)

SMM is a form of Internet marketing that utilizes social networking
websites as a marketing tool. The goal of SMM is to produce content that users
will share with their social network to help a company increase brand exposure
and broaden customer reach.

One of the key components of SMM is social media optimization (SMO).
Like search engine optimization (SEO), SMO is a strategy for drawing new and
unique visitors to a website. SMO can be done in two ways: adding social media
links to content, sharing buttons -- or promoting activity through social media
by updating statuses or tweets, or blog posts.

SMM helps a company get direct feedback from customers (and potential
customers) while making the company seem more personable. SMM became
more common with the increased popularity of websites such as
Twitter,Facebook, Myspace, LinkedIn, and YouTube.

4.4 Some important guidelines or checklist which must be noted while
publishing website.
4.4.1 Page Content

1. Spelling and grammar, paragraphs, headers, lists, and other formatting
should be correct.
2. Company contact details are accurate throughout the website.
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3. Images and audio and videos are in the correct places, formatted and
working on all devices.
4.4.2Design

Take the necessary steps to ensure that the site design is pixel perfect. If
designer has a responsive website. It needs to check the design across all
devices. The site should be looking good not just on an office desktop, but also
on laptops, tablets, and mobile phones.

4.4.3 Functionality

Take some time to test and validate all of the different features on the
website. Lead generation forms, social sharing, should work flawlessly across
the website such as:-

1. Thank-you message or page displays after form is submitted.
2. Company logo is linked to the homepage.
3. Load time for site pages is optimized.

4.4.4 SEO

Take some time to ensure that the website has been given a solid
foundation for SEO success. From site architecture and content to metadata
sitemaps, do not leave any stone unturned such as:

1. Pages have unique page titles (fewer than 70 characters,

includes keywords).

2. Pages have keywords (fewer than 10, all words appear in page

copy).

3. Spelling and grammar are correct in all information.

4. Alt tags have been added to every image.

4.4.5 Security & Backups

Designer can prevent loss of data and protect against malware and other

damages by properly setting up site security and regular backups.

1. 24 x 7 monitoring scripts are installed.

2. A copy of the final website has been made for backup purposes.

3. Ongoing copies of the website are being created and stored on a
regular basis.

4. Passwords and other website credentials are stored in a secure
database.

4.4.6 Compliance
Finally, make sure the website complies with any applicable laws and
regulations. Internet law can be hard, and each industry has its own set of
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rules to follow. Following are a few rules one needs to know about:

1.
2.

Web pages offer accessibility for users with disabilities.
Terms and privacy policies are visible to website visitors.

4.3 Project

Project: School Website

We have learnt in details, about planning uploading and online testing
etc of a website. Let us now build a project on the subject of "School
Website'".

For building a project first of all a source file is created in notepad. It is
saved as: with ..html extension. Finally it is run on internet explorer.

There are common tags used in building this project, which we have
studied in previous chapters. This project contains one homepage and eight
web pages. All the eight webpages are linked to home page.

Home page is always the first page of the website. This page contains
all the information available on the site.

Now we are able to make a project in html related to a school ,So that we
can able to implement all the concepts which we have discussed in this and
previous chapters. Let us make a website of a school.

This is the home page of our website. As shown in fig.4.1

& GOVERNMENT SENIOR SECONDARY SCHOOL PATIALA - Windaws Internet Explorer (= ]

@ g ™ ‘e C:\10th class web development\homepage.html| v‘ +3 | X ! ‘ Search The Web 2~

W& & | @ GOVERNMENT SENIOR SECONDARY SCHOOLP... - * @ v i Page v (i Tools v

File Edit View Favorites Tools Help

-

GOVERNMENT SENIOR SECONDARY SCHOOL
"yF A9 <4 A"

Important Links Principal Message

Facilites available

Admission Form .
Greetings,

Education starts from home. Learning takes place in the best way in a secure and comfortable environment. Home is the
most secure place and we often say that we are at home with..... The home atmosphere is to be extended to school as well,
to acquire good learning outcomes. The circumstances may vary in different homes where as the school provides more or
less a uniform setting to all the students. The school is no doubt is a formal setting. Thus the formal school setting should act
as correction centres for students. It should supplement and complement what is unavailable or available at home for good

m

Faculty Details

House Details

Fhsto Gellery formation. Acquiring good social skills vales and practicing them in the school context will definitely help every student to

Other Helpful Websites convert the school into a land of bliss. The joy of achieving more and more in academic skills and feeling significance is

riner Delpiis Y ehsiies indeed home atmosphere Wishing all students a great academic year with good accomplishments and all should be able to
say "My Schoolfrom where I learned the art of loving and the joy of living together".

Any ‘Warm regards,

b-l;n' /Feedback/Suggestion Principal

Locate Us

Fig 4.1
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Code for this page is as follows in fig 4.2

TiEmei— =)

File Edit Format View Help

<htmil> B
<head> <title>GOVERNMENT SENIOR SECONDARY SCHOOL PATIALA</itle>

<meta encoding="ut}-8">

<style>

body table

background-color lightysliow

h1.H2{color red
margin-left-40px;
i

</style>

</head>

<body>

<h1 align=center>GOVERNMENT SENIOR SECONDARY SCHOOL</h1>

<Marquee behavior="alternate” bgcolor=yellow=<h1>"2 w8 wdm2 < h1></marquee>

<hr size=6 color =green width=100%>

<table border=2 width=100% >

<tr> <th>Important Links</th>

<th>Principal Message</th> </r>

<tr> <td>

<A HREF="facilities html"><h3>Facilites available</h3></A>

<A HREF="admissionform1 htmi><h3>Admission Form</h3></A>

<A HREF="facultynames html"><h3>Faculty Details</h3></A>

“housesdetails_html"><h3>House Details</h3></A>

“photogallery htmi"><h3>Photo Gallery</h3></A>

“extemnallinks_htmi"><h3>Other Helpful Websites</h3></A>

“contactus htmi"><h3>Any Query [Feadback/Suggestion</h3></A>

<A HREF="locateus html™><h3>Locate Us</h3></A>

<hd>

<td>Greetings, <br>

Education starts from home. Learning takes place in the best way in a secure and comfortable emironment. Home is the mast secure place and we often

that we are at home with..... The home atmasphere is to be extended to school as well, to acquire good leaming outcomes. The circumstances may vary in different homes where
as the school provides maore or less a uniform setting to all the students. The school is no doubt is a formal setting. Thus the formal school setting should

act as correction centres for students. It should and what is or available at home for good formation.

Acquiring good social skills values and practicing them in the school context will definitely help every student to convert the school into a land of bliss. The joy of achieving more and
more in academic skills and feeling significance is indeed home atmosphere. Wishing all students a great academic year with good accomplishments and all should be able to say
"My Schoolfrom where | leamed the ant of loving and the joy of living together”.

<Br>Warm regards, <br>

Principal

<fr>

</body> </tmi>

Fig 4.2
The first Link available in the website is facilities available and the code
and output for this is shown in fig 4.3 and 4.4

. .
(@ Fociities - Noteped Lo
FleoEditeFonmats ety
<html> a
<head>
<title>FACILITIES AVAILABLE AT OUR CAMPUS<Aitle>
<style>
body

{
background-color lightblue;

ul hi{color lightyeliow;
margin-left:40px:
)

</style>
</head>
<body>
<a htmi >Home Pag <br><br>

<h1>Superior infrastructure and best facilities available in the Campus. </h1>

<ul>

<li>fully vantilated and airy class rooms.

«<li>Total built-up area of about 75,000sq ft

<liWell equipped laboratories for Physics, Chemistry ,Biology. . Maths and Science Labs.
<li>State-of-the-art computer lab that is open for children of all ages

<li>A well stocked and updated library with a multimedia and intemet connection.
<liK-Yan multimedia presentation tool available

<li>ROT System avialble for live lectures by education department

<li>Power back up with Gen_set

<li>Retail and IT subjects are available in Vocational stream

<li>Canteen

<li>Vast Play ground

<hul>

</body>

<fhtmi> -

Fig. 4.3
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{@ FACILITIES AVAILABLE AT OUR CAMPUS - Windows Intemet Explorer =&

@U b | & C\10th class web development\facilities.html > I + | X ‘ ‘ Search The Web P~

File Edit View Favorites Tools Help
Y% & | FACIITES AVAILABLE AT OUR CAMPUS - B v B v ® v |kPagev Toolsv

Home Page

Superior infrastructure and best facilities available
in the Campus.

o fully vantilated and airy class rooms.

+ Total buit-up area of about 75,000sq &

+ Well equipped laboratories for Physics, Chemistry Biology, Maths and Science Labs.
o State-of-the-art computer lab that is open for children of all ages.

o A well stocked and updated library with a multimedia and intemnet connection.
+ K-Yan multimedia presentation tool available.

+ ROT System avialble for ive lectures by education department.

o Power back up with Gen_set.

« Retail and IT subjects are available in Vocational stream.

o Canteen.

. Vastl’laygrmd

Fig 4.4
The second link is admission form which has following output and code as
shown in Fig. 4.5 and 4.6(a) and 4.6 (b)

i,.? &he & admission form | ‘ i "’"ﬁ' B -

Home Page
Student Registration Form

Adhaar Number
Name

Father Name
Mother Name
Postal Address

i

Fig. 4.5
And the code for this form is as follows. Fig 4.6
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"] admissionform - Notepad
File Edit Format View Help
<htmi>|
<head> <tille>admission form</title> </head>
<body>
<form action="post" name="StudentRegistration™ >
<table cellpadding="2" width="20%" bgcolor="light pink" align="center" cellspacing="2">
<tr> <td colspan=2>
<center><font size=4><b>Student Registration Form</b></font></center>
<td> <tr>
<tr> <td>Name</td>
<td><input type es id=' " size="30"><d> <itr>
<tr> <td>Father Name</td>
<td><input type="text” name="fathemame” id="fathername” size="30"></td> </r>
<tr> <td>Postal Address</td>
<td><input type="text" name="paddress" id="paddress" size="30"></td> <ir>
<tr> <td>Personal Address</td>
<td><input type="text” name=" laddress” id=" laddress” size="30"><Ad> <Ar>
<tr> <td>Sex<itd>
<td><input type="radio” name="sex" value="male" size="10">Male
<input type="radio” name="sex" value="Female” size="10">Female</td> </tr>
<r> <td>City<itd>
<td><select name="City™>
<option value="-1" selected>select..</option>
<option value="New Delhi">NEW DELHI</option>
<option value="Mumbai">MUMBAI</aption=
<option value="Goa">GOA</option>
<option value="Patna">PATNA</option>
</select></td> <itr>
<tr> <td>Course</td>
<td><select name="Course">
<option value="-1" selected>select..</option>
B.Tech”>B.TECH</option>
<option value="MCA">MCA</option>
<option value="MBA">MBA</option>
<option value="BCA">BCA</option>
</select></td> </tr>
<tr> <td>District</td>
<td><select name="District">
<option value="-1" selected>select..</option>
<option value="Nalanda">NALANDA</option>
<option value="UP">UP</option>
<aption value="Goa">GOA</option>
<option value="Patna">PATNA</option>
</select></td> <ftr> -
4| i ] »

Fig 4.6 (a)

7| admissionform - Notepad = | &)
File Edit Format View Help
selected>select..</option> -
B.Tech">B . TECH</option>
MCA">MCA</option>
MBA">MBA</option>
BCA">BCA</option>
</select=</td> <Ar>

<tr> <td>District</td>

<td><select name="District">

selected>select. </option=>
Nalanda™>NALANDA</option>
UP">UP </option>
‘Goa">GOA</option>

<option value="Patna">PATNA</option>
</select><ftd> <itr>

<tr> <td>State</td>

<td><select Name="State">

{ " selected>select </option>
New Delhi">NEW DELHI</option>
Mumbai“>MUMBAI</option>
'‘Goa">GOA</option>
ihar">BIHAR </option=>

<option value=’

<Iselect><ftd>

<hr>

<tr> <td>PinCode</td>

<td><input type="text” name="pincode” id="pincode” size="30"></td>
<ftr>

<tr> <td>Emailld</td>

<td><input type="text” name="emailid" id="emailid" size="30"></td>

<ftr>

<tr> a4
<td>DOB</td>
<td><input type="text” name="dob" id="dob" size="30"></td>
<ftr>
<tr> <td>MobileNo</td>
<td><input type="text” name="mobileno” id="mobileno" size="30"></td>
<ftr>
<tr>
<td><input type="reset"></td>
<td colspan="2"><input type="submit” value="Submit Form"” /></td>
</tr> </table>
</form>
</body>
</htmi> =

. m 3

Fig 4.6(b)
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The next link is for faculty details the output and its code is defined below in
fig4.7and 4.8:-

Fig 4.8
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The next link is for house details the output in figure 4.9 and its code is
defined below inn fig. 4.10 (a), 4.10 (b) and 4.11, 4,12.

@ C:\10th class web development\housesdetails.html - Windows Internet Explorer @gﬁ

@ S | & C:\10th class web development\housesdetails.html

¥ ‘ + ‘ X ‘ ' Search The Web P~

File Edit View Favorites Tools Help

W & C:\10th class web development\housesdetails.html ‘

HOUSE RAJGURU

HOUSE INCHARGE:-RAVINDER KAUR
(MATHS LECTURER)

scheduled days:-1-10th date of

R v M v |y Page v QTooisv

HOUSE SUKHDEV

scheduled days:-21-30th

every month. date of every month.
HOUSE INCHARGE:-PARAMJIT SINGH
(ECONOMICS LECTURER)
scheduled days:-11-20th
date of every month.
D
Fig 4.9
7| housel - Notepad (== %= | | house3 - Notepad (= B
File Edit Format View Help File Edit Format View Help
<html> - khtml> -
<head> <head>
<title>OUR SCHOOL HOUSES<#itle> <title>OUR SCHOOL HOUSES<ftitle>
<style> <style>
body body
{
background-color:lightblue: background-color-RED;

h1{color:maroon;
margin-left:40px;

</style>
</head>
<body>
<h1>HOUSE RAJGURU</h1>

<B>HOUSE INCHARGE:-RAVINDER KAUR(MATHS LECTURER)
<h2>scheduled days:-1-10th date of every month.</h2>

</body>
</html>

4

m

)
h1.H2{color:YELLOW;
margin-left:40px;

)

</style>

</head>

<body>

<h1>HOUSE SUKHDEV</h1>

<B>HOUSE INCHARGE:-RANJIT KAUR(PUNJABI LECTURER)
<h2>scheduled days:-21-30th date of every month.</h2>
</body>

</html>

4

m

Fig 4.10(a)

Fig 4.10(b)
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T [ e -, ]

7] house2 - Notepad (2| E e | housesdetails - ... @M
File Edit Format View Help a3 - .
e 5 File Edit Format View Help
<head>
<title>OUR SCHOOL HOUSES<itle> <html= =
;:LY"” <frameset cols="**">

¥ <frameset rows="**">
background-color:lightgreen; <frame src="house1 html">
h1,H2{color:maroon; = <frame src="house2 html"> =
margin-left:40px; 1 <frame src="house3 html">
<Istyle> </frameset>
:mad: <frame src="house3 html">

y -
<h1>HOUSE BHAGAT SINGH</h1>
<B>HOUSE INCHARGE:-PARAMJIT SINGH(ECONOMICS LECTURER) < -
<h2>scheduled days:-11-20th date of every month.</h2> B firameset
<lbody> </html>
<lhtmi> =
&5 v »

Fig 4.11

Fig. 4.12

The next available link is photo gallery as shown in figure 4.13 and the
output and code for this webpage as shown in fig 4.14.

& IMAGES TAGS - Windows Intemet Explorer

=] B

@Q \ |fe C\10th class web develop ~ l ‘r‘ X HSEJ’:‘* The Web

2«

File Edit View Favorites Took Help
U 0 | @ IMAGESTAGS ]

fh~ v v b Page v

Home Page

Computer Lab

=1 wisw)

E photogallery - Notepad
File Edit Format View Help

htmi> ’
<head>

<title=IMAGES TAGS <Hitle>

<head>

<body>

<A HREF="homepage.himl">Home Page</A><br=<or>

<image src="computerlabjpg” width=500 height=300><br>Computer Lab<br>
<image src="science [abjpg” width=500 height=300=<br=science Lab<br»
<image src="libraryjpg" width=500 height=300=<br=Library<or>

<image src="44 jpg" width=500 height=300><br>Ground<br=

<image src="aviab,jpg" width=500 height=300=<br>audio-visual Lab<br>
<image src="can jpg" width=500 height=300=<br>Canteen<br>

<image src="mdm jpeg" width=500 height=300><br=Mid day Meal<br>
<[body>

</html=

Fig 4.13

Fig 4.14

The next available link is Other helpful websites the output as shown in figure
4.15 and code for this webpage is as shown in fig.4.16
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| externallinks - Notepad =l &

File Edit Format View Help

|htmi= -
<head>

<title=hyperlinks in html<fitle>

</head=

<body bgcolor=lightblue>DIFFERENT USEFULL WEBSITES FOR A STUDENT<BR><BR>
<A HREF="homepage html">Home Page</A><br><br>

<A href="HTTP//SSAPUNJAB.ORG™=Visit SSAPUNJAB WEBSITE</A>

<BR=<BR>

<A href="HTTP:/PSEB.AC.IN">Visit PSEB MOHALI WEBSITE</A>

<BR=<BR>

<A href="HTTP-JEPUNJABSCHOOL GOV.IN">Visit EPUNJABSCHOOL
WEBSITE</A><BR><BR>

<A href="HTTP:/ISCHOLARSHIPS.GOV.IN">Visit SCHOLARSHIP

RELATED WEBSITE</A><BR><BR>

<A href="HTTP:/PUNJABSCHOLARSHIPS.GOV.IN">APPLY FOR SC/BC

SCHOLARSHIPS

RELATED WEBSITE</A><BR=<BR>

<A href="HTTP/AVELFAREPUNJAB.GOV.IN">Visit WELFARE DEPARTMENT</A>

& hyperlinks in html - Windows Internet Explorer

@ Q v | & C\0thclasswebd + ‘ +5 ‘ x | | Search The Web

i File Edit View Favorites Tools Help

U8 @1 @ hyperlinks in html ‘ | i f~ =

Home Page
Visit SSAPUNJAB WEBSITE
Visit PSEB MOHALI WEBSITE

Visit EPUNJABSCHOOL WEBSITE

DIFFERENT USEFULL WEBSITES FOR A STUDENT i

Visit SCHOLARSHIP RELATED WEBSITE

m

;’ﬁ;’r:{: APPLY FOR SC/BC SCHOLARSHIPS RELATED WEBSITE
" - Visit WELFARE DEPARTMENT 2
Fig 4.15 Fig 4.16

The next available link is query/suggestion form the output and code for
this webpage is as shown in fig. 4.17, 4.18.

& Contact Us - Windows Internet Explorer

—|alok

@ Q - 1 @ C:\10th class web developm « | +y I x | ’ Search The Web

2 -]

File Edit View Favorites Tools Help

S a i@ContactUs ; | 2 - ~ dmh v ;) Page v

»

Home Page

Name

Email

Phone No.
Postal Address
CATEGORY

feedback -
Please write here

Contact Us

m

Fig.4.17
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) contactus - Notepad =

File Edit Format View Help

<html= .
<head>
<title=Contact Us<=#itle= </head=
<body align="left">
<Atarget=house1.html HREF="homepage.html">Home Page</A=<br=<br=
=<center=<font size=12><b>=Contact Us</b></font></center=>
Name<br=
<input type=text name=textname size="30"><br=
Email=br=
<input type="email” name=textmail size="30"><br>
Phone No.<br=
<input type="text" name="phoneno” size="30"><br>
Postal Address<br=
<input type="text" name="paddress” id="paddress” size="30"><br=
CATEGORY<br=
=select name="CATEGORY">
=<option value="Suggestion” >Suggestions</option=
=gption value="Complaint™=Complaint=/option=
<option value="feedback” selected=feedback</option=
=option value="0Others.."=0Others</option=
</select><br>
Please write here=br=
<textarea name="subject” placeholder="Write something..” rows="15" cols="50"=<Aextarea=
<br=<br=
<input type="submit” value="Submit Form" =
=fform=
</body>
</html= -

Fig 4.18
The next and last available link is locate us the output as shown in figure
4.19 and code for this webpage is as fig. 4.20:-

[ /& LOCATE US - Windows Intemet Explorer li@lg
UU [ @ a0t class web devel: + |4 | | [ search The web £~

. File Edit View Favorites Tools Help I PDFsam Enhanced 4 @ [Ea B
o |§Lomr5us ]_} - ~ = v [k Page v =
"

Home Page i

Contact Us

ADDRESS:-

GOVERNMENT SENIOR SECONDARY
SCHOOL,
DISTT.MOHALI

Email:-gsssmohali@gmail.com
Phone No. L
01722680001 =

Fig. 4.19
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| LOCATEUS - Notepad =] [l

File Edit Format View Help

<html= <
<head=

<fitle=LOCATE US<fitle=
</head=
<pody font align="left"=

<A HREF="homepage himl"=Home Page</A=<br=<br=

=center==font size=12=<b>Contact Us=/b==/font=</center=
<font size=5=<p=
ADDRESS -<br==br=
GOVERNMENT SENIOR SECONDARY SCHOOL <br=
DISTT MOHALI=br==<br=
Email-gsssmahali@gmail com=br=
Phone No.<br=

01722680001
=ffont=</b=
</body=
</htmi=| i
Fig 4.20
1. Before deciding about the server we should register the domain
name.
2. The needs of viewers should be kept in mind while designing a
website.
3. You can establish your own server or can hire a space for it from

any company or organization.

4 After designing all pages they are tested off line.

5) Site is uploaded with the help of FTP (File Transfer Protocol).

6. After successful uploading, site in tested online.

7. First page of a site is the home page, all other pages of site are
linked with home

8 Bandwidth is the amount of data transfer you are allowed
within a given time period.

9. Test your website in a variety of web browsers.

10. Search engine optimization is a methodology of strategies,
techniques and tactics used to increase the amount of visitors
to a website
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Exercise

1. Multiple Choice Questions:

1.

There are four stages of planning a
website.
a. Goal of a site.
b. Designing for viewers.
c. Work strategy. And
development of subject matter.
d. All of the above.
The modes of works to carry out for
achieving the goal is called
a. Work-strategy.
b. Plan Strategy.
c. Design Strategy.
d. None of th e above.
Web Server can be
a. Bought.
b. Borrowed.
c. Both of the above.
d. None of these.
Size of a web page should not be more
than
a. One screen.
b. Two screens.
c. Three screens.
d. Four screens.
A good look of a webpage depends
upon
a. Font size/colour.
b. background colour
c. Table and graphics.
d. All of the above.
No internet connection is needed in
a. Offline testing.
b. Online testing.
c. Both of the above.
d. None of these.
SEO means
a. Search engine optimization.
b. System engine optimization.
c. Syncronized engine
optimization.
d. None of the above.

8. SMM Stands for
a. Social media marketing.
b. Science media marketing.
c. System macro media.
d. None of the above.

9. FTP means
a. File transfer protocol.
b. Finance transfer protocol.
c. Folder transfer protocol.
d. None of the above.

10. Testing of website using internet is
known as
a. Offline testing.
b. Online testing.
c. Both of the above.
d. None of the above.

2. Fill in the Blanks:

1. While planning to build a site, decision

about...... fsite is taken at the end.

2. e is the address of your site.

3. After deciding about domain name next
stepis....cceceenen the domain name.

4. i should not be larger than two
screens.

5. i test can be done without the
internet.

6. The very first page of any website is

calledas......cc...........
3. True or False:

1. There is no link of other pages with the

home page

2. Address of site ends with .com, .org, .net

etc.

3. Off line testing of a site should be done

on a single browser only.

4. To send the webpages to host, we need

FTP client.

5. During online testing of a site your
computer should be connected to the

internet.
Give the full names of

1.1P 2. FTP 3. URL
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Very Short Answer type Questions:

Which is the address of your site .

The copy of the website on computer is

called the version, and the copy

on the web host is called the
version.

What helps a company get direct

feedback from customers.

What is necessary to check all of the

different features on the website.

How can Designer prevent loss of data

and protect against malware and other

damages.

Short Answer type Questions:

Describe the important points to fix
the purpose of a site.

What is meant by designing for
viewers? Write in brief.

4.
5.

Answers Key

- Publishing.
- a Domain Name.
_ c Registration
- d Offline.

: =
Kl - :
Kl - .

: -

What should be contents of your
site?

What do you mean by Domain
Name?

How a domain name is registered?

What is role of server in world of
internet?

What points are to be taken care of
while designing a webpage?

Write the procedure of uploading a
site.

What do you mean by offline testing?

Long Answer type Questions:

Write the different steps for planning
awebsite?

Describe the necessary direction for
implementing a website.

What is difference between offline
and online testing.

What is SEO?
What is SMM?

T
m Multiple Choice Fill in the Blanks Very Short Answer

FALSE. Domain Name.

TRUE. Local
,productionExternal Link.

FALSE. SMM.

TRUE. Test and Validate.

TRUE. By taking regular backup

and preventive security
measures.
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Chapter
5 Desktop. Publishing

Objectives of this chapter:

5.1 Desktop Publishing

5.2 Desktop —publishing software

5.3 Word Processing vs. Desktop Publishing
5.4 WYSIWUG Feature

5.5 Graphics

5.6 Margins

5.7 Fonts

5.8 Frames

5.9 Printers

Introduction

When documents and images are printed, these are "published." Before
computers became commonplace, the publishing process required large print
presses that copied and duplicated pages. In order to print images and words
on the same page, the text and graphics would have to be printed separately,
cut out, placed on a single sheet, taped in place, then copied and printed.
Fortunately, computers with graphical user interfaces have enabled desktop
publishing, which allows this process to be done electronically.

5.1 Desktop publishing:

Any time we use a computer to create a printable document, it can be
considered desktop publishing. Desktop publishing programs can be used to
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create books, magazines, newspapers, flyers, pamphlets, and many other
kinds of printed documents. Word processing programs like Microsoft Word
can be used for basic desktop publishing purposes.

Complete desktop publishing involves the combination of typesetting
(choosing fonts and the text layout), graphic design, page layout (how it all fits
on the page), and printing the document. However desktop publishing can also
be as simple as typing and printing a school paper. In order to desktop publish,
all we need is a computer, monitor, printer, and software that can create a
printable document. While that might cost more than a pen and paper, it
certainly is cheaper than a printing press.

5.1.1 Definition:
Desktop publishing is the process of using a computer and specific types of
software to combine text, images and artwork to produce documents

properly formatted for print or visual consumption.
5.1.2 Desktop Publishing Opened Visual Communication To All
Desktop publishing isn't limited to professionals. With the advent of

desktop publishing software and affordable desktop computers, a wide range
of people, including non-designers and others without graphic design

experience, suddenly had the tools to become desktop publishers.
Freelance and in-house graphic designers, small business owners,

secretaries, teachers, students and individual consumers do desktop
publishing.

Non-designers can create visual communications for commercial digital
printing, printing on a printing press, and for desktop printing at home or in the

office.
Although desktop publishing encompasses everything from the initial

design to printing and delivery of the finished product, the core parts of
desktop publishing are the page_layout, text composition and the prepress or

digital file preparation tasks.
5.1.3 The Modernization Of Desktop Publishing
Desktop publishing has expanded beyond the print-only applications

that made it so popular. Desktop publishing hardware and software is also
used to design and produce web pages. In this case, the content is viewable, not
designed for print. It is accessed on computers and mobile devices, such as
tablets and smartphones. Examples of other non-printed desktop publishing
results include slide shows, emailed newsletters and PDF's etc.
5.2 Desktop-publishing softwares

The primary software used in desktop publishing is page layout software
and web design software. Graphics software, including drawing software, a
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photo editor and word processing software, are also important tools of the
graphic designer or desktop publisher. The list of available software is lengthy,
but some software is seen on just about everyone's must-have list depending
on what they are trying to accomplish.
5.2.1 Page Layout Software for Printing
e. Adobe InDesign
e. PagePlus Series from Serif
- QuarkXpress
5.2.2 Page Layout Software for Office
-@ Microsoft Office Suite
-@ Apple iWork Suite
5.2.3 Graphics Software
-@ Adobe Illustrator
-@ Corel Draw
-@ Inkscape
5.2.4 Photo Editing Software
- Adobe Photoshop
-@ Corel PaintShop Pro
5.2.5 Web Design Software
-@ Adobe Dreamweaver CC
- Adobe Muse
5.3 Word Processing vs. Desktop Publishing

Both word processing and desktop publishing are similar in many ways
but different in areas that cover the publication of documents.
The similarities between the two are:

e  Both deal with text that can be formatted.
-0 Both can work with tables and pictures.
0 Both have many similar features like WordArt, Clip Art, and
text styles.
The differences between the two are:

Word processing involves creation, editing, and printing of text while
desktop publishing involves production of documents that combine text
with graphics.

Word processing is difficult to layout and design as compared to desktop
publishing. Thus, desktop publishing is used to work on things like
newsletters, magazines, adverts, and brochures where layout is important.
Word processing documents are common for simple memos, letters,
manuscripts, and resumes.

5.4 WYSIWYG Feature:

Pronounced WIZ-zee-wig. Short for what we see is what we get. A

WYSIWYG application is one that enables us to see on the display screen
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exactly what will appear when the document is printed. A WYSIWYG is a
system in which content (text and graphics) can be edited in a form closely
resembling its appearance when printed or displayed as a finished product,
such as a printed document, web page, or slide presentation. WYSIWYG is

especially popular for desktop publishing
With desktop publishing, we can increase productivity, minimize

production cost, enhance the appearance of our documents, improve the level
of creativity, reduce the time taken for printing and produce customized
documents. The best part about DTP is that we can create professional-looking

documents, without the need for graphic designer.
5.5 Graphics

A graphic is an image or visual representation of an object. Therefore,
computer graphics are simply images displayed on a computer screen.
Graphics are often contrasted with text, which is comprised of characters,
such as numbers and letters, rather than images.

Computer graphics can be either two or three-dimensional. Early
computers only supported 2D monochrome graphics, meaning they were black
and white (or black and green, depending on the monitor). Eventually,
computers began to support color images. While the first machines only
supported 16 or 256 colors, most computers can now display graphics in
millions of colors.

There are two main types of 2D graphic:
;@-  Bitmap or Raster graphics
-0 Vector graphics

5.5.1 Bitmap or raster graphics

Bitmap graphics consist of many tiny dots called pixels. It is possible to
edit each individual pixel using bitmap graphics software like Adobe
Photoshop .

Examples of bitmap graphics are a digital photograph or a scanned image.

The amount of detail we can draw depends on the number of pixels per
square inch (PSI). Since the computer has to store information about every
single pixel in the image, the file size of a bitmap graphic is often quite large.
When we resize a bitmap graphic, it tends to lose its quality.

5.5.2 Vector graphics

Vector graphics are based on control points which are connected by lines and
curves called vector paths or vectors. Vector paths can be used to make shape
objects. It is possible to edit each shape object separately, for example, to
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change the shape, outline type (stroke), fill, size or position.
Vector graphics software includes Adobe Illustrator and CorelDRAW.

When a vector graphic is resized, it doesn't lose quality. This is because the
software works out the new relationships between control points and redraws
the image at the new size. Vector graphics do not store information about each
pixel so file size does not depend on image size. Instead it depends on how
much detail is in the image.

Vector Raster

Enlargement Enlargement

o ¢

25 100 25 100
pixels pixels pixels pixels

Fig. 5.1

3D graphics started to become Top Margin
popular in the 1990s, along with 3D
rendering software such as CAD and 3D
animation programs. By the year 2000,
many video games had begun
incorporating 3D graphics, since
computers had enough processing
power to support them. Now most
computers now come with a 3D video
card that handles all the 3D processing.
This allows even basic home systems to
support advanced 3D games and
applications.

PnntSpoace

uillvpy 2%y

Lel Mapn

5.6 Margins

A margin is the area between the
main content of a page and the page
edges. The margin helps to define where
a line of text begins and ends. A page to
include top, Bottom, Left and Right Fi

. o ig. 5.2
margin as shown in fig 5.2.

Bestom Marngn
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The default margins are usually defined as one inch on all sides. However,
depending on the requirement, the margins may vary. These margins create a
frame around the content of the page so that the text does not run all the way
to the edges. The white space along the edges of the document makes the page
look cleaner and the text is easier to read.

| Page Setup ? X ‘ & ny H -3 )*

1 .
Magim [Eencer iyt Home Insert Page Layout References Mailings
Margins Ecoors- | | l (B3 ]j =) Breaks -

Top: 2.54cm % Bottom: 2.54cm i || | —— Fonts ~ ||[PY | —J £ Line Nu
3 - " - Themes — Margins|Orientation Size Columns
Left 25%cw =] Rt 20w = - Effects ~ - v - - b&™ Hyphen
Gutter: 0cm %|  Gutter position:  |Left v E— e
Orientation Top: 254cm Bottom: 2.54 cm
. @ Left: 254cm Right: 254 cm
: =
Portrait  Land ) | B
et 2 - Top: 1.27cm Bottom: 1.27 tm
Pages - Left: 1.27cm Right: 1.27cm
Multiple pages: Normal v i —
_ Moderate
Top: 254 cm Bottom: 2.54 cm
Preview Left: 1.91cm Right 1.91cm
! }
— = T Wide
_— - Top: 2.54cm Bottom: 2.54 ¢m
S - Left: 5.08cm Right: 5.08cm
R Mirrored
T Top: 254cm  Bottom: 2.54 ¢cm
Apply to: |Whole document | v L1 | Inside: 3.18cm  OQutside:2.54 cm
Det II' - Custom Margins...
Fig. 5.3 Fig. 5.4

5.6.1 Gutter position

A gutter margin setting adds extra space to the side margin or top margin
of a document that we plan to bind. A gutter margin helps ensure that text isn't
hidden by the binding.

5.7 Fonts

A font is a set of printable or displayable text character s in a specific style
and size or we can say that a font is a specific typeface of a certain size and style. A
typeface is a set of characters of the same design. These characters include
letters, numbers, punctuation marks, and symbols. Some popular typefaces
include Arial, Helvetica, Times, and Verdana. While most computers come with a
few dozen typefaces installed, there are thousands of typefaces available. Because
they are vector-based (not bitmaps), typefaces can be scaled very large and still
look sharp. The term "typeface" is often confused with "font," which is a specific
size and style of a typeface. For example, Verdana is a typeface, while Verdana 10
ptboldis a font. It's a small difference, but is good to know.
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Arial

Anal Regular Arial Narrow
Anal ltalic Anal Narrow ltalic
Arial Bold Arial Narrow Bold
Arial Bold Italic Arlal Narrow Bold ltalic
Arial Black Arial Rounded MT Bold
T
Fig. 5.5

5.8 Frames

Frames are rectangular areas meant for inserting graphics and text. They allow
users to place objects wherever they want to on the page. Because text and
images are handled in DTP as separate units, they are placed on the page as
frames surrounded by bounding boxes. These frames can then be changed in
size or position using the bounding boxes. Frames allow for complete control of
the page design. Text frames can also be linked to allow text to flow from one
column to another or one page to another. Frames can be a rectangle, an oval,
or a polygon. Polygon frames can be changed to any shape. Frames can contain
text, a graphic, or be empty.

text box
text box picture
pox
il
Fig 5.6 Frames

5.9 Printer

A printer is an external output device that takes data from a computer and
generates output on a paper in the form of graphics / text.
There are two types of printers.
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Impact Printers
Non-Impact Printers

5.9.1 Impact printers

An impact printer has a head that contains pins to make contact with the
paper. It usually forms the print image by striking its pins on a inked ribbon
against the paper . Following are some examples of impact printers.
5.9.1.1 Dot-Matrix Printers

The dot-matrix printer uses print heads containing from 9 to 24 pins. These
pins produce patterns of dots on the paper to form the individual characters. The
24 pin dot-matrix printer produces more dots that a 9 pin dot-matrix printer,
which results in much better quality and clearer characters. The general rule is:
the more pins, the clearer the letters on the paper. The pins strike the ribbon
individually as the print mechanism moves across the entire print line in both
directions, i-e, from left to right, then right to left, and so on. The user can produce
a color output with a dot-matrix printer (the user will change the black ribbon with
a ribbon that has color stripes). Dot-matrix printers are inexpensive and typically
print at speeds of 100-600 characters per second.

Fig 5.7 Dot Matrix Printer

5.9.1.2 Daisy-wheel Printers

In order to get the quality of type found on typewriters, a daisy-wheel impact
printer can be used. It is called daisy-wheel printer because the print mechanism
looks like a daisy; at the end of each “Petal” is a fully formed character which
produces solid-line print. A hammer strikes a “petal” containing a character
against the ribbon, and the character prints on the paper. Its speed is slow
typically 25-55 characters per second.

Fig 5.8
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Fig 5.8 Daisy Wheel Printer
Note:

dot marix printer and daisy wheel printer comes in the category of
character- at- a- time printer.

5.9.1.3 Line Printers

In business where enormous amount of material are printed, the character-at-
a-time printers are too slow; therefore, these users need line-at-a-time printers.
Line printers, or line-at-a-time printers, use special mechanism that can print a
whole line at once; it can typically print the range of 1,200 to 6,000 lines per
minute. Drum, chain, and band printers are line-at-a-time printers.

Fig 5.9

5.9.2 Non-Impact Printers

Non-impact printers do not use a striking device to produce characters on the
paper; and because these printers do not hammer against the paper its much
quieter. Following are some non-impacted printers.

5.9.2.1 Ink-jet printers

Ink-jet printers work in the same fashion as dot-matrix printers in the form
images or characters with little dots. However, the dots are formed by tiny droplets of
ink. Ink-jet printers form characters on paper by spraying ink from tiny nozzles
through an electrical field that arranges the charged ink particles into characters at
the rate of approximately 250 characters per second. The ink is absorbed into the
paper and dries instantly. Various colors of ink can also be used.
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Fig 5.10

One or more nozzles in the print head emit a steady stream of ink drops.

Droplets of ink are electrically charged after leaving the nozzle. The
droplets are then guided to the paper by electrically charged deflecting plates
[one plate has positive charge (upper plate) and the other has negative charge
(lower plate)]. A nozzle for black ink may be all that's needed to print text, but
full-color printing is also possible with the addition of needed to print text, three
extra nozzles for the cyan, magenta, and yellow primary colors. If a droplet isn't
needed for the character or image being formed, it is recycled back to its input
nozzle.

Several manufacturers produce color ink-jet printer. Some of these
printers come with all their color inks in a cartridge; if we want to replace on
color, we must replace all the colors. Other color ink-jet printers allow us to
replace ink individually. These printers are a better choice if user uses one
color more than other colors. These printers produce less noise and print in
better quality with greater speed.

5.9.2.2 Laser printers

A laser printer works like a photocopy machine. Laser printers produce
images on paper by directing a laser beam at a mirror which again directs the
beam onto a drum. The drum has a special coating on it to which toner (an ink
powder) sticks. Using patterns of small dots, a laser beam conveys information
from the computer to a positively charged drum to become neutralized. From
all those areas of drum which become neutralized, the toner detaches. As the
paper rolls by the drum, the toner is transferred to the paper printing the
letters or other graphics on the paper. A hot roller bonds the toner to the paper.

Fig 5.11
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Laser printers use buffers thagjgterean entire page at a time. When a

whole page is loaded, it will be printed. The speed of laser printers is high and it
print quietly without producing much noise. Many home-use laser printers can
print eight pages per minute, but faster and print approximately 21,000 lines
per minute, or 437 pages per minute (if each page contains 48 lines). When high
speed laser printers were introduced they were expensive. Developments in the
last few years have provided relatively low-cost laser printers for use in small

businesses.
mber
1. In order to desktop publish; all we need is a computer, monitor,
printer, and software that can create a printable document.

2. Desktop publishing isn't limited to professionals.

3. Desktop publishing hardware and software is also used to design and
produce web pages.

4. The primary software used in desktop publishing is page_layout
software and web design software.

5. Both word processing and desktop publishing are similar in many
ways but different in areas that cover the publication of documents.

6. Agraphicisanimage or visual representation of an object.

7. A marginis the area between the main content of a page and the page
edges.

8. Afontis a set of printable or displayable text character s in a specific
style and size or we can say that a font is a specific typeface of a
certain size and style.

9. Frames arerectangular areas meant for inserting graphics and text.

10. A printer is an external output device that takes data from a computer
and generates output in the form of graphics / text on a paper

. 2) That enables us to see on the display
Exe rcise screen exactly what will appear when the
document is printed.
1. Multiple Choice Questions: a. WYSWJKI
1) Programs that can be used to create b. WKSWUG
books, magazines, newspapers, flyers, ¢. WUSIWUG
pamphlets, and many other kinds of d. WYSIWYG .
printed documents. 3) An external output device that takes

a. Desk Publishing data from a computer and generates output

b. Desk Top Publishing inthe formof graphics / text on a paper.

c. TopPublishing a. Frfames

d. Publishing b. Printers

c. Fonts
d. Plotters
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4) A printer that works like a photocopy
machine

a. Laser
b. InkdJet
c. Line
d. Drum

5) Rectangular areas meant for inserting
graphics and text.
a. Rectangles

b. Frames

c. Structure

d. Fonts
6) is a visual representation of
objects

a. Charts

b. Graphics

c. Frames

d. Fonts

7) Ink-jet printers form characters on
paper by spraying ink at the rate of

approximately _____ characters per
second.

a. 250

b. 350

c. 200

d. 100
8) are formed by tiny droplets of
ink.

a. Pixels

b. Dots

c. Fonts

d. Characters

9) Printer that print image by pressing an
inked ribbon against the paper using a
hammer or pins.

a. Ink-jet

b. Impact

c. Nonimpact
d. Laser

10) The graphics do not store information
about each pixel so file size does not
depend on image size.

a. Raster
b. Plain graphics
c. Vector

d. None ofthese

Fill in the banks
1) Arial, Helvetica, Times, and
Verdana etc. are examples
of and they have same

2) A Gutter margin setting
adds extra space to the ____
margin or margin of a
document that we plan to
bind.

3) Polygon frames can be
changed to any and

4) In web pages the content is

, not designed for ____ .

5) Laser printers use that

stores an at a time.
True/False

1) DTP stands for Desk Top
Publishing.

2) Desktop publishing hardware
and software is also used to
design and produce web
pages.

3) In Ink-Jet Printer, the ink
cannot be absorbed into the
paper and dries instantly.

4) Frames allow users to place
objects wherever they want to
on the page.

5) The dot-matrix printer uses
print heads containing from
19 to 124 pins.

Very short Answers Type Questions

1) Which printer can typically
print the range of 1,200 to
6,000 lines per minute?

2) Which printer can be either
two or three-dimensional.

3) Which printer has a special
coating on it to which toner
(an ink powder) sticks?

4) A set of characters of the same
designiscalled as.....?

5) The area between the main
content of a page and the page
edges is called as ....?
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Short Answer type Questions Long Answer type questions

1) What is Desktop Publishing? 1) What is the difference
2) What are the various types of between Vector Graphics
printers? and Bitmap Graphics?

3) What is Frame? 2) Desktop publishing opened

4) Define Font.sssss visual communication to
5) What is margin? all. Explain.

6) What do you mean by Gutter 3) What is the difference

Position? - between Impact and Non-
7) What are Graphics? Impact printers?

8) Explain the working of Laser 4) Explain any two types of

Printe}’. Impact printers.
9) Explain WYSIWYG feature. 5) Give comparison between

Desktop publishing and
word processing software.

Answers Key

- Desk Top Typeface, design Line Printers

Publishing
— WYSIWYG Side, top True Computer Graphics
BE Printer Shape, size False Laser Printers
— Laser Viewable, print True Typeface
- Frames Buffers, entire page False Margins
— Graphics - - -
_ Dots _ _ _
— Impact - - -
Vector _ _ _
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OPERATING SYSTEM Chaspter

Objectives of this chapter:

6.1 Definition of operating system

6.2 Types of operating systems

6.3 Difference between DOS and Windows Operating System
6.4 Linux

6.5 Computer Security

Introduction:

An Operating System (OS) is an interface between computer user and
computer hardware. An operating system is software which performs all the
basic tasks like file management, memory management, process
management, handling input and output, and controlling peripheral devices
such as disk drives and printers.

Some popular Operating Systems include Linux, Windows, OS X, VMS,

0S/400, AIX, z/OS, etc.

6.1 Definition of operating system
An operating system is a program that acts as an interface between the

user and the computer hardware and controls the execution of all kinds of
programs.

System Application
Softwares Softwares

Operating System

Fig 6.1 Operating System
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6.1.1Services provided by operating System

An Operating System provides services to both the users and to the
programs.

° It provides programs an environment to execute.
o It provides users the services to execute the programs in a
convenient manner.
Following are a few common services provided by an operating system ?
Program execution
I/0O operations
File System manipulation
Communication
Error Detection
Resource Allocation
° Protection

6.1.1.1 Program execution

Operating systems handle many kinds of activities from user
programs to system programs like printer spooler, name servers, file server,
etc. Each of these activities is encapsulated as a process.

A process includes the complete execution context (code to execute,
data to manipulate, registers, OS resources in use). Following are the major
activities of an operating system with respect to program management ?

° Loads a program into memory.

Executes the program.

Handles program's execution.

Provides a mechanism for process synchronization.
Provides a mechanism for process communication.
° Provides a mechanism for deadlock handling.

6.1.1.2 I/0 Operation

An I/0 subsystem comprises of I/O devices and their corresponding
driver software. Drivers hide the peculiarities of specific hardware devices
from the users.

An Operating System manages the communication between user
and device drivers.

e [/O operation means read or write operation with any file or any

specific I/O device.

e Operating system provides the access to the required 1/0 device
when required.
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6.1.1.3 File system manipulation

File manipulation refers to wide variety of operations which are available
and allow us to delete ,copy, move. As we know a file represents a collection of
related information. Computers can store files on the disk (secondary storage),
for long-term storage purpose. Examples of storage media include magnetic
tape, magnetic disk and optical disk drives like CD, DVD. Each of these media
has its own properties like speed, capacity, data transfer rate and data access
methods.

A file system is normally organized into directories for easy navigation
and usage. These directories may contain files and other directions. Following
are the major activities of an operating system with respect to file
management :-

° Program needs to read a file or write a file.

° The operating system gives the permission to the program for
operation on file.

° Permission varies from read-only, read-write, denied and so on.

° Operating System provides an interface to the user to
create/delete files.

° Operating System provides an interface to the user to
create/delete directories.

° Operating System provides an interface to create the backup of file
system.

6.1.1.4 Communication
In case of distributed systems which are a collection of processors that

do not share memory, peripheral devices, or a clock, the operating system
manages communications between all the processes. Multiple processes

communicate with one another through communication lines in the network.

The OS handles routing and connection strategies, and the problems of
contention and security. Following are the major activities of an operating
system with respect to communication :-

e Two processes often require data to be transferred between them
e Both the processes can be on one computer or on different

computers, but are connected through a computer network.
¢ Communication may be implemented by two methods, either by

Shared Memory or by Message Passing.
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6.1.1.5 Error Detection

Errors can occur anytime and anywhere. An error may occur in CPU, in
I/0 devices or in the memory hardware. Following are the major activities of an
operating system with respect to error Detection ?

° The OS constantly checks for possible errors.
. The OS takes an appropriate action to ensure correct and
consistent computing.

6.1.1.6 Resource Management

In case of multi-user or multi-tasking environment, resources such as
main memory, CPU cycles and files storage are to be allocated to each user or
job. Following are the major activities of an operating system with respect to
resource management ?

. It acts like a resource manager. The OS manages all kinds of
resources using schedulers.

° CPU scheduling algorithms are used for better utilization of
CPU.

6.1.1.7 Protection

Considering a computer system having multiple users and concurrent
execution of multiple processes, the various processes must be protected from
each other's activities.

Protection refers to a mechanism or a way to control the access of
programs, processes, or users to the resources defined by a computer system.
Following are the major activities of an operating system with respect to

protection :-
° The OS ensures that all access to system resources is
controlled.
° The OS ensures that external 1/O devices are protected from
invalid access attempts.
° The OS provides authentication features for each user by means
of passwords.

6.2 Types of Operating Systems

Operating systems are there from the very first computer generation
and it keep evolving with time. In this chapter, we will discuss some of the
important types of operating systems which are most commonly used.

6.2.1 Batch operating system
The users of a batch operating system do not interact with the computer

directly. Each user prepares his job on an off-line device like punch cards and
submits it to the computer operator. To speed up processing, jobs with similar

S

Downloaded from https:// www.studiestoday.com



Downloaded from https:// www.studiestoday.com

needs are batched together and run as a group. The programmers leave their
programs with the operator and the operator then sorts the programs with

similar requirements into batches.
The problems with Batch Systems are as follows :-
o Lack of interaction between the user and the job.
° CPU is often idle, because the speed of the mechanical I/0O

devices is slower than the CPU.
° Difficult to provide the desired priority.

6.2.2 Time-sharing operating systems

Time-sharing is a technique which enables many people, located at
various terminals, to use a particular computer system at the same time.
Time-sharing or multitasking is a logical extension of multiprogramming.
Multiple jobs are executed by the CPU by switching between them, but the
switches occur so frequently. Thus, the user can receive an immediate
response. Computer systems that were designed primarily as batch systems
have been modified to time-sharing systems. Advantages of Timesharing
operating systems are as follows :-

° Provides the advantage of quick response.

° Avoids duplication of software.

° Reduces CPU idle time.

Disadvantages of Time-sharing operating systems are as follows :-

° Problem of reliability.

° Question of security and integrity of user programs and data.

° Problem of data communication.

6.2.3 Distributed operating System

Distributed systems use multiple central processors to serve multiple
real-time applications and multiple users. Data processing jobs are
distributed among the processors accordingly.

The processors communicate with one another through various
communication lines (such as high-speed buses or telephone lines). These are
referred as loosely coupled systems or distributed systems. Processors in a
distributed system may vary in size and function. These processors are
referred as sites, nodes, computers, and so on.

The advantages of distributed systems are as follows :-

o With resource sharing facility, a user at one site may be able to
use the resources available at another.
° Speedup the exchange of data with one another via electronic
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mail.

° If one site fails in a distributed system, the remaining sites can
potentially continue operating.

° Better service to the customers.

° Reduction of the load on the host computer.

° Reduction of delays in data processing.

6.2.4 Network operating System

A Network Operating System runs on a server and provides the server the
capability to manage data, users, groups, security, applications, and other
networking functions. The primary purpose of the network operating system is
to allow shared file and printer access among multiple computers in a network,
typically a local area network (LAN), a private network or to other networks.

Examples of network operating systems include Microsoft Windows
Server 2003, Microsoft Windows Server 2008, UNIX, Linux, Mac OS X, Novell
NetWare, and BSD.

The advantages of network operating systems are as follows :-

e Centralized servers are highly stable.

e Security is server managed.

e Upgrades to new technologies and hardware can be easily

integrated into the system.
e Remote access to servers is possible from different locations and
types of systems.

The disadvantages of network operating systems are as follows :-

e High cost of buying and running a server.

e Dependency on a central location(server) for most operations.

e Regular maintenance and updates are required.

6.2.5 Real Time operating System

A real-time system is defined as a data processing system in which the
time interval required to process and respond to inputs is so small that it
controls the environment. The time taken by the system to respond to an input
and display of required updated information is termed as the response time. So
in this method, the response time is very less as compared to online
processing.

Real-time systems are used when there are rigid time requirements on
the operation of a processor or the flow of data. A real-time operating system
must have well-defined, fixed time constraints, otherwise the system will fail.
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For example, Scientific experiments, medical imaging systems, industrial
control systems, weapon systems, robots, air traffic control systems, etc.

6.3 Difference between DOS And Windows Operating System

Disk Operating System abbreviated as DOS is a product of Microsoft
Corporation released in 1981 and it comes as part-and-parcel with Microsoft
Windows operating system.To get to DOS prompt and give commands for
performing tasks on files and directories,

Click Start > Run... and type command or cmnd and press ENTER.

Windows is a series of most popular operating systems developed by
Microsoft for use on personal computers. First edition of Windows that runs
on MS-DOS 5.0 was released in 1985, as a 16-bit OS. Of all the editions of
Windows OS released by Microsoft Corporation from 1985 till date, the
popular ones include Windows 98, Windows 2000 Professional, Windows XP,
Windows Vista and Windows 7,windows8,window10 Coming to differences,
here are 5 basic ones that differentiate DOS and Windows:

DOS Windows
Single user Multi User
Single tasking Multi tasking
Not time Sharing Time sharing
Input device keyboard Standard Input devices are keyboard and mouse
Character User Interface
(CUD) Graphical User Interface (GUI)
6.4 Linux

Linux is one of popular version of UNIX operating System. It is open source
as its source code is freely available. It is free to use. Linux was designed
considering UNIX compatibility. Its functionality list is quite similar to that
of UNIX.
6.4.1 Basic Features

Following are some of the important features of Linux Operating
System.

° Portable : Portability means software can works on different
types of hardware in same way. Linux kernel and application
programs supports their installation on any kind of hardware
platform.

° Open Source : Linux source code is freely available and it is
community based development project. Multiple teams work in
collaboration to enhance the capability of Linux operating system
and itis continuously evolving.
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Multi-User : Linux is a multiuser system means multiple users can
access system resources like memory/ ram/ application programs
at same time.

Multiprogramming : Linux is a multiprogramming system means
multiple applications can run at same time.

Hierarchical File System ? Linux provides a standard file structure
in which system files/ user files are arranged. Files and directories
are arranged in tree structure form

Shell : Linux provides a special interpreter program which can be
used to execute commands of the operating system. It can be used
to do various types of operations, call application programs. etc.
Security : Linux provides user security using authentication
features like password protection/ controlled access to specific
files/ encryption of data.

6.4.2 Architecture
The following illustration shows the architecture of a Linux system
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Fig 6.2 =g

The architecture of a Linux System consists of the following layers —

Hardware layer — Hardware consists of all peripheral devices (RAM/
HDD etc).

Kernel - It is the core component of Operating System, interacts
directly with hardware, provides low level services to upper layer
components.

Shell - An interface to kernel, hiding complexity of kernel's functions
from users. The shell takes commands from the user and executes
kernel's functions.
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6.5 Computer Security

Computer security is the process of preventing and detecting
unauthorized use of our computer. Prevention measures help us to stop
unauthorized users (hackers) from accessing any part of our computer system.
Detection helps us to determine whether or not someone attempted to break
into our system, if they were successful, and what they may have done.

Our computers have become an extension of everything we do from
banking and investing to shopping and communicating with others through
email or chat. We may not consider our communications "top secret," most
likely we do not want strangers reading our email, using our computer to attack
other systems, sending forged email from our computer, or examining personal
information stored on our computer.

Hackers do not care about our identity. Often they want to gain control of
our computer so they can use it to launch attacks on other computer systems.
Having control of our computer gives the hackers the ability to hide their actual
location as they launch attacks, often against high-profile computer systems
such as government or financial systems.

Hackers have the ability to watch all our actions on the computer, or
cause damage to our computer by reformatting our hard drive or changing our
data.

Internet Security is the most important aspect that everyone using the
internet should understand. Here we are describing a few important tips to keep
ourself secure and protect our Information from Security threats.

6.5.1 Latest Anti-virus software:

New viruses and threats are being discovered everyday and to cope with
that we need to have a latest version of the Anti-virus software. Even to make
our Version of Anti- Virus software effective, we need to update it with latest
updates available. There are many Anti- Virus Software available, both free and
paid.

6.5.2 Anti-Spyware Software:

Anti-virus software alone is not enough. To be secure from Internet
Security threats we also need Anti-spyware software. Spyware programs are
different from viruses in a way that unlike virus it does not alter the way in
which our machines works or corrupt any data but it installs itself on our
machine to send important data like passwords, Credit card numbers stored
on your machine to its server. So in order to detect spyware programs & prevent
one from getting into our machine we need latest Anti-spyware software.
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6.5.3 Password protection :

Passwords are the most important aspect of various online accounts. They
provide access to online accounts and enable us to perform various activities
linked with account like shopping, emailing, online transactions etc. Keeping our
password secure is like keeping money secure. Never keep same passwords for
different accounts. Never keep password's that can be guessed or password
relating to our personal's like telephone number, date of birth etc. Use long
Password's consisting of both letters and digits and may be some special
characters. Always Access Websites Related to our password directly by opening a
new webpage and never through a link in email or provided otherwise.

6.5.4 Apply Latest Updates & Patches:

No software installed on our system is perfect for life. Apply the latest
updates & patches to the software. These updates and patches are made available
from time to time by the software manufacturer.

6.5.5 Firewall:

If possible try to Use a firewall to prevent hackers from attacking our
system. Firewall blocks traffic not authorized to access our PC. Firewall enables
us to access internet securely and prevent unauthorized applications and people
from accessing our PC.

1. Anoperating system is a program that acts as an interface between the user and the
computer hardware.

2. Operating systems handle many kinds of activities from user programs to system
programs like printer spooler, name servers, file server, etc. Each of these activities
is encapsulated as a process.

3. Afile represents a collection of related information. Computers can store files on the
disk (secondary storage), for long-term storage purpose.

4. Time-sharing is a technique which enables many people, located at various
terminals, to use a particular computer system at the same time.

5. Real-time systems are used when there are rigid time requirements on the operation
of aprocessor.

6. Linux is one of popular version of UNIX operating System. It is open source as its
source code is freely available.

7. Computer security is the process of preventing and detecting unauthorized use of
our computer.
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Exercise

1. Multiple Choice Questions:

1) An operating system is a
a. Terminal
b. Software
c. Storage system
d. Processor
2) Time-sharing is a technique which
allows to use a computer system at the
same time to
a. Many users
b. One user
c. Two users
d. None
3) The process of running multiple
applications at the same time is known
as
Multi application
Multi processing
Multi programming
. Multi timing
4) The ability of software to work on
different types of hardware in same
way is known as
a. Open source
b. Portability
c. Shell
d. Security
5) The users of an operating system do not
interact with the computer directly.
a. Batch Processing System
b. Time Sharing System
c. Network Operating System
d. Distributed system
6) It enables us to access internet securely
and prevent unauthorized applications
and people from accessing our PC.
a. Anti-Virus
b. Security
c. Firewall
d. None of these

aogop

7) It hides complexity of kernel's
functions from users.
a. Shell
b. Hardware layer
c. HDD
d. Kernelitself
8) This file system provides a standard
file structure in which system files/
user files are arranged.
a. Horizontal
b. Vertical
c. Hierarchical
d. Structured
9) The time taken by the system to
respond to an input and display of
required updated information is
a. Response time
b. Access time
c. Output time
d. Total time
10) Remote access to servers is possible
from different locationsin .
a. Batch Processing System
b. Time Sharing System
c. Network Operating System
d. Distributed system
Fill in the Blanks.
1) A represents a collection of
related .
System wuse multiple
_____ processors to serve
multiple real-time applications and

multiple users.

3) is the process of preventing
and detecting use of
our computer.

4) provide access to

accounts and enable us to perform
various activities linked with
account like shopping, emailing,
online transactions etc.

5) are used when there
are time requirements on
the operation of a processor or the
flow of data.
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True/False
1) The time taken by the system to

respond to an input and display of
required updated information is
termed as the response time.

2) Anti-virus software alone is enough

to be secure from Internet Security
threats.

3) An Operating System cannot

4)

manage the communication between
user and device drivers.

Linux source code is freely available
and it is community based
development project.

5) The OS manages all kinds of

resources using schedulers.

Very short Answers type questions:

1) An interface between computer user

and computer hardware is call

2) What hides the peculiarities of

specific hardware devices from the
users.

3) A mechanism or a way to control

the access of programs, processes,
or users to the resources defined by
a computer system is called as......

4)

5)

The process of preventing and
detecting unauthorized use of our
computer is called as......

Linux provides a special interpreter
program which can be used to
execute commands of the operating
system. Name of program is.........

Short answer type Questions:

1)
2)
3)
4)

5)

6)
7)

What is an operating System?

List type of operating systems.
Explain real time operating system.
What are the functions of operating
system? Make a list.

What do you mean by computer
security?

Define Linux?

What is protection?

Long Answer Type Questions:

1)

2)
3)

Answers Key

- Software File, Information
— Many users Distributed, Central
_ Multi Computer
programming  Securitv.Unauthorized
n Portability Passwords, Online
Batch Real Time Systems,
Processing Rigid
System
— Hierarchical
— Response Time
Network
Operating
Svstem

123

Explain functions of operating
system.

Explain the architecture of Linux.
Define computer security. Give
important tips to keep yourself
secure and protect your Information
from Security threats.

What are the basic features of Linux?
Give difference between DOS and
Windows operating system.

m Multiple Choice Fill in the Blanks Very Short Answer

True Operating System
False Drivers
False Protection
True Computer Security
True Shell
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Microsoft Publisher - I Ch?ter

Objectives of this chapter:

7.1 Whatis Publisher?

7.2 Microsoft Publisher 2010
7.3 How to start publisher?
7.4 Creating a Publication
7.5 Frames

7.6 Viewing Pages Templates
7.7 Templates

7.8 Saving Your Publication

7.9 Printing Your Publication

7.1 What is Publisher?

Publisher is an application used to design and produce attractive
advertising and promotional material like pamphlets, letter heads, banners,
posters, calendars, invitations, and newsletters and so on. This advertising
and promotional material is called a publication.

Publisher enables us to produce quick publications by using wizards and
a design gallery. A template is the predefined model of publication. We can view
the publication on the monitor exactly the way it would appear when printed.
Publisher also helps us keep track of the colors used in publications to produce
high-quality color output. With the help of publisher, we can create quick web
sites at a minimum cost.

7.2 Microsoft Publisher 2010:

Publisher 2010 is a program that helps us design professional
publications such as newsletters, websites, brochures, catalogs, flyers, signs,
postcards, invitations, greeting and business cards, letterheads, envelopes,
business forms, banners, calendars, certificates, and more. Microsoft
Publisher 2010 helps us create professional-looking publications quickly and
easily. With Publisher, we can create, design, and publish professional
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marketing and communication materials for print, and for e mail. Publisher
2010 allows us to apply built-in templates, to apply our own custom templates,
and to search from a variety of templates available on Office.com. Office.com
provides a wide selection of popular Publisher templates, including
newsletters and flyers.

7.3 How to start publisher?
Follow the given steps to start Publisher:
On the start menu, point to all programs, point to Microsoft office, and then

click Micro soft office publisher 2010.

1 Windows Update -
<4 XPS Viewer
. Accessories
. Canon LBP2900
. Canon Printer Uninstaller
. CD Factfinders
. Games
Maintenance
. Microsoft Office
@ Microsoft Access 2010
[&] Microsoft Excel 2010
|1| Microsoft InfoPath Designer 2010

@] Microsoft InfoPath Filler 2010
|E| Microsoft OneNote 2010
0| Microsoft Outlock 2010
,E Microsoft PowerPoint 2010
| [B] Microsoft Publisher 2010
[5 | Microsoft SharePoint Workspace 201
(W] Microsoft Word 2010
Microsoft Office 2010 Tools -

1 Back

1. Click on the start button.

2. The search bar is shown in start menu for searching the programs and
files.
| If‘ programs and files L0 l
Fig 7.2
3. Type "Publisher" or "Pub" in search bar and press enter button.
[ published x |

Fig 7.3 Search Bar
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5 Open

Available Templates
Inctalled and Online Templates

£ Home

Recent @
_ Blank85x 11"  Blank 11 x 85 More Blank My Templates
Page Sizes

Mast Popular
Help
) Options i

il _ | E]
e i = K
eting Cards  Labels
Mare Templates
- ]
= = i
t] 3 — =5 (@) .
: S @ | . > }
Advertisements Award Banners Business Forms. Catalogs E-mail nvelopes

Certificates . Documents

Fig 7.4 Publisher opening window

7.4 Creating a Publication
We can create new Publication by following methods:

1.
2.
3.

By using Blank Layout.
By using Installed templates.
By using online templates.

7.4.1 Creating a publication using blank Layout:
Following are the steps to start with a blank publication.

1.
2.

Click the File Menu, and then click New.

Under Available Templates, click a blank publication template,
and then click Create.

Note:

We can

8.5x11

choose the desired size of blank template by clicking More

Blank Page Sizes from the New Publication screen or even we can also
customize the size as per our requirement. Here we have selected Blank

(either Landscape or Portrait).

Home  Insert  PageDesign  Mailings  Review  View

|

Available Templates
&5 Open Installed and Online Templates E

4 {2} Home

Recent

b |

ER |
Blank 8.5 x 11" | Blank 11 x 8.5" More Blank
Page Sizes

Fig 7.5
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3. Now, we can create a publication with our own specifications in
Publication. We can also add the objects to the blank Layout like text, picture,
word art, and auto shapes etc. The blank layout window is shown as below:

m Home | Insert  PageDesign  Mailings  Review  View > @
= » o ) st #4 Find -
| = = == iEE ﬂA,AJ | @ = &
bl 2, Replace
st u \
B 7 U % x As gn - 3 Select -

=E=== = Styles  Deaw Picture Table Shapes

pagetwvguron ¢ | LBt finniu o Bt B B B BB B B B BB oot oo BBl

bbbl

bl il il B

iily

anilvitlog g iglnly

&) Em 4% - + 3

Fig 7.6 Blank Publication window

4. After creating publication, save the publication by clicking on save
option in File Menu. The Save As dialog box appears. type a name for our
publication, select the folder in which we want to save it, and then click save
button. The publication is saved with a .pub extension.

5. Close the publication by clicking close button in File menu. A dialog
box appears, if we want to save the changes, then click yes button, otherwise
click no.

Before exiting Publisher, we should close all the publications, then Click Exit
in File Menu or click cross button on title bar.

7.4.2 Components of publisher window
There are three most important components that we should remember as we
work within Publisher 2010. These are:

7.4.2.1 The Quick Access Toolbar

7.4.2.2 The Ribbon

7.4.2.3 The File Window.

7.4.2.1 Quick Access Toolbar

The quick access toolbar is a customizable toolbar that contains
commands that we may want to use. We can place the quick access toolbar
above or below the ribbon. To change the location of the quick access toolbar,
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click on the arrow at the end of the toolbar and click Show below the Ribbon. We
can also add items to the quick access toolbar, simply click on any item and it
will be added to our toolbar.

DIFRRGME
Home Customize Quick Access Toolbar

— _ ; New
,j " Open
L=l
Paste " _ Bl save
Clipboard Quick Print
Page Navigation Print Preview
4 Spelling
v | Undo
v | Redo

Open Recent File

More Commands..

Show Below the Ribbon

Fig. 7.7 Customize Quick Access Toolbar

7.4.2.2 Ribbon

The ribbon is the panel at the top portion of the document it has six tabs:
Home, Insert, Page Design, Mailings, Review, and View. Each tab is divided into
groups

“ Home | Inset  PageDesign  Mailings  Review  View Format Format a 0
¥ Cut Ao gl e im smosm == ring Forwar Find *
| & Cu Calibri ANy EE EEEY & J} j G Bring Forward * # Find
—' &3 Copy L L4 Send Backward * 3¢ Replace
Paste P ae Ny AL IEIEEE =5 Styles  Draw Picture Table Shapes Wrap
« <J Format Painter BIUx XA A&7 [§S38 &3 v TedBox 5 v | Tetr [2AlignT ShRotate~ | g Select~

Clipboard [ Font ' Paragraph | Styles Objects Arrange Editing

Fig 7.8 Ribbon of Publisher

7.4.2.2.1 Tabs:

There are some useful tabs in publisher, in which so many options are
available. To view features in each tab, click the tab name. Here is the list of
groups within each tab:

° Home: Clipboard, Font, Paragraph, Styles, Objects, Arrange, Editing
° Insert: Pages, Tables, [llustrations, Building Blocks, Text, Links, Header

& Footer
[ Page Design: Template, Page Setup, Layout, Pages, Schemes, Page

Background
° Mailing: Start, Write & Insert Fields, Preview Results, Finish
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° Review: Proofing, Language
° View: Views, Layout, Show, Zoom, Window
Note:

To view additional features within each group, click the dialog box
launcher (arrow) at the bottom right corner of each group.

7.4.2.3 File Window
When we click on the File Menu, we are brought to the Info screen. It
looks like that our document is gone, but it is not. As we click on the options
in the File Menu, the screen will change accordingly.
o Save: Save the file as a 2010 file
Save As: Allows you to choose a different file type (i.e. PDF, Word)
Open: Browse to a Publisher file
Close: Closes the file but keeps Publisher running
Info: Edit Business Information, use Design Checker, and set Commercial
Print Information
Recent: List of our recently used Publisher files
New: New Publication Screen
Print: Print Options
Save & Send: Options for saving e mailing the file
Help: Microsoft Help
Options: Set default options
Exit: Closes Publisher (file and program)

=] = . -
-i- Home

=d Save

L save As

7y Open

T Close

Recent

New

Print

Save & Send
Help

2] Options

E3 Exit

Fig 7.9 File Window
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7.4.3 Working in publication:
7.4.3.1 Adding Text:
1. From the Home or Insert Tab, select Draw Text Box.
2. Place the cursor on the page where we want to draw a text box.
3. Click and drag the cursor across the page to the desired size. The
size of the text box can be changed after we have drawn it.
4. When we let go of the left click on the mouse, we are brought to
the format tab which gives us more options for the text box.
5. Type the text in text box.

m Home Insert Page Design Mailings Review View Format Format
3 B O BY 8 & 400F€ @5 BE B
e B HEEEP JE Lo L] HE @ # 35 -
Page Catalog Table Picture Clip Shapes Picture Page Calendars Borders & Advertisements ~ Draw Business WordArt Insert Date Object Hyperlink Bookmark Header Footer Page
Pages = Art *  Placeholder  Parts = E Accents ~ = Text Box Information~ = File & Time Number ~
Table llustrations Building Blocks a Links eader & Foote
o Jrwkioltio®n BB BBt B oawredsos Do ons Bt Boonsn B P8 v B30 R0 1B

Insert a text box into the
document, or add text to the
selected shape,

1 .

T et e b k)|

7.4.3.2  Editing Text: Fig. 7.10
1. Highlight the text we want to edit.
2. If we are not brought to the Text Box Tools Format Tab, then
select it.
3. Text Group Options:
a. Text Fit - Defines how the text will fit in the text box: Best
Fit, Shrink Text on Overflow, Grow Text Box to Fit, Do Not
Auto-Fit
b. Text Direction - Changes direction to horizontal or vertical
C. Hyphenation - Changes hyphenation behavior of selected
text.
4. Font Group Options: Style, Font Size, Bold, Italics, Underline,
Text Spacing, & Color
5. Alignment Group Options: Text Box Alignment, Columns,

Margins

6. Effects Group Options: Shadow, Outline, Engrave, Emboss
Home Insert Page Design Mailings Review View Format Format | & 9
13y Text Fit = P vl 4 | E HE=E3 T - Outline ASpDropCap~  ahe Stylistic Sets =
JlﬁTm Direction = e 7 =HE== J J e ] A Engrave 123 Number Style ~ (3
b~ Hyphenation B I U x x A & 4 == Coluvmm ”a’-gm C[Fnaie Shadow A Emboss | fj Ligatures -

Text B Font . Alignment Linking Effects Typography
Fig. 7.11

7.4.3.1 Changing the Text Box Style: To change the text box style follow
the steps:

1. Click on the text box.
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2. Click on the Drawing Tools Format Tab.

3. Shape Styles Group Options: Style, Shape Fill, Shape Outline,
Change Shape

4. Arrange Group Options: Wrap Text, Bring Forward or Backward,

Rotate
Home Insert Page Design Mailings Review View Format Format () 9
N\ ONOOO - X Edit Shape - Q- at @ ﬂ U Bring Forward = [E]  §]| 267°
ALLD Y 0| Eeate D D D " o P%q, B send Backward + I 53 341
_ N Shadow . 3- Wrap
e} %ls * @~ | Effects~ -’ Effects Text= I Align = SAv 3 Measurement

Insert Shapes Shape Styles 7 Shadow Effects Arrange

Fig. 7.12

7.4.3.4 Inserting Clip Art: To insert the clip Art follow the steps:
1. Click on the Insert Tab.
2. Click Clip Art. The Clip Art window appears on the right side of

the screen.
3. Type in a keyword.
4. Click Go.
5. Browse through the results.
6. When we find clipart, click on the thumbnail from the Clip Art
Window.
7. The Clip Art image will then appear on our page.
=8l
o |
Clip
Art
Fig. 7.13

7.4.3.5 Inserting a Picture: To insert a picture follow the steps:
1. Click on the Home or Insert tab.
2. Click on Picture.

3. Browse to the location of the picture we have saved on our
computer.
4. Select the picture and click Insert.
-
Picture
Fig. 7.14
i3 1

Downloaded from https:// www.studiestoday.com



Downloaded from https:// www.studiestoday.com

7.4.3.6 Inserting Shapes: To insert a shape follow the steps:

Click on the Home or Insert tab.

Click on Shapes.

Select a shape from the drop down menu.

On the page, click and drag to create the shape.

The shape appears on the page, and we are brought to the Drawing
Tools

Format tab. From this tab, we can edit the style, fill, outline, and more.

Guk W=

o

e

Stars arsd Barawers

Fig. 7.15

7.4.3.7 Text Wrapping: Text wrapping is the way our object is set on
the page in reference to the text. To do text wrapping following are the
steps:

1. Select the Object.

2. Click on the Format tab (Text Box, Drawing, or Picture Format).

3. In the Arrange group, click on Wrap Text. This will determine how

text will be arranged around the object.

Here are the Options: None, Top & Bottom, Square, Through, Tight,
More Layout Options

"] Jj Bring Forward = ]

« Send Backward ~ Ii:
Wrap | P
Text~ | I= Align - ah

None

EEE R R E
3
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7.4.3.8 Resizing Objects: Resizing enables us to resize our objects.
1. Click on the object.
2. Click and drag the handles to resize.
a.The corner handles will resize the object proportionally.
b.The handles centered on the lines of the box will stretch the
object vertically and horizontally.
The green handle allows us to rotate the object.

L
Microsoft Publisher

Fig 7.17

7.4.3.9 Moving Objects:
1. Click on the object.
2. Place our cursor over the solid line so that we see the

crosshairs.
3. Click and drag the object to the desired location.

1
Microsoft Publisher |,

Fig 7.18

7.4.3.10 Deleting Objects: We can also delete any object, if do not
require it in our publication.

1. Click on the object.

2. Press Delete button on the keyboard.

7.5 Frame-

Most publications are divided into several different areas called frames.
A frame can contain a variety of objects such as graphics, tables, or text
boxes. Frames can be resized, moved and manipulated to suit your needs.

7.5.1 Working with Frames

Each publication is composed of different frames, such as text frames,
picture frames, table frames, and shape/object frames. Click on different
areas of the publication to identify the different frames. Handles, little circles
on the corners and sides of the frame will appear. The handles help us to show
which frame we have selected. These are also used in resizing frames.

Handles - When we click on a frame, small circles appear around the
edge of the frame. These are called handles. We can click and drag on the
handles to resize our frame.
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Moving Frames:

To move a picture frame,

Click on the picture.

When our cursor turns into a four directional arrow, click and
drag the picture frame to the desired location.

To move a text frame:

Click on the text frame.

Rest our cursor near the border of the text frame. When our
cursor turns into a four directional arrow, click and drag the
text frame to the desired location.

Fig. 7.19

7.5.3 Resizing Frames:

7.5.3.1

7.5.3.1

To resize a picture frame:
1. Click on the picture.

2. Rest our cursor on a corner handle. When our cursor turns
into a diagonal line with arrows on the ends, click and drag
inwards at a diagonal to make it smaller or outwards at a
diagonal to make it larger. Using corner handles to resize

pictures allows us to keep the picture's proportions.

To resize a text frame:
1. Click on the text frame.

2. Rest your cursor on one of the handles. When your cursor turns
into a line with arrows on the ends, click and drag inwards or

outwards to resize the text area.

AN AN

Resizing Arrows
Fig. 7.20
Deleting Frames:

Right click on the frame that we would like to delete.
Select Delete Object from the list of choices.

Inserting Additional Text Frames :

Click on Text box from the Insert Tab

Click and drag over an area of the publication.
Type the text we want to appear.
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7.6 Viewing Pages in our Publication : There are three ways to view pages
in a publication:
e Click on the thumbnails of the pages in the publication from the Page
Navigation Window on the left hand side of the screen.

Page Navigation < i
)

Heading

Fig 7.21 Page navigation view

° From the View tab, we can switch from single page to two-page
spread view as well as choose other viewing options.

Home Insert Page Design Mailings Review View Format
j _|\] j J__,J [7] Boundaries [¥] Rulers [7] Graphics Manager J J (Q 48% - 3 % ™
= ' 4 <] Page Width 1 =

[¥] Guides [V] Page Navigation [ Baselines
Normal| Master | |Single | Two-Page 100% Whole Arrange Cascade Switch

Page O

Page | Spread | L Fields [V] Scratch Area Page EiSe\eded Objects All Windows *

Views Layout Show Zoom Window

Fig 7.22

° On the bottom right corner of Publisher, we can change our view as
well as zoom in and out using the slider.

[Elm 4% oU ) (3

Fig 7.23 Zoom in Zoom out slider

7.7 Template : A Template is a tool used in Publisher to help us easily create
basic publications. The template has a set of prechosen design styles that we
can use as it is or customize as we see fit.

7.7.1 Customizing the Template: Here we will learn how to customize a
Template. Choose the publication type that we would like to use. The next
screen will show us templates for the publication we have chosen.

i35
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Home  Insert  PageDesign  Mailings  Review  View (7]
(e save
. Available Templates Brocade
B save As E
&5 Open Installed and Online Templates [=] Search for templates p
cd Close € 3} Home » Quick Publications ap
Info -E Pisce yoar
Installed Templates - T
et
Recent :- s %
¥ - H ¥ S
s i = £ =
“ 1= 1= 1= 1= -
Print - =' - - s .
Save & Send Arrows Bounce Brocade Color Band Custemsize
Color scheme:
Help Brocade] Reef e
— L et Font scheme:
2 ions
g E o — _:_._ = Breve
6 et == = == e Bodoni MT Black
a=- K e EE" Franklin Gothic Boak
o -
- — = Business information:

Custom 1
Marker Madular Perforation PhotoScope -

Options
Layout:

B | Sidebar heading, picture _
atthe top

Fig 7.24 Templates

Each template is customizable. Click on a template from the center. On the
right side of the screen, we can change the template colors, fonts, and more.
Once we have found a template and customized it, click Create. After we click
create, we can edit the text boxes, images, and shapes that have been set up by
the template as needed.

7.7.1.1 Changing the Design of a Template: To change the design
template follow steps:
1. Click on the Page Design tab.
2. To change the entire template, click Change Template.

° Choose a template from the pop up window. If we
are currently working in a template and changing
to a different template, the information we have

entered will conform to the new template.

3. To change the color scheme, browse through the color
schemes available in the Schemes group.
° However the mouse over the color scheme to
preview.
° To select a color scheme, click on it.
4. To change the font scheme, click on Fonts in the
Schemes group.
° Browse through the available font schemes.
° However the mouse over the font scheme to
preview.
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° To select a font scheme, click on it.
° If we want to create our own font scheme, click

Create New Print Scheme.

“ Home  Inset | PageDesign | Mailings  Review  View Format

@Z [

Change Margins Orientation Size = Guides

Template

by lj j Align To .B\DE\EIE B Re [ | Sagebrush [ Sapphire [ Shamrock [} Sienna~ » El ﬂ _J
= V] Guides | | Spice W Summer | Sunise [ et [ Teal v —
_ Fonts  Background Master

@ ovjects ) Rename | [ Tidepool IV Topic [ Tt (W Twany OB Vineyard Pages

Template Page Setup [ Layout Pages Sthemes Page Background

7.7.1 Page Design:

Fig. 7.25

Click the tab Page Design if needed, to change templates, adjust page
margins, apply ruler guides, or apply built-in color schemes to the
chosen template.

We can use the Built-in Ruler Guide templates to help in aligning text
boxes, pictures, or other objects. To apply a Built-in Ruler Guide
template click on the command Guides in the group Layout, and then
choose a template.

To add a vertical or horizontal ruler guide repeat the above step, then
click on Add Vertical or Horizontal Ruler Guide.

To add additional guides, move the mouse pointer over the vertical or
horizontal ruler; drag the guide in the desired direction when the
pointer changes to a two headed arrow.

7.7.2 Creating a Publication with Templates:
We can create a publication in Publisher by using template.

Available Publication Types: Publisher 2010 allows us:

Note:

To apply built-in templates,

To apply our own custom templates, and

To search from a variety of templates available on Office.com.
Office.com provides a wide selection of popular Publisher templates,
including newsletters and flyers. To find and apply a template in
Publisher 2010, do the following:

1. On the File tab, click New.

2. Under Available Templates, do one of the following:

To use a template that we already have installed, click My Templates,
click the template that we want, and then click Create.

To use one of the pre-built templates installed in Publisher, under
Most Popular or More Templates, click the category that we want, click
the template that we want, and then click Create.

To find and apply a template on Office.com, under Most Popular or
More Templates, click the category that we want, click the template
that we want, and then click Download.

search

We can also search for templates on Office.com from within Publisher. In the Search
for templates box, type one or more search terms, and then click the arrow button to

jS7
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7.5.2.1 Creating publication with Installed templates:
We can create any publication easily with the help of the
installed templates available in Publisher. We can use pre
designed templates in publisher and create so many
publications like Brochures, Business Cards, Calendars,
Greeting Cards, Labels, Newsletters, Postcards,
Advertisements, Award Certificates, Banners, Business
Forms, Catalogs, E-mail, Envelops, Flyers, Gift certificates,
Invitation cards, Letterhead, menus, resumes and so many

uick publications
q p .
g Desig g (2]
S
Available Templates
L save s ¥
&5 Open Installed Templates |~ Search for templates »
[’ Close 2} Home
Info
Most Popul
Recent
_ 4 —_— y = i
Print o T J
e ochure d: g Card: Labels [ d:
Help
More Templates
2] Options
B3 &
a )
= =1 a = -
& _| @ | s =] _.‘l} ¥ 1
d ol I
Advertisements Award Banners Business Forms Catalogs E-mail Envelopes Flyers Gift Certificates  Import Word  Invitation Cards
Certificaty Documents
.
v — —
B \§ = ol
Letterhead M Paper Folding Programs uick Resumes Sigr With Mare
Projects Publications Compliments  Categories
Cards
Fig. 7.26

7.7.2.2 Creating publication with online templates:
We can create any publication easily with the help of the internet,
because we have also a option to create publication using online
templates. For online templates, internet facility is available in
our system.

Available Templates

Online Templates |Z|

[Installed and Online Templates
{Online Templates
|Installed Templates

Fig. 7.27

To find and apply a template on online Templates, click the
category that we want, click the template that we want, and then
click Download, and then apply that template.
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7.8 Saving Your Publication: There are two basic ways to save our
publication.
First one is to Point and click on the save icon on our toolbar.

7.9

OR

Follow these steps:

1.
2.

3.
4.

Click on the File Menu and Save As.

When the Save As Dialogue Box appears Click Browse and find
the location on computer where we want the file

saved.

Type the name of our publication in the File Name field.

Click on the Save button.

Printing Your Publication: There are two basic ways to print your
publication.

First one is to click on the print icon on toolbar. This will print

one copy of our publication with the default print options.

=

ok

o

OR
Click on the File Menu and click Print.
When the print window appears, select the desired
number of copies.
Choose any other Print Settings:

° All Pages, Selection, Current Page, or Custom Range
° Manually enter page numbers we want to print
° How many pages print per sheet of paper
° Paper Size
° 1-sided or 2-sided printing
Click Print.

Publisher is an application used to design and produce attractive
advertising and promotional material

A template is the predefined model of publication

Publisher enables us to produce quick publications by using wizards
and a design gallery

To open the Microsoft publisher by keyboard, Type “Publisher” in
search bar and press enter button

We can also add the objects to the blank Layout like text, picture,
word art, and auto shapes etc.

After creating publication, save the publication by clicking on save
option in File Tab

Close the publication by clicking close button in File menu
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11.
1124
13.

14.
15.
16.

17.
18.
19.
20.
21.

2o
23.

24.

250,

Before exiting Publisher, we should close all the publications
We can place the quick access toolbar above or below the ribbon

. We can also add items to the quick access toolbar, simply click on any

item

The ribbon is the panel at the top portion of the document it has six tabs
Each tab is divided into groups

To view additional features within each group, click the dialog box
launcher (arrow) at the bottom right corner of each group.

Click and drag the handles to resize

The corner handles will resize the object proportionally

The handles centered on the lines of the box will stretch the object
vertically and horizontally

The green handle allows you to rotate the object

Place our cursor over the solid line so that we see the crosshairs.

Click and drag the object to the desired location

Most publications are divided into several different areas called frames

When we click on a frame, small circles appear around the edge of the
frame. These are called handles

We can click and drag on the handles to resize our frame.

A Template is a tool used in Publisher to help us easily create basic
publications

In arrange group, the text will be arranged around the object by using
Wrap Text

If we want to delete any objects which are not required in publication,
click on the object and press Delete button from the keyboard.

Exe rcise 4. To open the Microsoft publisher by

keyboard, what we need to type in

. Multiple Choice Questions: search bar?

1. Choose an application used to design
and produce attractive advertising and

a) WordPad b) Notepad
c) Access d) Publisher

promotional material. 5. Which color handle allows you to

a) Document b) Spreadsheet

rotate the object?

c) Publication d) Presentation a) Red b) Green

. Publisher enables us to produce quick

c) Blue d) Black

publications by using . 6. Each tab is divided into

a) Manual b) Wizards a) Groups b) Blocks
c) Customize d) All of these c) Menus d) Parts

. What is the predefined model of 7. We can place the quick access toolbar
publication? above or below the

a) Templates b) Clip Arts a) Ruler b) Status Bar

c) Objects d) Styles

c) Ribbon d) None of these
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The ribbon is the panel at the top portion

of the document it has number
of tabs.

a) Eight b)Six

c) Five d) Four

After creating publication, save the

publication by clicking on save option
in

a) File
c) Insert

b) Home
d) View

10. Close the publication by clicking

button in File menu.
a) Open b) New
c) Print d) Close

Fill in the Blanks:

We can also add the objects to the
blank Layout like , ,
word art, and auto shapes etc.
The handles centered on the lines of
the box will stretch the object
and

We can and on the
handles to resize our frame.

To view additional features within
each group, click the dialog box
launcher (arrow) at the Dbottom

of each

When we click on a , small
circles appear around the edge of the

frame. These are called
True or False:

A Template is a tool used in
Publisher to help us easily create
basic publication.

Most publications are divided into
several different areas called frames.
The corner handles will resize the
object proportionally.

Before exiting Publisher, we should
not close all the publications.

We cannot add items to the quick
access toolbar by click on any item.

4.

6.

141

Very Short Answer type Questions:

1. Extension used to save a
publication is?

2. To move objects which cursor is
used?

3. Online Templates are available
in?

4. List of our recently used
Publisher files are in?

5. The text is arranged around the
object by using which option?

Short Answer type Questions:

1. What is Publisher?

2. Write three differences between
Word and Publisher.

3. How to start publisher by using
keyboard?

4. Write the steps for Moving
Objects in publisher.

5. Define Templates?

6. What is Frame?

Long Answer type Questions:

1. How to create a publication
using blank Layout in
publisher?

2. Write the components of
publisher window.

3. How to add text using text box
and write the steps for editing
text in publisher?

4. Write the steps for Changing
the Design of Template in
publisher?

5. How to Print your Publication?
Write their steps.
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Answers Key

- Publication Text and Picture
_ Wizards Vert'tcally and True crosshairs
horizontallv
— Templates Click and drag True Office.com
n Publisher Right corner, group False Recent
_ Green Frame, handles False Wrap Text
— Groups - - -
Ribbon - — -
— Six - - =
B s - - i
Close - - -
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Chapter  NTicrosoft Publisher - 11

8

Objectives of this chapter:

8.1 Advertisements

8.2 Business Cards

8.3 Greeting Cards / Invitation Cards / Compliment Cards
8.4 Award Certificates
8.5 Envelops

8.6 Labels

8.7 Letterhead

8.8 Calendars

8.9 Resumes

8.10 Menus

8.11 Signs

8.12 Paper folding projects

8.1 Advertisements:

Advertising means how a company encourages people to buy their
products, services or ideas. An advertisement or "ad" for short is anything that
draws good attention towards these things. It is usually designed by an
advertising agency. Ads appear on television, as well as radio, newspapers,
magazines etc. Advertising is an audio or visual form of marketing
communication that employs an openly sponsored, non-personal message to
promote or sell a product, service or idea. Sponsors of advertising are often
businesses who wish to promote their products or services.

Advertising is communicated through various mass media, including old
media such as newspapers, magazines, Television, Radio, outdoor advertising
or direct mail; or new media such as search results, blogs, websites or text
messages. The actual presentation of the message in a media is referred to as
an advertisement or "ad". Non-commercial advertisers include political
parties, interest groups, religious organizations and governmental agencies.
The following figure shows an example of an advertisement.

143

Downloaded from https:// www.studiestoday.com



Downloaded from https:// www.studiestoday.com

Hury Summer
good news camp
Summer camp is
e Painting being organized in
* Dance these summer
® Swimming holidays for all age

e Skating groups

Flll’l 4 all 2 hrs daily morning or

evening as per your

o choice
Near mini e
market fundooz
Tel: 555 555 5555
Fig 8.1

MS - Publisher offers templates and other tools to help us create a variety of
publications, including brochures, newsletters, business cards, and menus.
Various print media used for advertisement are:

8.1.1 Brochures

8.1.2 News letters

8.1.3 Banners

8.1.4 Catalogs

8.1.5 Flyers

8.1.1 Brochure:

A brochure is an informative paper document often used for advertising
that can be folded into a template, pamphlet or leaflet. Brochures are
promotional documents, primarily used to introduce a company, organization,
products or services to the public. Brochures are distributed inside
newspapers, handed out personally or placed in brochure racks in high traffic
locations. They may be considered as grey literature.
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Now day's brochures are also available in electronic format and are called e-
brochures. They have the added benefit of having unlimited distribution and
cost savings when compared to traditional
paper brochures.

The most common types of single-sheet
brochures are the bi-fold (a single sheet
printed on both sides and folded into halves)
and the tri-fold (the same, but folded into
thirds). A bi-fold brochure results in four
panels (two panels on each side), while a tri-

fold results in six panels (three panels on
each side). | : ’ .

Othe.r brochure fold ar.rangements are 1: letter/C tri-fold, 2: gate tri-fold, 3: &7
also possible: the accordion or "z-fold" rollidouble gate fold, 4: accordion z-
method, the "c-fold" method, etc. Larger g, 5: double (paraliel) fold, 6: double
sheets, such as those with detailed maps or right-angle / French fold
expansive photo spreads, are folded into i
four, five, or six panels. Fig 8.2

Booklet brochures are made of multiple sheets most often saddle
stitched stapled on the creased edge, or perfect bound like a paperback book,
and resultin eight or more panels.
8.1.1.1 Creating Brochures using MS-Publisher:

Steps to create Brochures in Publisher:
1. Click on File Tab, then New, and then Brochures.
There are many Templates related with brochures, which are already available
in Install Templates. Select any one according to our choice. Now, we can see at
right side of window, many options are available for customizing this selected
brochure.

Available Templates. Modular

Installed Templates - for bermplein I
X +Home » Brochures _— =
Installed Templates Sl el | l

Recent Informational NE

rrrrrr sounce srocade Color Band Marker Modular perforation (defout template fonks)

2 Options Business information:
Modular Creste new...
Options
- ¥ s s 0 L« Pagesize:
x :
DDDDDDDDDD 4-panel
Include customer address

Fig 8.3
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Now, customize our brochure with the help of color scheme, font scheme, page
size options and forms.

Color scheme:
(default template colors) B

(default template colors) .
Alpine
Apex
Aqua
Aspect
Berry
Black & Gray
Black & White
Bluebird
Brown
Burgundy
Cavem
Chery
Citrus
Civic

m

=
||
m

Color Scheme

After changing of color, fonts, size and forms of brochure, click on Create

option.

4.

-~
Organization
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Font scheme: L
(default template fonts) H
(default template fonts)
Apex
Lucida Sans
Book Antiqua

Archival
Georgia Bold
Georgia

Agpect
Verdana
Verdana

Basis
Arial Bold 5
Arial

Binary
Verdana
Georgia

Breve

Fig
Font Scheme

)

(default template fonts) v
Page sae None
‘ M I Order form
4-panel
I ’ : |Responsefmm
g‘piﬂd : | Sign-up form
4'pand - I None v
8.4
Page Size Form

Create

Fig 8.5
We will see the brochure as shown in figure below.

Bumnes Tagina a Morrs

® Product/Service
Information

Tel: 555555 5555

Back Panel Heading

This is a good place to briefly,
but effecrively, summarize your
products or services. Sales copy
is typically ot included here.

Lorem ipsum dolor sit amet,
‘comsecteruer adipiscing elit, sed
diem nonummy wibk euismod
tincidunt ut lacreet dolor et ac-
cumsan.

Lorem ipsum dolor sitamet,
‘comsectetuer adipiscing elit, sed
diem nomummy mibh ewismod
tincidunt ut lacreet dolore
magna aliguam erat velurpar.
Ut wisis enim ad minim ve-
niam, consequat, vel illum
dolore eu feugiat nulla facilisis
at vero eros et Gcoumsan et iu-
510 odio dignissim qui biandir
pragsent lup tatum

Lorem ipsum dolor sitamet,
comsecreruer adipiscing elit, sed
diem nonummy mibh exismod
nincidunt ut lacreet dolore
magna aliguam erat volutpat.
LY wisis enim ad minim ve-

Fig 8.6
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miam, consequat, vel illum
dolore eu feugiat mulla facilisis
atvero eros et.

Lorem ips um dolor sitamet,
comsectetuer adipiscing elit, sed
diem nomummy nibh evismod
tincidunt ut lacreet dolore
‘magna aliguam erat volutpat.
Ut wisis erim ad minim ve-
miam, conse-
quat, vel il-
lum dolore

o feugiar
nudla facilisis
atvero eros
eraccumsan
et iuste odio
digmissim qui
biandit prae-
sent lupta-
tum. Lorem
iprum dolor
Sif amet, con-
sectetuer
adipiscing elit, sed diem non-
ummy nibh ewismod tincidunr
ut lacreet dolore magna
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Now we can edit our brochure's details and save it as publication.
8.1.2 Newsletters:

A newsletter is a printed report containing news or information of the
activities of a business or an organization that is sent by mail regularly to all its
members, customers, employees or people, who are interested in. Newsletters
generally contain one main topic of interest to its recipients. A newsletter may
be considered grey literature.

E-newsletters delivered electronically via e-mail and can be viewed as
spamming if sent unsolicited.
8.1.2.1 Creating Newsletters using MS-Publisher:

Steps to create Newsletters in Publisher:

1. Click on File Tab, then New, and then Newsletters.

Available Templates Banded

Installed Templates

4 Home » Newsletters

) optians Ry — - p— Fant schemer
3 et = 52/' L'_] - ks g T
Blocks ~ Borders ubbles Capsules u:::;
= e = —— .,
- ‘ : Include c r: res:
f ——— 5
Fig 8.7
2. Select newsletter design from available Templates as per requirement

and click on Create.

Lovls i B lar Bt B vaton Bt B oban B Lo Bt B o B o By B o

Newsletler Title

Lead Story Headline

oy or
-
—
. —
=
. w—
-
=
*

—  Secondary Story Headline

Fig 8.8
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Now we can edit our newsletter's details and save it as a publication.
8.1.3 Banners:

A long strip of cloth bearing a slogan or design carried in a
demonstration, procession or hung in a public place. Depending on how it is
used, a banner can be a flag or other piece of cloth bearing a symbol, logo,
slogan or other marketing message.

An online banner is either a graphic image that announces the name or
identity of a site. An online banner is a typically rectangular advertisement
placed on a Web site's main content and is linked to the advertiser's own Web
site.
8.1.3.1 Creating Banners using MS-Publisher:

Steps to create Newsletters in Publisher:

1. Click on File Tab, then New, and then Banners.

File Haome Insert Page Design Mailings Review View

= save
Bl sove s All Congratulations Congratulations
5 Open Installed and Online Templates ﬂ Search for template r] -
Ld Close € 2} Home » Banners » All Congratulations
Customize
Info Installed Templates Color scheme:
Aspect mE -
Recent Font scheme:
Breve
| I [ (N [i p———— i] [ Bedoni MT Blads -
Franklin Gothic Book
L ‘CC"E'“”"’“"_’_‘_—‘_| Business information:
Save & Send Baby Champions Congratulations Graduation Custom 1 v
Congratulations Options
Help Page size:
15ftx85in -
2] Options Border:
B Exit [ [ Y == v =1 Border -
Graphic:
5l Both -
Promotion Retirement The Greatest To the Best
Create
Fig 8.9
2. Select newsletter design from Available Templates as per requirement,

here we have three categories: Congratulations, Event and Get well.
3. Click on Create button.
Banner will be shown as in figure below:

E‘é!-"1?.55fé!!é!!éifé?-L’S!5!-‘1!&!!é!f-‘Sf.‘S!ﬁ!ﬂ!é!!é!ﬁiféi#é!féYA!é!!é!fé‘.lfé‘.ifé!iféﬁ%ﬁﬁl!é!ﬁiféiféiféﬁféﬁﬁifé fi!féi#éiiéﬂéﬁfé&fé!fé!fé'.ifé!!ﬁ#ﬁﬁifé!ﬁ!fé!féﬁféﬁfﬁfﬁﬁg

§ . , i
g Congratulations! ;’;
g‘é!é!fé!!&!fé!fé!féS!éS!,-'Stéifé!fé‘.iféSfé!!53!;ﬁ!é!feiﬁife’.ité.!!.-‘S!él!&!ﬁif:iféﬁiféité‘;iﬁl!éiﬁifeifé‘iféﬁik’ﬁféﬁfé!faféiféﬂ.%ﬁfé!f&!ﬁ!fé!féik?kﬁfé!ﬁ!ﬁ!fé!féﬁfé?féﬁir’:}%
Fig 8.10
Now we can edit the banner and save it.
8.1.4 Catalogs:

A catalogue is a list of things. A catalog can be a list of anything, arranged in
some order, and when we list things, we catalogue them. A complete list of things;
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usually arranged systematically. A catalog may also represent a collection of
products that we group into categories.

8.1.4.1 Creating Catalog using MS-Publisher:
Steps to create Catalog in Publisher are same as we create other
publications described above.

-
-
1 E
—— — —] ) Catalog Subtitle
2 3 ]
Mt ' ]
a 5 =
—— — =
T =" ooEer F Sidebar Heading
= 6 7 = - Brefl- kighlight wour product or service here
. Brefl kighlight vour product or service here
T: Briefly highlight vour product or service here
s +
Fig 8.11
8.1.5 Flyers:

A flyer is a form of paper advertisement used for wide distribution,
posted or distributed in a public place, handed out to individuals or sent
through the mail. Flyers range from inexpensive photocopied leaflets to
expensive, glossy, full-color circulars. Flyers may be used by anyone including
individuals, businesses, not-for -profit organizations or governments for:

a) Advertising an event such as a live concert, nightclub
appearance, festival, or a rally

b) Promotion of a business, discount store or a service business
such as arestaurant or a gym.
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c) Persuading people about a social, religious, or political
message, campaign activities on behalf of a political party or
candidate during an election.

d) Recruiting members for organizations or companies.

In Installed Templates, various flyers for different events and
marketing are available in MS publisher. We can choose the flyers as per our
requirement. After that we can edit the basic information to be displayed on
it and save it as a publication. Example of a flyer is shown in the figure
below:

;:-::.\'m ar Mams

Produet/Service

Information

Tel: 555 555 5555
Bustaces Nmme Mame of ltem or Service -ﬂ
e 00% OFF ~{J
ranr -8 £
Fig 8.12

8.2 Business Cards: A small card printed with one's name, occupation,
business address, etc. is called a business card.

Business cards are cards bearing business information about a company
or individual. They are shared during formal introductions. A business card
typically includes the giver's name, company or business affiliation (usually
with a logo) and contact information such as street addresses, telephone
number (s), fax number, e-mail addresses and website. In these days, business
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cards may also include social media addresses such as Facebook and Twitter.
Traditionally many cards were simple black text on white stock; today a
professional business card will sometimes include one or more visual design.
8.2.1 Creating Business Card in Publisher:

1.

Click on File Tab, then New, and then Business Card.

There are so many Templates are available in Install Templates
related with Business Card. Select any one according to our choice.
On right side of window, we can customize this selected Business
Card with the help of color scheme, font scheme, business
information, page size options and logo.

After changing of color, fonts scheme, business information and
page size, click on Create button.

eview  View

Help

) Options

Available Templates Batik
Installed Templates [« Search for templates P

& €} Home » Business Cards

" Customize
Color scheme:
(default template colors)
Font scheme:

(default template fonts)

Business information:
Create new...

3 et Options
Page size:
|
| = |
~ More Installed Templates (43) ¥/Include logo
M= = [T | [T e | e —-
E L B E|LEPE||E=B- E-E B
o (G
A it Be A ry B Amb: d A Ax B. Batik
Fig 8.13
3. Now, we will see the Business Card as shown as below figure. The

Business Card is designed successfully. Now we can change Business Name or
Individual name also, Address, Contacts etc.

BUSINESS NAME

Name Primary Business Address

Address Line 2

AITLE Address Line 3
Address Line 4
N . . Phone: 555-555-5555
Organization Fax: 555-555-5555
[

E-mail: someone@example.com -
Fig 8.14

51

Downloaded from https:// www.studiestoday.com



Downloaded from https:// www.studiestoday.com

8.3 Greeting Card/ Invitation card/ compliment card:

A greeting card/ Invitation card/ compliment card is a piece of card or
high quality paper expressing friendship or any other sentiment. Although
these cards are usually given on special occasions such as Birthdays,
Anniversary, Christmas, Diwali or other holidays, they are also sent to convey
thanks or express other feelings. These cards are usually packaged with an
envelope, come in a variety of styles. There are both mass-produced as well as
handmade versions that are distributed by hundreds of companies.

pagetmigaton ¢ | PP B B R B B B B B
a

amtegetn ¢ Lot B B B B B B B B B B B B

Happy B

')rmﬁ[(’””'f

CELEBRATE WITH US!

SATURDAY, DECEMBER 4TH
NOON TO 4:00

Fig 8.15 Fig 8.16

Greeting Card Invitation Cards
Page 4 _ Lisctosabonin |‘| U] B o et | i et S A T |]| | TP ST TP por I'. Lol
|

With Compliments

Fig 8.17 Compliment Cards

These can also be designed with the help of MS Publisher.
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8.2 Award Certificates:

An award is something given to a person, a group of people, or an
organization in recognition of their excellence in a certain field. An award may
be accompanied by trophy, title, certificate, medal, badge, pin, or ribbon.

Certification refers to the confirmation of certain characteristics of an
object, person, or organization. This confirmation is often, but not always,
provided by some form of external review, education, assessment, or audit.

Certificates of achievement, merit, and honor can be powerful tools when
used at the right time and presented in the right way. Receiving an award
certificate gives a person the warm glow of knowing someone took the time to
acknowledge them. And being the person who motivates others can be
rewarding, too.

Award certificates may include: Community Service Award, Great Job,
Good Behavior or Course Completion. MS Publisher provides many templates
for creating Award Certificates. Figure shown below is an example of certificate
of Appreciation created using M'S publisher.

Fig 8.18

Various Templates in MS publisher as shown in figure below can be
used to create this certificate.
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H Inset  Page Design Mailings Review  View [7)
A
Available Templates Appreciation 7
5 op Installed Templates = Search for templates »r

€ 3 Home » Award Certificates

Installed Templates

= "o =&

Customize
3 Color scheme:
Achievement Appreciation 1 Appreciation 2 Appreciation 3
Aspect -a -
Font scheme:
Hel
P Breve
2] Options Pl —— Bedoni MT Black -
Aertatien Franklin Gothic Book
(X ) —3 Business information:
=
Appreciation 4 Apprecia tion 5 Apprecial tion 6 Apprediation 7 B
L
Create
! - E 5 (u m
Appreciation 8 Apprecial tion 9 Appreciation 10 Best of Show

Fig 8.19

After selecting the required certificate design, edit the color scheme and click
on Create button. Now we can edit the certificate information and save it as a
publication.

8.5 Envelops:

An envelope is a common packaging item, usually made of thin flat
material. It is a flat paper container with a sealable flap designed to enclose a
flat object, such as a letter, card or document. Traditional envelopes are made
from sheets of paper. They are most commonly used for enclosing and sending
mail (letters) through a prepaid-postage postal system.

Envelop with mailer's address and recipient's address may look like the
figure shown below.

5432 Any Street West, Townsville, State 54321

Address line 01
Address line 02
Address line 03
Address line 04

consulting sales staffing support WWw.companyname.com

Fig 8.20
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We can create envelop with Various Templates in MS publisher. After selecting
the required envelop design, edit the color scheme and click on Create button.
Now we can edit the envelop information and save it as a publication.

8.6 Labels:

Alabel is a piece of paper, polymer, cloth, metal, or other material affixed
to a container or product. Information printed directly on a container or item
can also be considered labeling. Labels have many uses, including providing
information on a product's origin, manufacturer (e.g., brand name), use, shelf-
life and disposal etc. Many hazardous products such as poisons or flammable
liquids must have a warning label.

Labels can be used for:

° Products: Permanent product labels need to remain secure
throughout the life of the product. For example, a food label must
be secure until the food has been used.

° Packaging: Packaging may have labeling attached to or integral
with the package. These may carry pricing, barcodes, UPC
(Universal Product Code) identification, usage guidance,
addresses, advertising, recipes, and so on.

o Assets: In industrial or military environments, asset labeling is
used to clearly identify assets for maintenance and operational
purposes. Such labels are frequently made of engraved Trifoliate or
a similar material.

o Textiles: Garments normally carry separate care/treatment
labels which typically indicate how the item should be washed for
e.g. machine washed or dry cleaned. Textile labels may be woven
into the garment or attached, and may be heat resistant, colorfast,
washable. Printed labels are an alternative to woven labels.

o Mailing : Mailing labels identify the addressee, the sender and any
other information which may be useful in transit.

s Security labels : They are used for authentication, theft reduction,
and protection against counterfeit and are commonly used on ID
cards, credit cards, packaging, and products from CDs to
electronics to clothing.

Labels may be used for any combination of identification, information,
and warning, instructions for use, environmental advice or advertising. They
may be stickers, permanent or temporary labels or printed packaging.

8.6.1 Creating Labels in Publisher:

Here we are designing a label for a CD/DVD with the help of MS
publisher. Follow the steps written below:

1. Click on File Tab, then New, and then Labels.

2. In category Media, select All Media. Here select the CD/DVD

Labels. Select required template, edit the color scheme and click
on Create button.
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Home  Insert  PageDesign  Mailings  Review  View @l
e save
Bl smen: All Media Mosaic (Avery 8931)
& open Installed Templates [~] Search for templ P
[ Close <« 3} Home » Labels » All Media
Info p e ¢
b Z [t "~
= ED e | |
2 Mz, =
. —- & —
Print Jazz (Avery 8931)  Jazz (Avery 8931) Mosaic (Avery Mosaic (Avery Mation (Avery Mation (Avery Romance (Avery
8931) 8931) 8931) 8931) 8931)
Save & Send Customize
- . - Color scheme:
Help hd
:] Options et Font scheme:
2 B . R
Romance [Ave;'y Tiles (Avery 8931) T\.Ies (Avery 8931) Business information:
8931 Create new..
Video j
—— Create  [Create]
pre— L___I= =
-
Video Face (Avery Video Spine (Avery
51994) 51998) I
.
Fig 8.21
3. Here we can edit the information related CD/DVD which is to be
shown on the label
“ Hom Inset  PageDesign  Mailings  Review  View - @
= ¥ : 1 o = Y E B # Find ~
4 ~ B A . o 11
r cois vy EEEP B Biows 4
fac hs Bu 2, Replac
e 8 U x X A A , Stes | Draw Piure Table Shapes | Wiop (o " [y seect
Clipboard Fant Styles Objects Arrange Editing
PageMavgaton < o ertrud] Bt bbbt : [ Y ~
-
3 CcCD/DVD TITLE
|| |*3
-
1 =
EE
|
¥ | PERFORMER’S
/ NAME
EF
=
= -
3 . Organization :
44 [ »
Pagelofl | Li 604,358 in. | Bm ue% = SVESNONE ]

Fig 8.22

4. Save the label as a publication for future use. We can print these
labels as per our requirement.
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8.7 Letterhead:

It is stationery with a printed heading. The heading usually consists of a
name and an address, a logo or corporate design, and sometimes a background
pattern. The term "letterhead" is often used to refer to the whole sheet imprinted
with such a heading. Many companies and individuals prefer to create a
letterhead template in a word processor or other software application. This
generally includes the same information as pre-printed stationery, but at lower
cost. Letterhead can then be printed on stationery or plain paper as needed or
sent electronically.

8.7.1 Creating Letterhead in Publisher:

Here we are creating a Letterhead for an organization using MS publisher.
Follow the steps written below:
1. Click on File Tab, then New, and then Letterhead.
There are many Templates are available in Install Templates related with
Letterhead. Select any one according to our choice. On right side of window, we
can customize color scheme, font scheme, business information and logo.

Home  Insert  Page Design Mailings Review  View

| save

B save as Available Templates PhotoScope

5 Open Installed and Online Templates El Search for templates L

ET—
.
' Close € 2} Home » Letterhead E

Info Installed Templates

Recent = - == = .-

b
i
_ i
b]
d
i

Print

Save & Send Arrows Bounce Brocade Color Band Cimbonnion

Color scheme:
Help Marine | |

= Font scheme:
[

:] Opti en

3 Options Breve

B Exit Bedeni MT Black
Franklin Gothie Book

E - - Business information:

. Custom 1 -
Marker Modular Perforation PhotoScope

Options
V! Include loge

4

Create

Simple Divider Tabs

Fig 8.23

1. After changing of color, fonts, size and other information, click on
Create option. The letterhead will be shown.

2. Now edit the necessary information as we can see in the figure
below and save the changes.
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Primary Business Address
Address Line 2
Address Line 3
Address Line 4

Phone: 555-555-5555
Fax: 555-555-5555
E-mail: someone@example.com

Fig 8.24

8.8 Calendar:

A calendar is a system of organizing days for social, religious, commercial or
administrative purposes. This is done by giving names to periods of time, typically
days, weeks, months and years. Calendars are also used to help people manage
their personal schedules, time and activities.

Calendars are also used as part of a complete timekeeping system: date
and time of day together to specify a moment in time.

8.8.1 Creating Calendars in MS Publisher:

To create Calendar in Publisher, follow these steps:

1. Click on File Tab, then New, and then Calendars.

From the Templates related to Calendars, available in install Templates,
select any one according to our choice. Now, we can see at right side of window,
there are many options available for customizing this selected Calendars.

Home  Insert  PageDesign  Maiings  Review  View 2]
I save
Available Templates Art Left =
[ savess v
(&5 Open Installed Templates [=] Search for templates p
[ Close € 3} Home *» Calendars
Info Installed Templates
Recent Full Page
= = e e |
Print - | s e | E=ErE = Customi
E _ = Sy | l EEER | |8 =
- _7 ey o = = - | | = Color scheme:
Save & Send (default template colors) -
Accent Box Accessory Bar Arcs Art Left Art Right Axis Bars Font scheme:
Help
B (default template fonts) -
B e = | | = = = e Business information:
- = = K Creste new... -
f e | =
~ ] ol = N Optlons
Page size:
Blends Blocks Borders Broadway Bubbles Capsules Cascade j
Landscape -
Timeframe:
e = e - ) One menth per page
7 r | s @ One year per page
BT E o o B
- frend e T ) J
Checkers Echo Eclipse Edge Floating Oval Create
o Create

Fig 8.25

158

Downloaded from https:// www.studiestoday.com



Downloaded from https:// www.studiestoday.com

2. Now, customize our calendar with the help of color scheme, font scheme,
Business information, page size options and specially Timeframe (One
month per page or One year per page).

3. After customizing Calendars, click on Create option.

4. Now, we will see the Calendar as shown in figure below. If we want, we
can edit the picture also and can save this calender in publisher.

Fig 8.26
8.9 Resumes:

A resume provides a summary of our education, work history,
credentials, and other accomplishments and skills. There are also optional
sections, including a resume objective and career summary statement.
Resumes are the most common document requested of applicants in job
applications. A resume should be as concise as possible. Typically, a resume is
one page long, although sometimes it can be as long as two pages. Often
resumes include bulleted lists to keep information concise.

8.9.1 Creating Resumes in MS Publisher:
To create Resumes in Publisher, follow these steps:

1. Click on File Tab, then New, and then Resumes.
From the Templates related to Resumes, available in install
Templates, select any one according to our choice. After customizing
the selected Resume click on Create button.
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i save
Available Templates

Save As t
2 Open Installed and Online Templates [=]
[ Close € B Home » Resumes
Info Installed Templates
Recent Entry Level
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Print. =
Save & Send [ = | { ] =

Accessory Bar Right Angles Straight Line
Help
1 Options

Chronological

(X

2.

—

Accessory Bar Right Angles

Straight Line

Fig 8.27

Search for templates

https:// www.studiestoday.com

Right Angles

! wﬂT

Customize

=| Color scheme:

Opulent [ ]~

Font scheme:
Archival
Georgia Bold -
Georgia
Business information:
Create new... -

]

Create

Now edit the necessary information in our resume and save the
changes. The resume will be as figure shown below.

000 = 9000, T, Compamy
Je's Respensilney

Educstion
5000 w 5000, Degrez. Iraswssen
SO0 ® 000, Degres. Irosteven

Fig 8.28
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8.9.2 Curriculum vitae(CV):

Like resume, a curriculum vitaE (CV) provides a summary of one's
experience and skills. Typically, CVs are longer than resumes - at least two or
three pages. CVs include information on one's academic background,
including teaching experience, degrees, research, awards, publications,
presentations, and other achievements. CVs are thus much longer than
resumes, and include more information, particularly related to academic
background.

We can create CVs with the help of MS Publisher in same way we have
created Resumes above.

8.10 Menus:

In a restaurant, there is a menu of food and beverage offerings. A menu
may be a list from which guests use to choose options available. Basically Menu
is the main way to give or take order from guest. Guest may order properly to
see the menu and be aware about our food and price. MS Publisher provides
many templates for creating a Menu. Below figure shows the example Menu
designed in M'S Publisher.

menu
A brief description of the dish.
A brief description of the dish.
A brief description of the dish.
A brief description of the dish.

A brief description of the gl

[ a8 th FETT

[ALEERTERREERRERRTERREETERTTE ' E T o
Fig 8.29
8.11 Signs:

A sign is a piece of paper, clothe, wood or any other material which is
painted with pictures or words and which gives some information about a
particular place, product, or event. MS Publisher provides us with many of
these signs as shown in figure below. We can create any of these sign using
publisher.
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Home Insert Page Design Mailings Review View

d Save

B s Available Templates No Smoking
ave As
2 Open Installed and Online Templates 3 Search for templates R
=
L Close € 2} Home » Signs

Info Inventory Keep Off The Keep Out Kid's Room -
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Recent

- . Neo
_ IA‘ﬂnlﬂ‘l‘: NO Parking

- for Salc; 1

Print Your Test Here '&. =| Customize
d L J m | Color scheme:
e s . (T -
Lemonade for Sale No Loitering No Parking No Smoking

Hel Font scheme:
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d Breve
:] Options Bodoni MT Black L
1 Franklin Gothic Book

B exit Open House

i of l’ri“ﬂte Business information:
. 0':_" Custom 1 -
o |

Open Open House Out of Order Private Property ]

Create

Restrooms r— —

Restrooms Return Time Special Offer Turn Off The Lights

Fig 8.30

8.12 Paper Folding Projects:

The paper folding templates include patterns for paper airplanes and
origami projects alike. They include pages (that may require trimming) with "fold-
lines" and others with instructions to create our paper masterpieces. We can
enjoy these Paper Folding Projects in our leisure time and can make some creative
things.

Microsoft Publisher offers templates for kids. These templates consist of
different paper folding projects like airplanes, boats, cups, and more.

8.12.1 Paper Folding Projects in Publisher:
Follow the steps written below:
1. Click on File Tab, then New, and then Paper Folding Project under
more Templates.
There are many paper folding projects in the middle panel.
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File Home Insert Page Design Mailings Review View
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Fig 8.31

Now we need to select the project we want to create. Once we select our
project, we can edit some of the options in the right panel. We can select
the color scheme we want to use and font scheme for typing instructions
on the project. After that click the Create button to open the project in a
new window.

Now edit the paper folding project, we can insert clipart and text. To insert
text, click on a text field and type what we want in the text field.

If we want to insert clipart, go to the top of our window and click Insert >
Picture > Clipart. The clipart box will open in the panel on the left. Click
the Go button and the clipart will load. Double click the clipart that we
want to insert and it will be inserted into the center of our project. Drag
clipart to where we want it.

After finishing paper folding project, we can save it to our computer and
then print it.
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1. Advertising means how a company encourages people to buy their
products, services or ideas.
2. MS - Publisher offers templates and other tools to help us create a

variety of publications, including brochures, newsletters, business
cards, and menus.

3 Brochures are promotional documents, primarily used to introduce
a company, organization, products or services to the public.

4. Now day's brochures are also available in electronic format and are
called e-brochures

5. A newsletter is a printed report containing news or information of
the activities of a business or an organization.

6. A long strip of cloth bearing a slogan or design carried in a

demonstration, procession or hung in a public place.

7. A catalogue is a list of things. A catalog can be a list of anything,
arranged in some order, and when we list things, we catalogue them.

8. A flyer is a form of paper advertisement used for wide distribution,
posted or distributed in a public place, handed out to individuals or
sent through the mail.

I Business Cards: A small card printed with one's name, occupation,
business address, etc. is called a business card.

10. Business cards are cards bearing business information about a
company or individual

11. A greeting card/ Invitation card/ compliment card is a piece of card
or high quality paper expressing friendship or any other sentiment.

12. An award is something given to a person, a group of people, or an
organization in recognition of their excellence in a certain field. An
award may be accompanied by trophy, title, certificate, medal,
badge, pin, or ribbon.

13.  Certificates of achievement, merit, and honor can be powerful tools
when used at the right time and presented in the right way.

14. An envelope is a common packaging item, usually made of thin flat
material. It is a flat paper container with a sealable flap designed to
enclose a flat object, such as a letter, card or document. Traditional
envelopes are made from sheets of paper. They are most commonly
used for enclosing and sending mail (letters) through a prepaid-
postage postal system

15. Alabel is a piece of paper, polymer, cloth, metal, or other material
affixed to a container or product.

16. Itis stationery with a printed heading. The heading usually consists of
a name and an address, a logo or corporate design, and sometimes a
background pattern.
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17.

18.

19.

20.

A calendar is a system of organizing days for social, religious,
commercial or administrative purposes. This is done by giving
names to periods of time, typically days, weeks, months and years.
A resume provides a summary of our education, work history,
credentials, and other accomplishments and skills. There are also
optional sections, including a resume objective and career summary
statement.

Resumes are the most common document requested of applicants in
job applications. A resume should be as concise as possible.

A curriculum vita (CV) provides a summary of one's experience and
skills. Typically, CVs are longer than resumes - at least two or three

pages. CVs include information on one's academic background,
including teaching experience, degrees, research, awards,
publications, presentations, and other achievements.

21. Menu is the main way to give or take order from guest. Guest may
order properly to see the menu and be aware about our food and

price.

22. A sign is a piece of paper, cloth, wood or any other material which is
painted with pictures or words and which gives some information
about a particular place, product, or event.

23.  The paper folding templates include patterns for paper airplanes
and origami projects alike. They include pages (that may require
trimming) with "fold-lines" and others with instructions to create

our paper masterpieces.

24. We can enjoy these Paper Folding Projects in our leisure time and

can make some creative things.

25.  Microsoft Publisher offers templates for kids. These templates
consist of different paper folding projects like airplanes, boats, cups,

and more.

1.
1.

Exercise

Multiple Choice Questions:

Now day's brochures are also
available in electronic format and are
called..........

a) e-brochures b)m-brochures 5.
c) t-brochures d) k-brochures

In publisher, what is a list of things?

a) Banner b) Catalogue

c) Label d) News Letter

A small card printed with one's name,
occupation, business address, etc. is
called.................

a) Brochures b) Newsletters

c) Business cards d) Menus
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What is a piece of paper, polymer,
cloth, metal, or other material
affixed to a container or product?
a) Label b) Letter Head

¢) Greeting Card d) Menu

What is stationery with a printed
heading? The heading usually
consists of a name and an address, a

logo.
a) Letterhead b) Program
c) Invitation d) Catalogue

What is the most common document
requested of applicants in job
applications?

a) Banner b) Resume

c) Calendar d) Flyer
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What is a system of organizing days 3.

for social, religious, commercial or 7.
administrative purposes and giving
names to periods of time, typically
days, weeks, months and years?

a) Advertisement b) Certificate

¢) Signs d) Calendar 2.
What are longer than resumes - at
least two or three pages? 3.
a)Curriculum vita (CV)

b) Banner 4.
c) Invitation

d) Catalogue

What is the main way to give or take
order from guest? 5.
a)Resume b) Label

c) Menu d) Banner

Children can enjoy................ in our

True or False:

A compliment card is a piece of
card or high quality paper
expressing friendship or any other
sentiment.

Certificates of achievement, merit,
and honor can be powerful tools.

A catalog cannot be a list of
anything, arranged in some order.
A long strip of cloth bearing a
slogan or design carried in a
demonstration, procession or
hung in a public place

Brochures are promotional
documents, primarily never used to
introduce a company, organization,

leisure time and can make some 4 Very Short Answer type Questions:

creative things.

a) Letterhead

b) Newsletter

c) Paper Folding Projects
d) Resume

Fill in the Blanks:

Advertising means how a company 2.
encourages people to buy their.......... ,
........... orideas. 3.
MS - Publisher offers templates and
other tools to help us create a variety
of publications, including brochures,
newsletters, ........ ,and ..o,
Business cards are cards bearing
business information about a

A resume provides a summary of our
............... y eeeeeennenncredentials, and
other accomplishments and skills.

Microsoft Publisher offers templates
for kids. These templates consist of
different paper folding projects
like......... ) ereeneeens , cups, and many

166

What is a piece of paper, cloth,
wood or any other material which
is painted with pictures or words
and which gives some information
about a particular place, product,
or event

What is a common packaging item,
usually made of thin flat material?

What is something given to a
person, a group of people, or an
organization in recognition of their
excellence in a certain field?

What is a form of paper advertisement
used for wide distribution, posted or
distributed in a public place, handed
out to individuals or sent through the
mail?

What is a printed report
containing news or information of
the activities of a business or an
organization
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Short Answer type Questions: 3.

Explain Signs?

Explain Resumes? 4.
What is Banner?

Explain Newsletters? 5.
What are Menus?

Long Answer type Questions:

What are Advertisements? Explain 7.
various print media used for
advertisements?

How to create Brochures using MS-
Publisher? Explain their steps.

What are Business Cards? Write
steps for creating Business Card
in Publisher?
What is Label? Where labels can
be used for?
What is Letterhead? How to
create Letterhead in Publisher?
What is Calendar? How to create
Calendars in MS Publisher
Explain Paper Folding Projects?
Write the steps to create Paper
Folding Projects in Publisher?

Answers Key

T Very Short
Multiple Choice Fill in the Blanks fUE OF Ciy 2ol
False Answer

Products and services

e-brochures True Sign
Business cards and
Catalogue menus True Envelope
Business cards Company, and meiyidual False Award
Label Education and work
g True Flyer
historv
L EEE Airplanes and boats False Newsletter
Resume _ _
Calendar

Curriculum vita
(CV) =

Menu

Paper Folding

Projects =

[y
]
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